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Signal version 7

The Signal software running under Windows together with one of the CED 1401 family of interfaces gives a PC
the power to capture and analyse multi-channel waveform and time marker data.

Signal is designed to let you manipulate your data using the familiar Windows idioms. You can arrange the
windows to display the data within them to best advantage and copy and paste the results to other applications.
Alternatively, you can obtain printer hard copy directly from the application. When you close a data file, Signal
saves the screen format and analysis window setup associated with it. When you open a file, Signal restores the
configuration, so it is easy to resume work where you stopped in a previous session.

You can analyse sections of data by reading off values at and between cursors, or by applying the built-in frame by
frame automated analyses such as waveform averaging and power spectrum. More ambitious users can further
automate both data capture and analysis with scripts. The script language is described in The Signal script language
manual.

New features in version 7

Version 7 of Signal is completely compatible with earlier versions; it will read data files and sampling
configurations created by versions 2, 3, 4, 5 or 6 without problems. Scripts that ran in versions 3, 4, 5 and 6 should
work without modification (with a very few exceptions). The main new features in version 7 are:

o The auxiliary states device support has been extended to allow use of multiple devices in the same experiment.

e The auxiliary states device support has been extended to include the PowerMAG and DuoMAG ranges of
transcranial magnetic stimulators.

e The auxiliary states device support has been extended to include the Digitimer DS8R biphasic constant current
stimulator.

e Viewing and editing auxiliary states device settings during sampling is now possible, access is via the Sampling
menu or a new control bar.

¢ Integer variables in the script language are now 64-bits in size, allowing massively greater integer values to be
used.

e There is a new information window which can be used to generate customisable high-visibility displays.
e Script language support for the Continuous Wavelet Transform has been added.

There are many other improvements and more are planned. You can find a full list of new features, bug fixes and
changes in the Revision history. Licensed users of Signal can download updated releases of Signal within the same
version from our web site www.ced.co.uk as they become available.

Hardware required

The absolute minimum requirement to run the program is a Pentium II with 256 MB of memory running Windows
7. All 64-bit versions of Windows are supported. The more memory you have and the faster the processor, the
better Signal will run. A graphics accelerator will greatly improve drawing and scrolling speeds.

To sample data, you will need a CED Power1401 mk I, mk IT or -3/3A or a Microl401 mk I, mk II, -3 or -4,
dynamic clamping requires a Power1401 mk IT or -3/3A or a Micro4. Version 7 does not support the standard 1401
or the 1401plus, if you want to use a 1401plus you will have to use version 6, a version 6 installer is supplied on
the Signal version 7 CD. Unless the exact type of 1401 is specified, when the terms Micro1401 and Power1401 are
used in this manual they refer to all versions of these types of 1401.

File icons

sl The various file types in Signal have icons so that you can easily recognise them when you minimise their
windows. The icons will automatically be used for the relevant files by programs such as Windows Explorer. All
the icons have a set of waveforms to remind you of the application to which they belong. The icon to the left is the
Signal application icon that you double-click to launch Signal from the Signal program group.
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== | These icons are for Signal data files. The icon on the left represents Signal CFS data files or file
views. The icon on the right represents an XY data file: a saved XY view. If you double-click on one of these in
Windows Explorer it will launch the Signal application (if it is not already running) and open the data file in a data
or XY view.

by
g

£ i,
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: These icons are for text-type Signal documents and files. The icon on the left represents a
text file, whlch can hold any textual data. The centre icon represents a Signal script file. Script files hold script
programs that execute within Signal to automate analysis or to customise Signal behaviour in some way. The icon
on the right represents a Signal sequencer file. These files store sequences of output pulses for use during
sampling.

These icons are for other files created by Signal. The icon on the left represents a Signal sampling
configuration, while the one on the right represents a Signal resources file.

Direct access to the raw data

Some users may wish to write their own applications that manipulate Signal data files directly. A C library: The
CFS library is available from CED. The library includes all functions necessary to read or write Signal data files
from Windows programs. This library is available, along with complete documentation in PDF format, from the
CED web site (https://ced.co.uk).

Using this on-line help

Much of the information in this help file is also in the manuals Signal for Windows and The Signal script language.
If you prefer printed documentation you may like to read the manuals and use this system for context-based help
from the program (by pressing F1 or clicking Help buttons).

We do not explain standard procedures, for example clicking and dragging, using menu short-cut keys or using a
file open dialog; we expect that you are already familiar with them. We use standard Windows idioms wherever
possible so that you feel at home and have a consistent interface to work with.

The Overview page at the start of the Getting started chapter aims to give you a general understanding of Signal
and what it does.

The Getting started section suggests some tasks you might undertake to get started with the system. We have
supplied example data files for you to experiment with; there is no need to have your own data available at this
time. This is followed by sections on General information, Sampling data, Pulse outputs, Sequencer outputs and
Sampling with multiple states.

The next sections are a reference section to all the menu commands in Signal: File, Edit, View, Analysis, Cursor,
Sample, Script, Window and Help.

Once you are familiar with the program, you may wish to investigate the script language so you can automate your
data capture and analysis.

There are also sections on specific topics, such as: Sampling with clamp support, Single channel analysis, Digital
filtering, Programmable signal conditioners, Telegraph support and Auxiliary states devices.

The Signal Training Course Manual covers selected topics in more detail. It is particularly useful for script authors
as the approach is much more descriptive than the reference material presented here.

Credits

Nearly all of the Signal code was written by CED programmers and is copyright Cambridge Electronic Design Ltd.
However there are a few other sources of code who should be thanked and acknowledged (though of course CED
is still responsible for any shortcomings):

e Curve fitting procedures are based on routines in Numerical Recipes: The Art of Scientific Computing,
published by Cambridge University Press and are used by permission.
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o XML resource files are handled using the XML library developed by Arseny Kapoulkine and available from
https://pugixml.org/.

Installation

To be reading this help you must have already installed Signal. However, you may need to move it to another
system (mindful of the Signal Software License).

Your installation disk is serialised to personalise it and the Signal software to you. Please do not allow others to
install unlicensed copies of Signal.

Just put the CD-ROM in the drive and it will start the installation. You can also run the installation manually by
opening the Signal?7 folder on the CD-ROM, then the Disk1 folder and running setup. exe.

During installation

You must select a suitable drive and folder for Signal and personalise your copy with your name and organisation.
You can have earlier versions of Signal on the same system as long as they are in different folders. If you have a
previous version on your system, make sure you install to a different folder. The installation program copies the
Signal program plus demonstration, help, tutorial and example files. It also copies and installs all required 1401
support (device drivers and control panels). In rare cases you may need to install drivers manually; the installation
program will tell you if this is the case and point you at detailed instructions. Your system may require a restart
after installation to get all 1401 device drivers up to date.

Installation location

By default, versions of Signal before 5.08 were installed by default into a C drive directory such as C: \Signal7.
As installation outside C: \Program Files is frowned-upon these days, modern versions of Signal install by
default into a directory inside C: \Program Files and we have made minor adjustments to ensure that Signal
will work smoothly in the new location. When running from C:\Program Files Signal cannot save data,
sampling configurations and other values inside the Signal installation directory as was often done previously, so
the Signal installer creates two new directories for you to save your files in. These are:

My Documents\Signal7

This directory is always created and if you are installing Signal inside C: \Program Files this folder is also
where the the installer puts the example data files, scripts and other useful files that were previously installed inside
the Signal installation folder. This folder is user-specific (for each user that logs on a different folder acts as My
Documents) and so you can use it for all of the files which you do not need to share with other users of the
computer.

Public Documents\Signal7Shared
This directory is also always created and can be used for files that you want to share with other users of the
computer.

Custom install
To install without 1401 support, or to install extra information and documentation (which includes the latest copies
of the software manuals) choose Custom installation.

After installation

If you are new to Signal, please work through the Getting Started tutorial in the online help. Where you go next
depends on your requirements. The Signal Training Course Manual is more descriptive than the other manuals,
which are organised as reference material. However, it covers all versions of Signal and you will occasionally need
to refer to the other manuals or this online help for version 7 specific details.

Updating and removing Signal

You can update your copy of Signal to the latest version 7 release free of charge from our web site:
www.ced.co.uk. You can only update a correctly installed copy of Signal version 7, though you can install the
update into a different directory prom the previously installed software. There are full instructions for downloading
the update on the web site.
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Once you have downloaded the Signal update, you will find that the update process is very similar to the original
installation process, except that you must already have a properly installed of Signal for Windows version 7 on
your computer.

Updates will include both bug fixes and new features. We will notify you by email (if we know your email address)
of new releases. You can also register for this service on our web site. To stop emails, reply to them and ask to be
removed from the list.

Removing Signal

You can remove Signal from your system: open the system Control Panel, select Add/Remove Programs, select
CED Signal for Windows version 7 and click Remove. This removes all of the files installed with Signal; you will
not lose any data or other files that you created.
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Getting started

This section of the Signal online help consists of a series of familiarisation exercises to help you become familiar
with Signal. You can begin the exercises by clicking here.

Signal overview

What is Signal and what does it do?

Signal is a program used to collect and analyse information from (normally bio-medical) scientific experiments.
The data that Signal works with are primarily waveforms - voltages that vary with time - each waveform is
represented by a separate channel. Signal collects and manipulates waveform data in chunks that are called frames,
the frames in a Signal data file are usually all of the same length - rather like a software oscilloscope.

Collecting data with Signal

Signal uses the CED 1401 data acquisition hardware to sample voltages and generate new data files, the 1401 can
also be used to generate outputs (stimuli) during sampling. To sample new data using Signal you would normally
read a sampling configuration from a disk file or edit an existing sampling configuration to generate a new
configuration, there are many options available to control how Signal samples data and generates outputs. Once the
sampling configuration is satisfactory you can make use of it by clicking on the Sample Now button in the
sampling configuration dialog, or using the File menu New command and selecting a data file. This creates the new
(empty) data file, gets the 1401 ready for use and makes the sampling control panel visible. Sampling is started,
stopped and controlled using the sampling control panel, once sampling has finished the new data file can be saved
to disk to make it permanent.

Viewing data with Signal

Signal data can be visualised in a number of different ways, from a simple display drawing waveforms as dots, line
or cubic splines, to overdrawn channels, to overdrawn frames using 3D perspective. Waveform channels can be
displayed using differing Y axis ranges and the appearance of both the Y and X axes can be extensively
customised. The time or Y axis range shown can be interactively adjusted in various ways.

Analysing data with Signal

Signal can carry out many types of data analysis. Vertical and horizontal cursors can be used to mark positions of
interest within the data and measurements can be taken using the current vertical cursor positions. Virtual channels
can be used to create simulated channel data using an evaluated expression and data in other channels and memory
channels can be created to hold temporary or easily modified data. New data views can be created holding the
results of processing existing data, for example by waveform averaging, and memory channels or XY views can be
generated holding measurements taken from other data views - the ability of vertical cursors to be active and
automatically move to locate features in channel data is particularly useful with these measurements. Other
available analysis techniques include curve fitting, digital filtering and interactive data modification across multiple
frames.

What can Signal be used for?

Hopefully you already know that Signal is suitable for the type of experiment that you want to carry out! However
Signal is a very versatile program and can be used for a wide range of experiments. Here are some of its uses and
capabilities:

Evoked response studies

Measuring responses to stimuli requires that the data acquisition be synchronised with stimulus presentation by
suitably triggering the data acquisition and often that data frames be collected at a high rate to minimise discomfort
for the subject. Automatic generation of an averaged response as part of the data acquisition process helps to
ensure that the data acquisition is proceeding satisfactorily.
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Complex stimulus generation

Generation of complex stimuli including arbitrary waveforms are a useful tool in many types of experiment. The
ability to generate multiple different stimulus sets and run through them in a predefined or randomised order allows
more complex experiments to be undertaken. If you require extremely complex behaviour including reacting to the
sampled data, the output sequencer allows still more control over what and when outputs are generated.

TMS studies

Signal can make Transcranial Magnetic Stimulation studies much easier & quicker to carry out by controlling a
Magstim stimulator and adjusting the stimulus parameters such as the power level automatically during an
experiment. Errors in record keeping are avoided by automatically recording the stimulation settings along with the
data and the Magstim health and temperature are automatically monitored throughout use.

Clamping studies

Signal can be used for both voltage clamp and current clamp experiments and is able to provide a quick analysis of
incoming data for the purpose of monitoring cell health or seal quality. Single-channel voltage clamping
experiments are also supported, in particular by the inclusion of the SCAN analysis technique developed by Prof.
David Colquhoun. When using advanced 1401 hardware such as the Power1401-3 is is possible to use dynamic
clamping techniques to simulate the presence of (or cancel out) particular ion channels.

System customisation

The Signal script language is a complete programming language which can be used to extend the capabilities of
Signal by allowing specialised analyses, automatic analysis and interaction with the data acquisition to perform
more complex experiments. The sample and scripts toolbar provide a simpler customisation mechanism by
allowing frequently used sampling configurations & scripts to be loaded by a single mouse-click.

Signal basics tutorial

This tutorial teaches you the basic operations that manipulate Signal data files. Signal is a large program with many
features; this short tutorial will get you started finding your way around. It is intended that you should work
through the tutorial sections in the order in which they appear, though some sections are optional as they are only
relevant in certain circumstances.

Run Signal

To work through this tutorial you need to be running Signal. If Signal is not already running, click the Start button
and select Programs. Select the Signal entry in the list of programs and inside this you will find the Signal program.
Select the program to start Signal.

Clean up unwanted windows

If you have any windows open in Signal, close them before you start to follow the tutorial instructions. The
quickest way to close all windows is to use the Window menu Close All command (click on Window in the menu
bar, then click on Close All). You can also close windows by double-clicking the control menu at the top left of a
window, or with the File menu Close command.

Opening a file to view

In this step you will open the demonstration data file that was shipped with Signal. Follow these steps:
1. Open the File menu and select the Open... command

2. Open the data directory (inside the Signal7 directory in My Documents for a Program Files install) and
double click on example.cfs (if you have moved files since your installation you may have to search around
to find this file, if all else fails, use any Signal CFS data file)

3. A new window will open. Arrange the help window and this new window so that you can see both.

4. To follow the tutorial, you should see a window holding at least one data channel and with a horizontal scroll
bar at the bottom. If this is not the case your file is in a mess!
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Clean up a messy file

If the file does not display properly this is because the last user of this file didn't put it away tidily. You can tidy up
by following these instructions:

1. Click on the window labelled example.cfs.
2. From the View menu select the Standard Display option.

3. [If the fonts used seem too large or too small open the View menu Font dialog and select Times New Roman,
Regular 10 point.

4. If the colours are grotesque open the View menu and select Use Black And White (which always works) or
select the Change Colours... option and choose a better combination.

Signal display overview

Signal - example.cfs _-ngﬁl

Menu bar Ela. Edit Wiew Analysis Cursor Zample Scrpt  Window Help
||| ¢ [mle] m)a ) plea]Ele] i slo) Fle| slsls) 2

A examrte.chs - frame 1 0

Toolbar

View title bar

Channel data

Channel number

Channel ¥ axis
with title and units

View X axis —\
-

Control buttons
and scroll bar

Minimised window

Status bar --h""-"'-_;

e 1,0,00872,-1.68767 [Frame 1 (max 12) 0,00 [State 0 Flags |z

Here is the Signal program with the example data file open, Signal displays the file in the state in which it was last
saved (as long as it can find a file with the same name and the extension . sgrx holding the previous settings). The
example.cfs window shows data from a specific frame in the file. We call this a file view because it displays
data from a file, along with memory views (which are described later), file views are examples of data views, so
called because they display standard Signal data.

The Signal window
You can see a number of separate components that are part of the Signal window and are normally present
regardless of what Signal is currently doing:

Menu bar

As normal in Windows programs, menus provide your main access to commands used to make Signal take an
action. The menu bar contains a number of separate menus: File, Edit, View, Analysis, Cursor, Sample, Window
and Help, each menu contains relevant commands, for example the File menu contains the Open command used to
open a file. The menus and commands available can vary according to the type of view in use. There are separate
chapters in the Signal help describing the commands available from the various menus.

Toolbar

Just below the menu bar is the toolbar; a line of buttons that, when pressed, carry out common actions. Each
toolbar button matches an action from the menu. The buttons are shown in this manual with the menu items. To
find out what a toolbar button does, leave the mouse pointer over the button for a few seconds. If you want, you
can hide the toolbar (& show it again) using View menu commands. You can also drag the toolbar and “stick” it to
any of the 4 sides of the application window (this is known as docking the toolbar) or simply leave it 'floating' in a
separate window inside the main Signal window.
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Status bar

The Status bar is at the bottom of the Signal window, it provides information about the current view ( and again
can be shown and hidden using the View menu). The status bar holds a number of 'panes’ plus an open area on the
left. This leftmost portion shows menu item prompts; as you move the mouse pointer over the menus, it will show
text describing the item underneath the mouse pointer. The other panes each show a particular item of information.
If the space available is too small for all of the panes, panes disappear starting at the right hand side. From the left,
the status bar panes are:

Cur Pos If the mouse pointer is over a part of a data or XY view that has axes this pane displays the pointer X
and Y positions, the first figure is the channel number from which the Y value is taken. For a text-type
view it displays the current text cursor position in lines and columns.

Frame This pane shows the current frame number for the current view and the maximum frame number in the
view. If the current view is not a data document then this pane is blank. See below for a discussion on
frames.

Start This pane, adjacent to the frame number, shows the absolute start time for the frame - this is the time
for the start of the frame relative to the time at which sampling started.

State This pane shows the state code (described below) for the current frame in the current view as a decimal
number or (if available) as a state label with the number appended. It is blank if the current view is not
a data document.

Tag If the current view is a data document and the current frame is tagged (described below), this pane
shows the text TAG, otherwise it is blank.

Flags This pane shows the flags for the current frame in the current view as an 8 digit hexadecimal (base 16)
number (hexadecimal format makes the individual flag states visible), each digit shows the state of four
flags with the highest on the left. This pane is blank if the current view is not a data document view.

Caps If the keyboard Caps lock is on, this pane displays the text CAPS.
Num If the keyboard Num lock is on, this pane displays the text NUM.

Record  This pane displays REC if Signal is recording user actions into a script.

The data view window
You can also see a number of separate components inside the example.cfs data view window:

Title bar

This shows the name of the data file used by the view and the current frame number, during sampling extra
information relating to the state of sampling can also be shown here. At the right of the title bar are buttons used to
minimise (show as an icon), maximise and close the view.

Channel data
These areas show the actual data from the file, which can be drawn in various ways.

Channel number
The channel number is shown to the extreme left (can be changed to right) of the channel data, it can be used to
select or de-select channels (this is described later on).

Channel Y axis

The Y axis shows the range of data values that are being plotted in the corresponding channel data area, you can
adjust the range shown as necessary (this is described later on) and also whether it is displayed to the left (as shown
here) or right of the channel data. The Y axis also displays the channel title and the units for the data. Not all
channels have a Y axis, for example the keyboard marker channel at the top of the data view.

X axis

The X axis shows the time range over which data is being shown, you can adjust the range shown as necessary (this
is described later on). The X units are also shown, for normal Signal data you can choose between seconds (s),
milliseconds (ms) and microseconds (us).

Control buttons
These buttons below the Y axes are used to zoom the X axis, add cursors and move to the next or previous frame,
they are introduced in detail below.
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Scroll bar

If the X axis range shown is less than the total available in the data frame the scroll bar will be activated (it's
always present but may be disabled). The scroll bar 'thumb' visually indicates the section of data that is being
shown, you can move back and forth through the data in the current frame by dragging the thumb.

Data channels

There are several data channels displayed in the window. These channels can hold different types of data: in the
example file channels 1 to 4 hold waveform data, channel 5 holds keyboard markers. Waveform channels are
normally displayed with channel 1 at the top, marker channels are shown above waveform channels but you can re-
arrange them as you like. Ordinary data channels are stored in the CFS data file, but there are also other types of
channel: memory channels are stored in the resource file associated with the CFS data file (this allows them to be
easily modified or deleted) and virtual channels are not stored anywhere - their data is calculated on-the-fly by
arithmetic operations on data from other channels.

Selecting channels

You select channels by clicking on the channel number to the left of the channel. Signal highlights the channel
number for selected channels. Hold down the Shift key and click on a channel to select all channels between it and
the last selection. Hold down Ctrl to select discontinuous channels. Many commands can operate on a list of
selected channels (for example y axis display optimisation). To clear any selection, click on the rectangular area
below the channel Y axes and to the left of the X axis.

From Signal 6.04, the mouse pointer changes when you move it over a channel number, or over the rectangular
area at the bottom left if any channels are selected. to remind you that you can select the channel.

Frame buttons

The bottom window edge holds five buttons and a scroll bar. The scroll bar controls movement through the frame
when the displayed time range is less than the frame length. If you resize the window, the same data is drawn,
scaled to the window. The two buttons to the left of the scroll bar change the currently displayed frame.

x|

Click on these buttons to move to the previous or next frame in the file. All CFS files contain a number of separate
frames which hold similar data, you can use these buttons to move from one frame to another. If the currently
displayed frame is the first available, then the previous frame button is grayed-out, similarly for the next frame
button. These buttons correspond to the View menu Previous frame and Next frame commands, there is also a
Goto frame command.

What buttons and scroll bar?
If the buttons and scroll bar are not visible, select the Standard Display option from the View menu, which should
tidy up the display so that you can see them.

About frames

Frames are a central concept within the Signal software. A CFS file or Signal data document contains one or more
data frames, each frame corresponds to a sweep of sampling. A data document view normally only displays one
frame at a time, this is the current frame for that view. You can have multiple views of the same data document,
each view can have a different current frame so you can examine separate parts of the file simultaneously. It is also
possible to overdraw multiple frames in the same view.

Each frame in a Signal data document has the same number and type of channels, but may have varying frame start
and end times. Each frame holds channel data from the various channels. Usually, all of the waveform channels
will have the same number of data points, while the number of markers can vary. In addition to this frame data
there are a number of other data items attached to each frame; a frame comment, the frame state, tag and flags, 16
user frame variables and others:

Comment a single line of text, of length up to 72 characters, that can be read or written using Signal scripts.
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State a 32-bit number that will normally have a value from 0 to 256, it is intended for use in conditional
analysis where each state value corresponds to a separate condition in the experiment, but may be
used for any purpose.

Start a floating point number holding the absolute start time for the frame. This value is the time for the
frame x axis zero relative to the start of sampling. For files collected by Signal version 1.00 or
collected using Fast triggers mode this will always be zero.

Tag a single yes/no switch; each frame can be tagged or not. This is intended for any purpose where a set
of frames need to be marked for analysis or attention.

Flags a set of 32 flags, each of which may be set or clear. These flags are available for any user-defined
purpose, currently they are only useable from the Signal script language.

User a set of 16 floating point numbers that can be read or written using Signal scripts. They are intended
for any purpose required.

Others when using an auxiliary states device such as a Magstim, extra frame variables are created to show
the Magstim power levels and other settings. When sampling with multiple states, a StateLvariable is
created, this holds the state label corresponding to the frame state or is blank if no state label is set.

When you are working with Signal data, the current frame for the view is held in memory. This frame will be
discarded when the view switches to a different frame. Any changes made to the frame data while it is held in
memory must be saved before the new frame is loaded or the changes will be lost. You can write the changed data
back into the file using the File menu Save command, or you can use the Preferences dialog Data page to select
what happens if the frame is changed while data is unsaved. Changes made to non-channel data such as the frame
state or flags are always saved.

Often in Signal you will need to specify the frame or frames to be used for an operation. There are a number of
ways of doing this, you can select the current frame in the view or you can enter a single frame number directly. To
specify more than one frame, you can enter a frame list such as ‘1..50,60,61,70..80°, or you can select options such
as All frames, Tagged frames or Frames with state n, giving a wide range of possibilities. These frame
specification mechanisms are also available from within the Signal script language.

Zoom buttons

The bottom window edge holds three buttons and a scroll bar. The scroll bar controls movement through the file. If
you resize the window, the same data is drawn, scaled to the window. The two buttons to the left of the scroll bar
change the time range.

.i--.ﬁa This button halves the time range (zoom in). The left edge of the display remains fixed. You can
zoom in until the ratio between the frame length and the width of a pixel reaches 2,147,483,647.

gﬂ This button doubles the time range (zoom out). The left edge of the window does not move unless
the start plus the new width exceeds the length of the frame. If the new width exceeds the frame
length, the entire frame is displayed.

Cursor buttons

These buttons add vertical or horizontal cursors to the display. Up to 10 cursors can be present in a window, it is
also possible to have up to 9 horizontal cursors. A vertical cursor is a dashed line used to mark positions on the X
axis, a horizontal cursor marks levels on a channel. You can remove cursors with the Cursor menu Delete option
or by right-clicking on them. You add cursors in four ways.

1. Click and release the relevant button to add a cursor in the centre of the window or centre of the first channel
with a Y axis (for horizontal cursors).

2. The Cursor menu New cursor command or it’s Ctrl-| shortcut adds a cursor in the centre of the window. The
New Horizontal cursor command adds a horizontal cursor in the centre of the first channel with a Y axis.

3. Ifyou right-click on a data view, the pop-up context menu will include an item for a new vertical cursor. If you
clicked on a channel with a Y axis, the channel-specific sub menu will include an item to create a new
horizontal cursor.
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4. From a script you can use the CursorNew() or CursorSet () commands to create vertical cursors,
HCursorNew () to create horizontal cursors. Script users have full control over the cursors.

Cursor style and pointers

Click on the cursor button so that at least one cursor is visible. The mouse pointer changes over a cursor or a cursor
label:

i This indicates that you can drag the cursor. If you drag beyond the window edge, the window scrolls.
The further beyond the edge, the faster the scroll. Dragging hides the label unless the ctrl key is down
or you drag the label.

If you position the mouse pointer over the cursor label, the pointer changes to a 4-headed arrow to

‘%’ I indicate that you can drag both the cursor and the label. This can be useful when preparing an image for
publication and you need the cursor label to be clear of data. If you move the pointer to one side, or hold
down the shift key, the pointer becomes a two-headed vertical arrow and you can drag the label, but not
the cursor.

There are four labelling styles for the cursor: no label, position, position and cursor number, and number alone.
You select the style with the Cursor menu Label mode option or by right-clicking on the cursor and selecting Set
Label.

Zoom in on an area

Move the mouse pointer to the waveform channel. Drag a rectangle round a waveform feature with the mouse and
release the button. The window displays the area within the rectangle. If the rectangle covers more than one
channel, only the time axis changes. If your rectangle lies within a channel and has zero width, only the y (vertical)
axis changes, similarly a rectangle with no height changes only the X axis.

@ The mouse pointer changes to a magnifying glass when you hold the mouse button down in the data
channel area to show that you are about to magnify the data.

@ If you hold down the Ctrl key as you drag, the mouse pointer changes to the un-magnify symbol and the
rectangle holding the channel area shrinks to the rectangle you drag

Now move the mouse pointer over an axis; you will see it changing to show a scrolling or stretching axis. You drag
the axis to directly shift or stretch it; if you are over the axis ticks you get a shift while over the numbers generates
a stretch in or out (the mouse pointer changes to show what operation you will get).

Whatever method you use to scale the data, you can return to the previous display using the Edit menu Undo
command or the keyboard short-cut Ctr1+2. If you release the mouse button with the pointer in the same position
from which you started the drag, the display does not change.

If you hold down the a1t key before you click and drag, Signal displays the size of the dragged
rectangle next to the mouse pointer and does not zoom the display. Release A1t, then you can use
the ¢ key to copy the current measurement to the clipboard and the L key to copy it to the Log view.

—|_29 00ms, 0.62V

Zoom a channel

You can zoom one channel to use the entire display area!
Double click anywhere in the waveform channel. The channel will expand to occupy the entire window.
Double click in the waveform channel again and your previous display is restored.

You can also change the display to show a channel and all duplicates of it by holding down the ctrl key, then
double-clicking on a channel. This is useful with sorted spikes, where duplicates of a channel are used to display
spike classes.
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Using x and y axes to scroll and zoom

L\}E L\} When the cursor is over the tick marks of an axis, you can drag the axis. This maintains the current

+r—+ axis scaling and the window moves to keep pace with the mouse pointer. You can do this with most x
and y axes in Signal. This is particularly useful for y axes as they do not have a vertical scroll bar.
The window does not update until you release the mouse button. If you hold down the ctr1 key, the
window will update continuously.

*

E [% When the cursor is over the axis numbers, a click and drag changes the axis scaling. The effect
% ¥ ;' depends on the position of zero on the axis. If the zero point is visible, the scaling is done around the
zero point; the zero point is fixed and you drag the point you clicked towards or away from zero. If
the zero point is not visible, the fixed point is the middle of the axis and you drag the point you
clicked towards and away from the middle of the axis

In a data or XY view you can drag the y axis so as to invert the axis. You can prevent this happening by setting an
option in the Edit Preferences dialog Display page. You are not allowed to invert the X axis.

X Range dialog

Click this toolbar button or double-click the time (X) axis of the display to

open the X Range dialog. Experiment with the time axis. You can type | mq [t =1 [[Showat |

new positions or use the pop-up menus next to each field to access cursor g o 5 5
positions and the maximum time in the file. = widh = Draw |
Left Sets the window start time. You can type times either ™ Lagetickspacing [l Garce] |

using the selected X axis units, or as a number | Tiksubdvisons |5 =
. _— . Close

followed by 's', 'ms' or 'us' to force the units. In [~ Logsithwic autsunits [of -] —I
addition to typing times or selecting a time from the
drop-down list, you can type in expressions using the maths symbols + (add), - (subtract), *
(multiply) and / (divide). You can also use round brackets. For example, to display from 1
second before cursor 1 to one second past cursor 1 set Left to Cursor(1)-1 and Right to
Cursor(1)+1. The Draw button is disabled if you type an invalid expression, or if the Right
value is less than or equal to the Left value or if the new range is the same as the current

range.
Right Sets the window end time using the same format as the Left field.
Width Shows the window width. You can either set the left and right positions, or the left position

and the width. Check the box to keep the width the same when the Left field changes or to
enter a width directly.

Large tick spacing Use this to customise the X axis appearance by forcing the interval (in X axis units) between
large ticks on the axis. If you enter a value that would produce an illegible axis it will be
ignored.

Tick subdivisions  Use this to customise the X axis appearance by setting the number of small-tick subdivisions
between large ticks on the axis. Again, any value entered that produces an unusable axis will
be ignored.

Logarithmic Check this box for a logarithmic rather than a linear X axis.

Auto adjust units  Check this to cause the units displayed on the axis to switch to multiples of powers of 10
when zoomed well in or well out in order to keep the figures shown on the axis sensible.

Show All Expands the time axis to display all the file and closes the dialog.

Draw If the axis range had been edited, use this to redraw the data to match the new range. You do
not need to press Draw to see the effect of other changes made within the dialog.

Close This closes the dialog; it does not update the axis range.

Cancel This undoes all changes made with the dialog and closes it.
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Y Range dialog

Click this toolbar button or double-click on the Y axis of a waveform
channel to open the Y Range dialog for that channel. This dialog changes . [240C 1 pwavetom) ] [ |

the y axis range and attributes for one or more channels. Experiment with

. T 22
the Y axis range. | 3] shoua |
Bottom |-2.2 —}21
Channel This is a pop-up menu from which you can select s type [Linea =]
any channel with a y axis, or all channels with y ~ .. _ Goposel [T Draw I
axes, or all selected channels. You can also enter a g
. . ™ Large tick spacing ||
list of channel numbers such as 1..3,6 directly. Caricel |
[T Tick zubdivizions |-‘ 3:
Top Enter the upper limit for the Y axis here. Auta units [Df b |
Bottom Enter the lower limit for the Y axis here.
Axis type Select a linear, logarithmic or square root axis.

Large tick spacing Use this to customise the Y axis appearance by forcing the interval (in Y axis units) between
large ticks on the axis. If you enter a value that would produce an illegible axis it will be
ignored.

Tick subdivisions  Use this to customise the Y axis appearance by setting the number of small-tick subdivisions
between large ticks on the axis. Again, any value entered that produces an unusable axis will
be ignored.

Auto units This is used to select between the units displayed on the axis being static, switching to
multiples of powers of 1000 in order to keep the figures sensible when zoomed well in or
well out, or you can select the SI Prefix option which does the same thing by changing the
units using SI prefixes, for example by converting v to mv when you are zoomed in.

Optimise Press this button to change the Y axis ranges of the set channel(s) to fit the range of the
displayed data.
Show All Press this button to change the Y axis ranges to the data limits for the channel(s), if

available. If the channel has no limits to its data this does the same as the Optimise button.

Draw Press this button to redraw the data using the currently entered Y axis range.

If no channel has a y axis, open this dialog from the View menu.

Waveform draw mode dialog

Data files hold two basic channel types: waveform and | praw mode for test virt markers.cfs.
markers. Waveform channels hold a list of wvalues
representing the waveform amplitude at successive time || Channel  2ADC 1 (Waveform) ~

intervals. Marker channels hold the times at which | H:;?n =
something happened (and more data, depending on the Siefine

marker type). . -

Open the View menu Draw Mode dialog. Experiment
with different drawing modes for channels 1 to 4. Click
Draw to update the display without closing the dialog. — ...
Click OK to close the dialog.

If you want to find out more about waveform drawing modes, you can find a complete description in the View
menu chapter, Draw mode section.
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Customise display

Open the View menu Customise display dialog. This sets

Display for example.cfs

the channels to display in your window. With up to 80 IV s W 58 A
channels in a file, this ability is quite important if you are to 21 1 ADC0 - Wavefom —!‘ioptions- I>i aptioris
see any detail! | 2ADCT111 - Wavefom e Mt
) ) ] 3ADC 2 - Waveform ¥ Tile ¥ Title
The list on the left of the dialog holds all the channels that can = [& 440C - wavetam v Units ™ Urits
be displayed. Check the box next to a channel to include it in = |¥l 5Kerboard - Marker ¥ Smallticks | | I Smallficks
the dlsplay liSt. (W] w1 Wirtual - WwWaweform . O ight ¥ Sool bar
I ScaleBar [ ScaleBar
You can also show and hide the axes, background grid and the I Grid I Grid

horizontal scroll bar in the window from this dialog, and
switch to displaying Y axes with horizontal labels.

7 axiz horizontal labels
¥ Enable V¥ Centre units

[e =
ICentre 'I

Cese [ ok |

Label space

Click the OK button to see the result. If you make a complete
mess of your window you can use the View menu Standard
Display command to clean things up.

Wertical alignment

sion | anog | Hep | Draew |

Channel order

Make sure that the example file is the current window and use the View menu Standard Display command to tidy
things up. Click on the ADC 0 channel number (1) and drag it down over the other channel numbers.

As the mouse pointer passes over each channel, a horizontal line appears above or below the channel. This
horizontal line shows where the selected channel will be dropped. Drag until you have a horizontal line below
channel 2 and release the mouse button. Channel 1 will now move to the middle of the channel list, between
channels 2 and 3. Type Ctr1+Z or use the Edit menu Undo to remove your change.

You can move more than one channel at a time. Signal moves all the channels that are selected when you start the
drag operation. For example, hold down Ctr1l and click on the channel 3 number. Keep ctrl down and click and
drag the channel 2 number. When you release, both channels will move. The mouse pointer shows a tick when you
are in a position where dropping will work.

The usual Signal channel order is with low numbers at the top of the screen. If you prefer low numbers at the
bottom of the screen, open the Preferences dialog Display page and uncheck Standard Display shows lowest
numbered channel at the top, then use the View menu Standard Display command.

Channel spacing

Hold down the shift key and move the mouse over the data area of channel 3. Keep the shift key down and
click. Drag up and down and release the mouse. You will see that this adjusts the vertical space allocated to the
channel.

When you click with shift down, the mouse jumps to the nearest channel boundary and you can change the
boundary position by dragging. With shift down, you can move the edge up and down as far as the next channel
edge. You can undo changes or use Standard Display to restore normal sizes.

If you add ctr1, all channels with a Y axis are scaled. If there are no channels with a Y axis above or below the
drag point, then all channels scale. You can force all channels to scale by lifting your finger off the shift key
(leaving ctrl down) after you start to drag the boundary.

Channel overdraw

You can overlay channels of data in a file or memory view. This is done interactively by dragging channel numbers
on top of each other or from a script by using the ChanOrder() command. To do this in the example file:

Click the "3" of channel 3 and drag it on top of Channel 1 and release.

Channels 1 and 3 now share the same Y axis space with the channel numbers stacked up next to the Y axis. The
visible Y axis is for the top channel number in the stack. You can promote another channel in the stack to the top
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by double-clicking the channel number. The channels retain their own y axes and scaling. You can remove a
channel by dragging the channel number to a new position.

When you drag channels, and at least one of the selected channels has a Y axis, you can drop the channels with a Y
axis on top of another channel with a Y axis. As you drag, a hollow rectangle appears around suitable dropping
zones. You can also drop between channels when a horizontal line appears.

Merged channels are drawn such that the channel with the visible Y axis is drawn last. If you have a channel that
fills in areas, such as a marker channel drawn as rate mode, put it at the bottom of the stack, as it will mask
channels below it in the stack.

Use the View menu Standard Display command to tidy things up before you continue.

Frame overdrawing

Open the View menu Overdraw settings... dialog. Specify frames 1..4 as the
frame list and click OK. Use the View menu Overdraw frames command to
turn overdrawing on and off. Experiment with different frame selections and

Overdraw settings

[ Overdraw frames v 3D drawing

Frames IT agaed frames

with the colour cycling display mode.

The frame display list is a list of frames that will be shown in addition to the
current frame when overdrawing in standard (non-3D) mode. When using
colour cycling each overdrawn frame is drawn in a different colour, or all
the display list frames are drawn in the colour specified by the Frame list
traces item in the colour setup dialog, or you can fade to the background
colour or channel secondary colour. The current frame will be displayed in
its usual colour if it is not in the frame list. All the standard mechanisms for
selecting frames are available. 3D overdrawing options are also available,
this differs from the simple overdrawing mechanisms in that the current
frame is always shown at the front and therefore only frames that are before
the current frame are overdrawn - so that the 3D array shows a time history
of frames with the oldest at the back.
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Cursor measurements

Make sure there are cursors in the window.

ﬁ"!-"' . . . . . .

_I Click the toolbar button (the toolbar is at the top of the Signal window, just below the menus, it holds
buttons for common tasks) or use the Cursor menu Display Y Values option. The columns show the cursor times
and values. For channels without a y axis, the value is the next marker time after the cursor.

The Time zero and Y zero check-boxes select relative rather than absolute measurements; the radio buttons set
the reference cursor. Reference cursor values are unchanged; values at other cursors have the reference value
subtracted.

If you move cursor or alter a channel display mode, the values change. If you add or remove channels in the
display, they are added or removed in the dialog.

You can copy dialog fields to the clipboard. Click and drag for multiple selections. Click the top or left hand cells
to select an entire column or row. Hold down the Ctrl key to make non-contiguous row or column selections.

Cursor regions

Tk
LI Click the toolbar button or use the Cursor menu Cursor Regions command. Experiment with changing
cursor positions and channel display types. The regions dialog looks at the data values between cursors. There are
nine modes set by the drop down list at the bottom of the dialog:

Curve area The area between a waveform trace and the line joining its end points, no measurement for markers.
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Mean The average level of a waveform, or the number of markers divided by the width of the region.
Slope The gradient of the least-squares best fit line to the waveform, no measurement for markers.
Area The area between a waveform and the y axis 0.0 level, or the number of markers in the region.
Sum The sum of all waveform points, or the number of markers in the region.

Modulus  The area between a waveform and the y axis 0.0 level, all values taken as positive, no measurement
for markers.

Maximum The maximum waveform (or marker as rate) value or interval between markers.

Minimum  The minimum waveform (or marker as rate) value or interval between markers.

Peak-Peak The difference between the Maximum and Minimum.

SD The standard deviation from the mean of the waveform values.

RMS The RMS amplitude of the waveform values.

amplitude

Extreme  The largest of the Maximum and Minimum, taken as absolute values.
Peak The amplitude of the first peak found.

Trough The amplitude of the first trough found.

Point Count The number of sample points between the cursors.

SEM The standard error in the mean of the waveform values.
RMS error The RMS error relative to the mean of the waveform values.

You can also make relative measurements by checking the Zero region box and choosing a reference region.

Memory views

Windows holding data from a file are called File views. There is another type of data window, called a Memory
view, that holds the result of analysing file view data, or other generated data. Memory views are very similar
indeed to file views, the only difference is that they are wholly held in memory and do not have an associated CFS
data file. Saving a memory view to disk will create a CFS data file which, if re-opened, will create a file view. The
simple way of generating a memory view is to analyse file view data. There are two steps in the analysis:

1. You set the type of analysis, the channels to analyse, the number of points or bins to generate and any other
parameters required. This creates a new, empty memory view.

2. You select frames from the file view to analyse and Signal calculates the result and adds it to the memory
view.

You may repeat step 2 as many times as is required to accumulate results from different frames or selections of
frames. The new window behaves like a file view containing a single frame of data.

Make a waveform average

Close all windows except the original view of example.cfs. Then:

1. _I Click this button on the toolbar or use the Analysis menu New Memory View command to select
Waveform Average.

2. Set the channels to analyse. The channel list in the pop-up menu includes suitable channels only. All
Channels of the example file is the best for this example.

3. Set the width of the average, we suggest 0.04.
4. Leave the first field set to 0.0 seconds. This is the offset from the start of the frame for the data to be averaged.
5. Click the New button to create a new window and open the Process dialog.

If you want to find out more about waveform averaging, you can find a complete description in the Analysis menu
chapter, New Memory View section, under Waveform Average.
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Process dialog

Now set the region of the data file to analyse:

1. Set the frames for analysis and the frame subset to All frames.

2. Check the Optimise Y axis after process box to scale the y axis to the data automatically.
3. Click Process to analyse the data and display the result.

The Clear result view before process check box sets the memory view contents to zero before you analyse the
data, otherwise each new result is added to the previous one. The Settings button takes you back to the previous
step.

Repeating analysis
You can add more data into the analysis or change the analysis settings and analyse again:

1. Recall the analysis dialog by selecting the Process command from the Analysis menu.

2. Click the Process button again. The data in the result window will not change, as it is an average, but the
sweeps shown by the View menu Info command will double (if you have not checked the Clear result view
before process box).

3. Recall the process settings dialog by selecting the Process settings command from the Analysis menu.
4. Change the width to 0.02, and the start offset to 0.01 then click the Change button.

5. Select frames for processing with the new settings and process as before.

Memory view usage

Experiment with this new window.

You will find that the memory view behaves in a very similar manner to the original file view, but has a single
frame.

XY views

In addition to File and memory views, there are XY views. These hold multiple data channels (up to 256) that
share the same x and y axes. Each channel is a list of (X,y) co-ordinates. Each channel has its own point marking
style, line style and colour.

Use the Script menu Run Script command and select the Load and run... command. Locate the Scripts folder (in
the folder where you installed Signal), and open the file clock.sgs.

Signal will load and run this script which generates an analogue clock in an XY view. You can move and resize the
clock window. You can stop the script running (and regain control of Signal) by clicking on the OK button at the
upper right hand side of the Signal window. You can read more about XY views in the script language manual.

Signal can also create XY views holding data taken from measurements from data files. Use the analysis menu
Measurements command to select XY View (Trend Plot) analysis. This will give you a dialog for the trend plot
settings allowing the trend plot measurements to be defined. Once the trend plot settings are set a normal process
dialog is used to select the frames from which measurements are taken. As for memory view processing, trend plot
generation can be saved as part of a sampling configuration.

You can use the View menu to manipulate the an XY view. Try Customise display, XYDrawMode, Options and
Colours to see XY-specific features.

If you want to find out more about trend plots, you can find a complete description in the Analysis menu chapter,
Measurements section, under XY View(Trend plot).

End of "Getting started tutorial”
If you have worked through these operations, you have the basic skills required to make use of Signal for
interactive data analysis.
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To learn about using Signal to collect data to create new data files you should read the Sampling data, Pulse
outputs while sampling and Sampling with multiple states chapters of the documentation and experiment with the
sampling configuration dialog.

To learn about all of the various forms of data analysis that Signal can carry out you should read the Analysis menu
chapter of the documentation.

To learn about using the script language for analysis you should read the Script language chapter of the
documentation and investigate the example scripts provided with Signal.
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General information

There are several topics that are important throughout Signal. Channel lists are used in many dialogs and also in
the script language, as are frame lists. Expressions can be used in many dialogs where x axis values are wanted and
also more generally. There are many keyboard shortcuts in Signal; they are gathered together here. We have also
included information on a number of other topics.

View types

We often refer to Views when we describe features of Signal. The types of views that an interactive user of Signal
has to deal with have a window on the screen with an associated menu and a data file on disk. These views come
under the categories of Data based views and Text based views. If you write scripts you will also have to deal with
two other types of views: External views (with no associated window) and Other. If you do write scripts, you
should read the more technical description of views and view handles in the Script language section.

Data file based views
There are three types of data views in Signal:

File views (*.cfs)

These display data that is being sampled or has been sampled by Signal or imported into Signal and are associated
with a .cfs file. They hold channels of various types of data, chiefly waveforms and contain multiple frames of data
all using the same channels. They are created by the File menu New command (to create a new file for sampling
based on the current sampling configuration), by opening an existing file or by importing a foreign format file or
from the script language with the FileOpen (name$, 0,...) or FileNew (0, ...) commands.

Memory views (saved as *.cfs)

Memory views are much the same as File views, but do not have a data file associated with them. When they are
saved to disk they are saved as .cfs files and when re-opened have become File views. They are generated from
other File or Memory views or by scripts. You can open saved memory views with the File menu Open command
and create new ones when the current view is a File or Memory view from the Analysis menu New Memory View
command.

XY views (*.sxy)

XY views are generated from analysis of File or Memory views or by the script language. They display multiple
channels of data points defined by (x,y) co-ordinates. The data can be drawn as dots, lines, closed curves or as
histograms, allowing a wide variety of displays to be created. Existing XY files are opened by the File menu
Open command.

Text based views

Text-based views correspond to standard text files. In Signal version 7, we expect text files saved on disk to be in
UTF-8 format, but we will attempt to read text in an range of formats and translate as appropriate. We save text
files in UTF-8. If you are firmly of the ASCII text persuasion, do not worry as this is a subset of UTF-8. We
distinguish the varieties of text file we support by the file extension used to store them on disk. The Text file view
types that Signal supports are:

The Log view

The log view is unusual in that it does not have an associated data file, though you can save it as a text file. The
Log view is used as a convenient place for Signal to display messages and there is a dedicated script command,
PrintLog (), to make it easy to write to from the script language, regardless of the current view.

Text views (*.txt)

These views are created by opening an existing .txt file or by creating a new text file with the File menu New
command or from the script language with the FileOpen (name$, 1,...) or FileNew(l,...) commands.
They display the text in the file and the text can be added to it with the script Print () command. You can choose
to display a gutter margin which can hold bookmarks, and a line number margin, which is normally hidden. Text
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views are normally used from the script language to build output files that the user can view. Script users can also
create external text files, which are faster but have no display window.

Script views (*.sgs)

These views are created by opening an existing script file or by creating a new one with the File menu New
command or from the script language with the FileOpen (name$, 3,...) or FileNew (3, ...) commands.
Scripts are used to automate Signal operations. Most Signal interactive functionality can be controlled by a script,
and there is a lot of functionality that is only available from a script.

Script views display the text in a window. Script views highlight your script files based on the syntax of the script
language, which can make scripts easier to understand and write. They are also used to debug scripts. They have
additional folding margin which shows the structure of the script and allows you to fold away blocks of code based
on the script structure.

Output sequencer views (*.pls)

These views are created by opening an existing output sequence file or by creating a new one with the File menu
New command. Output sequences are used when sampling data with a 1401 interface to sequence DAC and digital
outputs. They can also be used to respond to inputs very quickly, enabling real-time responses to external signals.
Like scripts, output sequences support syntax highlighting and and folding.

There is an alternative way to control outputs while sampling using the Pulses editor. However the output of the
pulses editor is converted to a sequence before it is used and a text sequence gives you the most complete control
of the 1401 outputs.

Grid views (*.sggx)

These were added as an experiment at version 6.04. They are mainly intended for use from the script language, but
can be used interactively. They provide a spreadsheet-style grid that can be used to store data and to build tables
for printing. They are not intended for vast quantities of data. You can read more about them here.

External views
These views have data files and view handles, but no display windows. They are used for text and binary data files
and are only available to users of the script language.

External text files (*.txt, *.*)

These files are opened and created with the FileOpen (name$, 8, ...) script command. You can read data from
the files with Read () and write data with Print () ; the files are accessed sequentially, that is you will read from
the start of the file through to the end or write from the start to the end or append to the end. Because there is no
associated screen image to update when you write or to scroll through on a read, external text files can be much
faster to use than a text view with an associated window, particularly if the file is very big.

External binary files (*.*)

These files are opened and created with the FileOpen (name$, 9, ...) script command. You can read and write
real, integer and text data to these files in a wide variety of formats. The files allow random access. See the
BRead (), BReadSize (), BWirite (), BWriteSize () and BSeek () commands for details. You can read or write
just about any type of file as a binary file, but to do it usefully you need to know the exact file format. The example
for the BWriteSize () command shows you how to create a .bmp file using the script language. The example for
Spline2D () has an example of generating a bitmap file.

Other view types
These view types are for objects that are controllable by the script using view handles, but that do not fit the view
types listed above. These are things like the various control bars, the Signal application window and so on.
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Data file and view topics

Channel lists

In most places where Signal prompts you for a data file channel you can select a channel or group of channels from
a drop down list or you can type in a channel list directly. A channel list is a list of channel numbers or channel
ranges separated by commas, while a channel range is two channel numbers separated by two periods or a hyphen.
For example 4..7 means channels 4, 5, 6 and 7 while the range 7-4 is equivalent to channels 7, 6, 5 and 4. In nearly
all situations the order of channels is not significant and these two ranges are treated the same. The channel list
1,3..5,7 therefore means channel numbers 1, 3, 4, 5 and 7. Virtual channels can be specified by using the vn
channel numbers shown by Signal, for example 1..3,v1,v3..v5. Memory channels can be specified in a similar
manner by using mn (so m1, m2 etc.).

In most cases, Signal checks channel lists and removes channels that are not suitable for the operation. For
example, if you open the example.cfs file supplied with Signal, select a waveform average and type in a channel
list of 1..32 and then click on another field in the settings dialog, Signal will reformat the list as 1..4 as these are
the only suitable channels in the data file. It is not an error for a channel list to include unsuitable channels,
however it is an error for a channel list to include no suitable channels.

You can also specify groups of channels in other ways, for example dialogs that require you to enter a channel list
will also, if any channels are currently selected, offer you a Selected channels option. Many of these dialogs will
also allow you to select and de-select channels while the dialog is visible. You will normally also be offered All
channels and All visible channels as other alternatives.

Channel lists can also be used in script commands, for example: ChanShow("1..4"). Script commands that will
accept this format describe the argument as cSpc. You can find more information about channel specifications in
the script language documentation.

Frame lists

In many places, you will be asked to specify the frame or frames to be used = Frames [ Tagged frames =l
for an operation. Dialogs that do this generally provide you with a pair of = ¢ cbeet T =
frame selectors plus an associated numeric value, for example in the display L ) R

frame list dialog. Other dialogs behave in a very similar manner to this one
though the precise options available may vary, the description below only
mostly matches the display frame list setup.

You can use the upper Frames selector to choose from All frames, Current frame, Buffer, Tagged frames,
Untagged frames, Frames state = xxx (with a separate field for entering the state value) and Last n frames
(again with an extra field for entering n). When used online an additional field All sampled frames is available and
the text shown for All frames changes to All filed frames. In addition to these options you can also directly enter
frame numbers or a frame list such as 1..50,60,61,70..80.

Direct text entry can also be used to specify wanted or unwanted states; ST:<list> will select all frames whose state
value is in the list, while !ST:<list> selects all frames whose state is not in the list. For example ST:1..8 will select
all frames with state values from 1 to 8, while !ST:3,6 selects all frames whose state value is not 3 or 6. So this
main selector already gives you a wide range of possibilities.

When the main Frames selector is set to All frames, Tagged frames, Untagged frames or a numerical frame list
the Frame subset selector is shown. This allows you to select an extra criterion such as Frame state = xxx to
apply to get the frames that are wanted. Using the two selectors together allows selection of, for example, all
untagged frames with a certain state code, giving even more possibilities. These mechanisms are also available in
the Signal script language where you can also build a frame list directly in an script array to get complete control.
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Dialog expressions

Many dialogs (and the equivalent script functions) in Signal accept an expression string in place of a number.
These expressions can be divided into two types: numeric expressions and view-based expressions.

Numeric expressions

A numeric expression is composed of numbers, the arithmetic operators +, -, * and /, the logical operators <, <=, =,
>=, <> and ? and round brackets ( and ). The result of a logical comparison is 1 if the result is true and 0 if the
result is false. You may not have come across ? which is used as:

exprl ? expr2 : expr3

The symbols exprl, expr2 and expr3 stand for numerical expressions. The result is expr2 if exprl evaluates to a
non-zero value and expr3 if exprl evaluates to zero. This can be used in the Cursor mode dialog to give a cursor
position if a search fails based on some other information, for example:

Cursor (2) >Cursor (1) ? Cursor(2) : Cursor (1)
This evaluates to the position of the rightmost of cursors 1 and 2.

If you write expressions involving more than one operator, for example 1+2*3 you need to know if this is
evaluated as (1+2)*3 or as 1+(2*3). This is determined by the operator precedence level which is described below.

View-based expressions

These expressions follow the rules for numeric expressions and allow references to positions along the x axis or a
channel Y axis. If a dialog field is documented as allowing expressions and the field supplies an x axis position (for
example a time), then you can use the following in addition to all of the operators and options available in numeric
expressions:

Cursor (n) Where n is 0 to 9, this returns the position of the relevant cursor in the view. If the cursor
does not exist or the position is invalid, the expression evaluation fails.

COtoC9 This is shorthand for Cursor (0) to Cursor (9).

CursorX(n) Where n is 0 to 9 returns the position of the cursor before the move to the current

position. If the cursor does not exist the expression evaluation fails. This was added at
Signal version 6.05.

COX to C9X This is shorthand for CursorX (0) to CursorX (9), and returns the previous position
of cursors 0 through 9. This was added at Signal version 6.05.

XLow () The left hand end of the view's visible x axis in X axis units.

XHigh () The right hand end of the view's visible x axis.

MinTime () The start time or x axis value for the frame.

MaxTime () The end time or x axis value of the frame.

AbsTime () The frame start time; the time relative to the start of sampling of the trigger time
(generally zero on the X axis) for the frame.

FO This is shorthand for AbsTime ().

View-based channel expressions

If a dialog field is documented as allowing expressions and the field supplies a y axis position that is associated
with a specified channel, then you can use the following. In addition, some expression fields that most often supply
an X axis position can also make use of these:

HCursor (n) Where n is 1 to 9 returns the position of the relevant horizontal cursor in the view. If the
cursor does not exist or is not on the relevant channel, the expression evaluation fails.

H1 to H9 This is shorthand for HCursor (1) to HCursor (9).

HCursorX(n) Where n is 0 to 9 returns the position of the horizontal cursor before the move to the

current position. If the cursor does not exist the expression evaluation fails. This was
added at Signal version 6.05.

H1X to H9X This is shorthand for HCursorX (1) to HCursorX(9), and returns the previous
position of horizontal cursors 1 through 9. This was added at Signal version 6.05.

YLow () The bottom end of the view's visible y axis for the relevant channel.
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YHigh () The top end of the view's visible y axis for the relevant channel.

At (t{, c}) The value on the relevant channel at time t, which can be a view-based time expression. If
the optional channel number c is supplied the measurement is taken from that channel
rather than the channel associated with the dialog field.

Mean (t1l, t2{, c}) The mean level on the relevant channel between times t1 and t2, both or either of which
can be view-based time expressions. If the optional channel number c is supplied the
measurement is taken from that channel rather than the channel associated with the dialog
field.

SD(tl, t2{, c}) The standard deviation of the values on the relevant channel between times tl and t2,
both or either of which can be view-based time expressions. If the optional channel
number c is supplied the measurement is taken from that channel rather than the channel
associated with the dialog field.

Meas (m, tl, t2{, Any available measurement (selected by m) made on the relevant channel between times

c}) tl and t2, both or either of which can be view-based time expressions. If the optional
channel number c is supplied the measurement is taken from that channel rather than the
channel associated with the dialog field. See the ChanMeasure () script function for a
list of the possible values of m and the corresponding measurements.

You can add View (-n) . before these expressions (apart from those referring to frame information) to force the
expression to be evaluated for the n-th duplicate of the current data view, for example View (-1) .Cursor (0)
forces the use of cursor 0's position in duplicate number 1 of the current view. This is required when the current
view is duplicated and you need to be sure which duplicate should be used.

Times as numbers

Times are normally entered as a simple number specifying the preferred X axis units, as set in the Preferences
dialog Display page. However, where a time is typed into a dialog field with a drop-down for preset strings such as
XLow() you can use {{{days:}hours: }minutes:}seconds where the seconds may include a decimal point and items
enclosed in curly brackets are optional. Each colon promotes the number to the left of the colon from seconds to
minutes to hours to days. Times may only contain numbers and colons, white space is not allowed. One decimal
point is allowed at the end of the time to introduce fractional values. We also allow a number with no colons to be
followed by s, ms or us to force Signal to interpret the time entered as a value in seconds, milliseconds or
microseconds. So the following are all equivalent: 1.6, 1.6s, 00:00:01.6, 1600ms, 1600000us.

Operator precedence

In the table, LHS means the value of the expression to the left of the operator as far as the next operator of same or
lower precedence, RHS means the value of the expression on the right up to the next operator of the same or lower
precedence. Where operators have the same level, evaluation is from left to right. The order from high to low is:

Level Name Return value
5 | O | Brackets Everything inside a pair of brackets is evaluated before
considering the effect of an adjacent operator.
4 |* [ Multiply LHS multiplied by RHS
/" | Divide LHS divided by RHS. It is an error for RHS to be zero
3|1+ |Add LHS plus RHS
~ | Subtract LHS minus RHS
2 | < |Less than If LHS less than RHS then 1 else 0
f: Less or equal If LHS less than or equal to RHS then 1 else 0
-_ | Equal If LHS equal to RHS then 1 else 0
> | Greater or equal | If LHS greater than or equal to RHS then 1 else 0
Greater than If LHS greater than RHS then 1 else 0
1 | ? | Ternary operator | LHS?A : B has the value A if LHS is not 0, and B is it is
0. Put spaces around the colon to distinguish it from a time.

1+2*3 has the value 7 because multiply has a higher precedence level than add.
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Script language compatibility

The expressions are compatible with the script language except for use of CO to C9, H1 to H9 and FO as shorthand
for Cursor (0) to Cursor (9), HCursor (1) to HCursor (9) and AbsTime () and the use of colons, ms and us
to denote times. If you use these in a script you will get syntax errors. However, you can use these constructs in

strings passed as expressions to CursorActive () or MeasureToXY ().

Data view keyboard shortcuts

The following shortcut key combinations can generally be used in file, memory or XY views, except where

otherwise specified.

Key Operation

Left arrow Scroll display left.
Right arrow  Scroll display right.
Ctrl+Left Decrease X axis range.
Ctrl+Right Increase X axis range.
Ctrl+Home Show all X range.
Ctrl+X

Down arrow

Provide the X Axis range dialog.
Shift data down (scroll Y axis) on all selected or visible channels.

Up arrow Shift data up (scroll Y axis) on all selected or visible channels.

Ctrl+Down Increase Y range (data shown smaller) on all selected or visible channels.

Ctrl+Up Decrease Y range (data shown bigger) on all selected or visible channels.

Home Show all Y range on all selected or visible channels.

End Optimise Y range on all selected or visible channels.

Ctrl+y Provide the Y Axis range dialog.

Double-click  Zoom or un-zoom double-clicked channel (file and memory views only).

Del Hide the selected channels (file and memory views only).

Ctrl+Del Provide the customise display dialog.

Ctrl+B Toggle displaying the frame buffer (file and memory views only).

Ctrl+D Toggle frame display list overdrawing (file and memory views only).

Ctrl+Shift+D  Provide the frame display list dialog (file and memory views only).

Ctrl+n Where n is 0 to 9. Fetch vertical cursor 0 to 9. If the cursor does not exist it is created.
Cursor 0 exists only in file and memory views.

Ctrl+Shift+ If cursor 0 is active, search for the next/previous feature and scroll the screen to make it

Left/Right visible (file and memory views only).

PgUp Next frame (file and memory views only).

PgDn Previous frame (file and memory views only).

Ctrl+PgUp Last frame (file and memory views only).

Ctrl+PgDbn First frame (file and memory views only).

Ctrl+A Open the experimenter's notebook (file and memory views only).

Ctrl+I Open the File information dialog (file and memory views only).

Ctrl+G Provide the Goto frame dialog (file and memory views only).

Ctrl+C Copy the image of the view and data as text to the clipboard.

Ctrl+N Open a new view.

Ctrl+0 Open the file open dialog.

Ctrl+E Export data (file and memory views only).

Ctrl+p Print the current data file.

Ctrl+L Open the Evaluate window to run single line script commands.

Ctrl+T Toggle the frame tag (file and memory views only).

Ctrl+z

Undo the last undoable operation.
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Ctrl+Break Break out of long drawing or calculation operations.

There are also a large number of keyboard shortcuts for various analysis and data manipulation operations for file
and memory views only. These are documented separately at the end of the Analysis menu chapter. There are also
a number of shortcuts for control of sampling.

Text view topics
Text view features

Drag and drop

The editor supports drag and drop of text both within Signal and between Signal and other applications that
support it (for example the Signal Help system). Signal also supports drag and drop for rectangular text areas.

Operation Method

Move block Select the text to move. Move the mouse pointer over the selected text and hold down the left
mouse button and drag. The mouse pointer will indicate that you can now drag the text and the
text caret will show the insertion point. Drag the text to the desired insertion point and release.

Copy block Select the text to copy. Hold down the ctr1 key and move the mouse pointer over the selected
text, click and drag. A small + symbol indicates the copy operation and the text caret will show
the insertion point for the duplicate. Drag the text to the target position and release the mouse
button to duplicate the text. The ctr1 key must be down when you release the mouse button or
the operation will move the text.

Virtual space

Prior to Signal version 4.06, the text caret could only be positioned between or next to existing characters in a text
line. From version 4.06 onwards, you can position the caret beyond the end of the text in a line by clicking in a
blank area with the mouse, or using the cursor right key. You cannot position the text caret below the last line of
text. When the caret is beyond the end of the line, it is said to be in virtual space. If you type with the caret in
virtual space, space characters will be added to fill in the virtual space up to the text you type.

There are two main uses for virtual space: to add comments without having to space along to the required column,
to make rectangular selections without having strange visual effects due to short lines.

If you use the script language to manipulate the text caret and make selections, virtual space is ignored; a caret in
virtual space will be treated as if it is at the end of the line. There are no script commands that will move the caret
into virtual space. If there is a requirement for the script to report or use virtual space, we will extend the script in
a compatible way to incorporate it.

Multiple selections

From Signal version 4.06 onwards, you can make multiple selections in a text view. To do this, hold down the
ctrl key and click and drag. Each time you make a new selection in this way it becomes the current selection; all
previous selections are shown with a different selection colour. When you have a multiple selection, each selected
area has a flashing text caret at the insertion point. If you type characters, these will appear at all insertion points,
replacing all the selected text. If you use the delete or backspace key, all selected text will vanish. Note that pasting
into a multiple selection will clear all the selected text, then insert the pasted text at the current (last made)
selection.

Multiple selection can be useful when you want to move several non-consecutive script functions to make them
consecutive.

3-25



Signal Version 7.07

Select rectangular text area

You can select, cut, paste and drag rectangular selections within Signal. To select a rectangular area hold down the
Alt key then select text with the mouse. The point where you hold down the mouse button will be one corner of
the selection, the point where you release the mouse will be the other corner. You can use this feature to change the
alignment of comments in a script, or to convert a single column of numbers into multiple columns. You can also
paste such text into other applications as plain text.

A rectangular selection will paste within Signal as a rectangular selection. Beware that Ctrl+x (cut) on a
rectangular selection followed by ctr1+V (paste) will not leave the text unchanged (unless you select the text from
bottom to top). The cut operation will leave a vertical flashing line (assuming a fixed pitch font) with the insertion
point marked by a more visually obvious caret. The paste operation will paste the cut text as a rectangular block at
the insertion point.

A rectangular selection is a multiple selection.

You can also easily select whole lines of text by holding the mouse pointer just off the edge of the margin on the
left of the text view. The mouse pointer changes to a rightwards-leaning arrow when you are in the line selection
area. A selection that is a number of whole lines of text can be moved up and down by using A1t+Up and
Alt+Down.

Read only text

If you open an output sequence or script file that is held in a read only file, the text window will also be marked
read only and you will not be allowed to change it. This is to allow users to protect sequences and script from
inadvertent change. If you want to edit such a text file you have two options:

1) Close the file, remove the read only status on disk, then open it
2) Save the file to a new file with a different name

You can use the Modified () script command to get and change the read only status of a text file. However, if the
original disk file is marked read only, using Modified () to allow you to edit the text will not change the status of
the disk file, so you will not be able to save it to the same file name.

Text view keyboard shortcuts

Text views have more keyboard short cuts than any other area of Signal. We have grouped them by function to
make the huge list more digestible. There are more keyboard shortcuts for data view manipulation, for analysis,
and for control of sampling.

Cut, Copy, Paste, Delete, Undo and Redo

Some of these operations are also available from the Edit menu and the main toolbar.

Key Operation

Ctrl+A Select all the text in the document.

Ctrl+C Copy selected text to the clipboard. If no text is selected, nothing is copied. Some keyboards have
cErl+Inse Ins in place of Insert.

r

Ctrl+Shif  Copy the current line to the clipboard.

t+T

Ctrl+v Paste the contents of the clipboard into the text at the caret. If there is a selection, the selection is
Shift+Ins replaced

placed.

ert

Ctrl+D Duplicate the selection.

Ctrl+X Cut the selected text and copy it to the clipboard.
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Shift+Del Cut the selected text and copy it to the clipboard.
BackSpace Delete the selection or the character to the left of the text caret.
Del Delete the selection or the character to the right of the text caret.

Ctrl+Del  Delete word right. Add shift to delete to the end of the line.

Ctrl+D Duplicate the selection.

Ctrl+Shif Delete the current line.

t+L

Ctrl+Zz Undo the last interactive text operation. The editor supports more or less unlimited levels of Undo.
Alt+Backs

pace

Shift+Ctr Redo the immediately previous Undo operation.
1+2

Find, Replace and Bookmarks

The Find and Replace commands can be accessed from the Edit menu, from the Edit Toolbar and by keyboard
short cuts:

Key Operation

Ctrl+F  QOpen the Edit menu Find dialog. In addition to searching for text you can also use this dialog to
bookmark all matching text.

Ctrl+H  This shortcut key opens the Edit menu Replace dialog.

F3 Repeat the last find operation in the same direction. You can use the toolbar to search forwards or
backwards.
F2 Move the text caret to the next bookmark. You can use the edit toolbar to move to the next or

previous bookmark.

Ctrl+F2 Toggle bookmark on the current line. You can use the edit toolbar to set or clear a bookmark and to
clear all bookmarks.

Bookmarks tag a line for future reference. They are displayed as a blue mark to the left of the text. Bookmarks are
kept as long as the current file is open; they are lost when you close the file. The easiest way to use a bookmark is
from the Edit Toolbar. You can show and hide this from the Edit menu (when a text-based window is active), or by
clicking the right mouse button on any toolbar or on the Signal application title bar and using the pop-up context
menu that appears.

Indent and Outdent

The structure of Signal scripts and other text files can often be made clearer by indenting program structures. To
make this easier, you can indent and outdent selected blocks of text to the next or previous tab stops. The tab size
is set in the Edit menu Preferences Display page for script, sequencer and text files.

Key Operation

Tab If there is a multi-line selection, all lines included in the selection are indented so that the first
non-white space character is at the next tab stop. If there is no selection, a tab character is
inserted (or spaces to the next tab stop depending on the Edit menu Preferences settings).

Shift+Tab If there is a multi-line selection, all selected lines are out-dented so that the first non-white
space character on the line is at the previous tab stop. If there is no selection, the text caret
moves to the previous tab stop unless it is already at one.
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Text caret control

The text caret is a flashing vertical bar that indicates the current position. Do not confuse this with the I-beam
mouse pointer which does not flash and which indicates the mouse position. Each time you click and release the

left mouse button

(we assume you haven't swapped the mouse buttons), the caret moves to the nearest character

position to the click point. To select text with the mouse, click at one end of the text you want to select and drag
(move the mouse with the button held down) to the other end of the text. You can also use the keyboard to move
the caret and select text:

Key

Operation (+shi ft to extend a text selection, +a1t+shift for rectangular)

Left arrow

Right arrow

Up arrow

Down arrow

Move the caret one character to the left. At the start of a line it wraps to the end of the previous
line.

Move the text caret one character right. You can move it into uncharted territory beyond the
end of the line. It does not wrap to the next line.

Move up one line.

Move down one line.

Ctrl+left Move one word to the left/right. This means move the caret to the next boundary between a

Ctrl+Right word character and a non-word character. Word characters are defined to be useful and vary
depending on the view type. In a script view, they are A-2, a-z, 0-9, , $ and %. In an output
sequence, they are A-Z, a-z and 0-9. All other text views use A-Z, a-z, 0-9 and _ as word
characters.

Ctrl+Up/Down Scroll the text window up and down, leaving the selection unchanged.

Alt+Up/Down  Move the lines containing the selection up or down by one line.

End Move the caret to the right of the last character on the line.

Home Move the text caret to the start of the current line.

Alt+Home Move the text caret to the start of the current line.

Ctrl+End Move the text caret to the right of the last character in the file.

Ctrl+Home Move the text caret to the left of the first character in the file.

ctrl+] () Start of next (previous) paragraph (after empty line)

ctrl+\ (/) Word part right (left).

PgUp Move upwards by one window of lines.

PgDn Move downwards by one page of lines.

Insert Swap between insert mode caret | and over-type caret

Miscellaneous
These commands do not fit into any other category!
Key Operation
Ctrl+U

Ctrl+Add, Sub

Convert the selection to upper case. Add shift for lower case

Change font size (Add and Sub are numeric keypad + and - ). You can also change the
displayed text size by holding down the ctr1 key and using the scroll wheel on your mouse
(if you have one). The View menu Standard Display command will remove any zooming.
The script equivalent is ViewZoom ().
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Grid view topics

You can create a Grid view interactively with the File menu New command or from a script with the
FileNew (17, mode%, rows%, cols%); command.

You can save and restore grid views with . sggx files (these are XML files internally). Grids support cut and paste
of text using a tab character "\t" to separate columns and an end of line character "\n" to separate rows. There
is also the Grdxxx. . . () family of script commands to support the grid.

What the Grid is and what it is not

Our first implementation of a Grid is not attempting to be a spreadsheet program. It is implemented as a utility to
make it relatively easy to generate tabulated data. The initial implementation stores data as text, but we may extend
this to allow data to be stored as integers, or real numbers with some user-control of formatting. There is no
capability yet in the grid to refer to other cells or to allow expressions to be evaluated.
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| Text | 1.23456 this |
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s
right
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Grid properties
The underlying grid implementation is capable of giving each cell its own font, alignment and type. To give us a
chance of implementing the grid in a reasonable time, we have restricted the grid as follows:

Size

The grid is currently restricted to 10000 rows and 1000 columns. We may change this to a limit based on the
product of rows and columns (so you can have more or one at the expense of the other). Rows and columns are
numbered from 0,0 at the top left. There is a default size for grids created interactively; from a script you can
create a grid with a defined size with FileNew (17, ...) and you can resize it with GrdSize ().

Headers

The grid has one header row at the top and one header column on the left. You can choose to hide or show these
headers. By default the header column displays the 0-based row number and the column header displays columns
as letters, A-Z for columns 0 to 25, AA-AZ for columns 26 to 51 and so on.

Font
All cells in the body of the grid use the same font. The headers use a bolder version of the same font.

Row and column spacing
For simplicity, all rows are the same height, which is based on the font. Columns can be sized individually, or you
can set a standard size, or you can optimise the columns widths to match the data displayed in them.

Alignment
You can apply Left, Centred or Right alignment on a column by column basis.
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Information window topics

The information window is a specialised type of view which can display times and special information using a very
large font for extra visibility. Information windows are attached to a time, memory or XY view and when saved to
disk these views will also save the information needed to re-create any associated information windows when the
file is re-opened.

You can create an information W& Wz Eeneii e

window interactively with the

View menu New Info window EEHRI0 fesch

command or from a script with

the InfoNew (mode%) 1 9 . 2 8 ® 3 4
function, other script functions . -

can be used to manipulate
information  windows.  An

o FRAME 1 (MAX 20
set by a string which includes

special fields that are replaced
by other information (for

example, the current frame
number).

Information windows can also display an image file instead of the standard background and either the area
containing the buttons or the window title area (or both) can be hidden if desired. These and other options are
available via a menu generated when you right-click on the information window.

Copy current file path to clipboard

When working with file views (data, result, XY or text-based) you can copy the full path to the file (if the view has
an associated file) by right clicking on the view title bar and then selecting the Copy path item that appears. This is
especially useful if you have set the operating system to not display full path names.

The Signal command line

When Signal starts, it checks the command line for option switches and for files to load. If there is no command
line, Signal looks in the folder that it ran from for a script called startup.sgs and, if it exists runs it. If startup.sgs is
found and run or if the command line loads a file, any start up messages that wait for a user response are
suppressed. The items in the command line used to run Signal are also available to running scripts by using the
System$() script function.

The command line holds option switches and file names, separated by white space characters (space and tab). If a
file name contains spaces, you must surround the file name with quotation marks. Option switches start with a / or
— character followed by a character to identify the option. The switches understood by Signal are:

M When you start Signal, it checks if there is already a running copy. If there is, the new one quits. This
option removes the check, allowing multiple copies to run on a single system. You need a Signal license
for each copy except when using multiple synchronised 1401s to capture related data on one computer
under the control of a single operator, when one license is sufficient. To do this, you must set separate file
names for each 1401 in the Automation tab of the Sampling Configuration dialog.

/Un nis 1-8 to select a 1401 when you have more than 1. The default is /U0, which uses the lowest-numbered
unused 1401. You set a device number in the CED 1401 device settings in the Device Manager (My
Computer->Properties->Hardware->Device Manager).

/Q Quiet startup. Suppress all message boxes and the Signal "splash screen".

The remaining items in the command line are assumed to be file names. Signal attempts to load the files in
command line order (from left to right). The files must have extensions so that the file type is known. If a script file
is included in the command line, Signal runs it before continuing with the remainder of the command line.

As an example, suppose we want to launch Signal so that it automatically opens a data file called example.cfs and
runs doit.sgs to process it. Follow these steps:
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1 Create a short cut to cfsview.exe (this is the Signal program).

2 Right-click on the new short cut and select Properties and open the Shortcut tab.
3. Add example.cfs doit.sgs to the end of the Target field.

4 Set the Start in field to the folder that contains your files.

5 Click OK.

This example assumes that both files are in the same folder. You could also have included the full path to each file
in the command line.

64-bit operating systems

Before Signal version 6, all versions of Signal were 32-bit programs, even if the operating system was 64-bit. From
Signal version 6, by default, we will install a 64-bit version of the program on 64-operating systems and a 32-bit
version on 32-bit operating systems. The advantages of 64-bit code on a 64-bit operating system are:

1. The 64-bit version of the CPU has more registers and instructions; "typical code" runs maybe 10% faster.
2. Calls into the operating system do not transition from 32-bit Signal code to 64-bit system code and back.

3. A 32-bit program is limited to a 4 GB memory space, and of this, quite a bit (typically 1GB) is reserved for the
32-bit operating system. With a 64-bit program you can use a lot more memory.

There are some disadvantages, too:
1. 64-bit code is typically larger (for example the cfsview.exe file is 20% larger as 64-bit code).
2. Pointers in memory are double the size, so memory usage increases.

Unless your system has limited installed memory, we recommend that you use the 64-bit version of Signal on a 64-
bit operating system.

Installation and data directories

This section applies to Signal version 6 and 7, so we refer to installation directories as SignalN where N stands for
6 or 7 as appropriate.

Note:  The example file paths in this section relate to English language versions of Windows. Program Files
can have different names depending on the language set for the system. Similarly, My Documents can be
different in different languages.

Previously, we installed Signal by default in a top level folder such as C:\SignalN. While this practice was
satisfactory when used with earlier versions of Windows, it has become deprecated, mainly for security reasons.
We have altered Signal so that it can be installed in the protected C: \Program Files folder as expected by
Microsoft. Some users will prefer to keep their existing arrangements so we still support installation into C:
\SignalN or similar. This support will be removed at some future point.

The main change caused by installing inside C: \Program Files is that this location is expected to be read-
only as seen by users. While there is no problem in storing data files, sampling configurations, scripts and other
files in C:\SignalN, you are not allowed to modify anything inside C: \Program Files. Therefore as part of
the Signal installation new folders are created for the current user's data, for data shared between all users and for
data generated by the application.

New folders created by the installer

User data directories
User data directories are used to hold data that is directly saved or loaded by the user, for example data files,
sampling configurations and scripts. Two such directories are created by the Signal installer:

e Data for the current user (the user who installed Signal). This directory is called SignalN and is created
inside the My Documents folder for the current user. Windows has separate My Documents folders for
each user of a computer system, this directory is only created inside My Documents for the current user.
When installing inside C: \Program Files the Signal installer puts all data intended for the user's own
use inside this directory, the folder contains the Data, Scripts, Sequence, ExtraDoc and TrainDay
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folders plus all of their contents, in addition an empty Include directory is provided to hold your own script
include files. This folder can also be used to hold your own files though of course you can use any directory
you choose for this.

e Data for all users of this computer. This directory is called SignalNShared and is created inside the
Documents folder provided for all users of the system. The installer does not put any data inside this
directory but it does create an empty Include directory inside it to hold any shared script include files that
should be generally available. If there are multiple Signal users on the system this directory ensures that there
is always a suitable directory for user's data.

When searching for the user data directory, Signal first looks for the current user's data directory and if this is not
found will use the user data directory for all users. If neither of these directories can be found Signal uses the
current user's My Documents folder as a last resort. If there are other Signal users on the system apart from the
one that installed Signal they can create their own SignalN directory inside their My Documents folder if they
want, or they can use their own data directory somewhere or make use of the shared directory for all users.

Application data directories

Application data directories are used to store data that is generated by the application without any direct user
involvement, for example the filter bank settings and the default and last-used sampling configurations. In the same
manner as the user data directories, two application data directories are created by the Signal installer:

e Specific to the current user (the user who installed Signal). This folder location varies with the operating
system version but in Windows7 the folder is C: \Users\Username\AppData\Local \CED\SignalN.

e Shared between all users. This folder location varies with the operating system version but in Windows7 the
folder is C:\ProgramData\CED\SignalN. If there are multiple Signal users on the system this directory
ensures that there is always a suitable location available for application data.

When searching for the application data directory, Signal first looks for the current user's application data directory
and if this is not found will use the application data directory for all users. If neither of these directories can be
found Signal uses the current user's My Documents folder as a last resort. If there are other Signal users on the
system apart from the one that installed Signal they should create their own CED\SignalN directory inside their
own AppData\Local folder unless they are happy for Signal to use the shared application data directory for all
users.

Moving your files to a new-style location

After an installation inside C:\Program Files, Signal and the data files that are installed with Signal will be in
their new locations but any files in the original C:\SignalN directory (or whatever has been previously used) will
be left unchanged. This applies to both your own files and the previous installation of Signal. There is no reason
why you have to do anything much about this - you can continue to load sampling configurations from and save
data files into C:\SignalN just as before and many users may prefer to do this, perhaps after cleaning it up (see
below). Alternatively you can choose to keep your data (and other files) in the new location for user data files. This
can be done by moving all .cfs, .sxy, .sgr, .sgrx, .sgc, .sgcx, .sgs and .pls files (plus any other
files you might want to keep: . txt? .jpg?) that are inside C:\SignalN plus any folders of your own into the
SignalN directory inside your My Documents folder. Once you do that you will be able to use your data files,
scripts, sampling configurations and other files from the new location. There are a small number of possible issues
involved in moving these files (see below for a list of these) but generally things will Just Work. After moving all
of your data to a new location you should check the following:

Application-level issues: While the Signal application will run in its new location without any problems, there may
be a number of minor issues relating to moving your files or installation into the new location:

e The Sampling page of the Preferences dialog contains the path to a directory which is used to store the
temporary CFS data file which is created by sampling. Previously this was set by default to be the directory
in which Signal was installed, so you will probably see that it is something like C:\SignalN. While there
is no problem in leaving this setting unchanged even if you have deleted C:\SignalN, if you want you can
get Signal to set it to the application data directory by clearing the path in the preferences dialog and pressing
OK. You should avoid setting this to a directory inside C: \Program Files as this might cause problems.

e Global resources - some options for the global resource file location use the directory where Signal is
installed. While this location can still be used you will have problems if you try to make use of a directory
inside C:\Program Files, so Signal now uses a list of directories which are searched in turn for the
required file. The list starts with the current user's data directory inside My Documents - if you are using
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global resource files inside the directory where Signal is installation you should move the resource files to
this location or somewhere else suitable and adjust the global resource setting to match.

e The Sample and Script bars hold lists of sampling configurations and script files. These lists hold the
complete path to the file so if you use either of these you should update them so that they use the new file
locations.

Data and XY file issuess: There should be no problems with the data files themselves as they do not contain any
information relating to directory locations. However if a background image file has been set up for a data or XY
file the background image settings will contain a complete path to the image file which may need to be updated.

Sampling configurations: Sampling configuration files can contain a number of directory paths which may need to
be adjusted. Note that (as documented just below) Signal will only write sampling configuration files using the new
XML file format and . sgcx file extension so any sampling configurations you change will have to be converted to
the new format (by using them for sampling before) they can be saved. As changed sampling configurations will
use the new file name extension your old configuration files will remain unchanged; if you want an original
sampling configuration you should use the . sgc file while if you want updated configurations you should use the
. sgex file. The things you might have to change are:

e Sequence file.Where the sampling configuration Outputs page specifies a sequence file to be used during
sampling, the entire path to the sequence file is stored and will point to the previous directory for the .pls
sequence file, this should be changed to point to the new file location.

e Automatic file-naming. Where a sampling configuration Automation page specifies a directory for
automatically-named files this path might now point at a non-existent directory and should be suitably
adjusted.

e Dynamic clamp model tables in text files. Some dynamic clamp models use user-generated text files to
customise their behaviour. The model settings include the text file name which can optionally include a
directory path. The location of these files are normally relative to the sampling configuration location, in
which case Signal will be able to find the files but any absolute text file paths (paths starting with a drive
letter and colon) should be adjusted to point to the new file locations.

Sequence files: Apart from the references to sequence file names in sampling configurations that are described
above, there should be no problems with these and no changes to these files will be required.

Script files: Depending upon how they are written and what they do, script files may or may not have problems.
Any problems that do occur will probably be caused by file path string constants in the scripts which may need
adjusting and by the use of the FilePath$ () function. Any use of FilePath$ (2) to get the directory where
Signal is installed is likely to give problems as you should not create or write to files inside Program Files and
you should adjust the script so that it uses a different location. The parameters to FilePath$ () have been
adjusted to allow you to find the current user data folder - we suggest that you change to using this location.

Cleaning up the old installation location with or without moving your own files
If after installing Signal into a new location inside C:\Program Files, you want to leave your files in the old install
location but get rid of the previously installed Signal application you should do the following:

e Delete the 1401, BaseDemo, Export, import and include folders inside the old install location. If you
have not put any of your own files into them, you can also remove the data, ExtraDoc, scripts,
sequence and trainday folders.

¢ Inside the old Signal installation folder itself, delete all .exe, .d11, .chm, .sgl, .t14 and . tip files. All
of these are files specific to the Signal installation and will have been replaced by newly installed files in the new
installation location.

Unicode

Before Signal version 6.03, all text in Signal was represented by 8-bit characters with codes in the range 0 to 255
(hexadecimal 0x00 to Oxff). In the 8-bit character world, characters with codes 0 through 127 are pretty much
universal, for example character 32 (0x20) is a space anywhere on the planet. These are sometimes referred to as
the ASCII character set. However, character codes 128 to 255 (0x80 to 0xff) have meanings that depended on what
code page your computer is set to. As some cultures have many more characters than can fit in the 255 available, in
some cases pairs of 8-bit characters are used to represent characters. The result of this was that you could use
characters with codes above 127 to represent national characters in text views, but if you sent a data file or text file
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that used such characters to someone with a computer set to a different code page, the result was unpredictable
(and often gibberish).

The solution to this problem is to use a character encoding that does not limit us to 8-bit characters. The Unicode
Consortium has defined a standard set of characters (1,112,064 valid code points) that can encompass all the
cultures on the planet. The characters are grouped into 17 'planes' of 65536 characters, of which the most important
is the first, known as the Basic Multilingual Plane (BMP). Character codes 0-127 of the BMP have the same
meanings as the ASCII codes 0-127, which is very convenient for backwards compatibility. The BMP holds the
vast majority of the characters used in everyday communication. The remaining planes hold more infrequently-
used and specialist characters, such a music clefs, historic scripts (hieroglyphs), playing card symbols and the like.

There are a variety of ways of storing Unicode characters in memory and in data files. Only two need concern us:
UTF-8 and UTF-16LE.

UTF-8

This is a method of storing Unicode characters using a sequence of 8-bit characters. It has the property that if your
text only uses character codes 0 to 127 (0x00-0x7f), then it is identical to ASCII text. So any Signal script that you
have that does not use any characters with codes above 127 is already coded in UTF-8. Character codes in the
range 128 to 2047 (0x80-0x7ff) are coded in two bytes, character codes in the range 2048-65535 (0x800-0xftft)
need three bytes and character codes greater than that take 4 bytes. If your text is mainly ASCII, or uses only
European characters, this is the most compact coding. The encoding is arranged so that you can always tell if a
particular byte is the start of a character or the continuation of a character.

We have standardised on UTF-8 as the encoding we will use for all external files (scripts, output sequences, XML
resources, text in Signal data files). The text editor within Signal uses UTF-8 internally (though this is of no
consequence to most users). UTF-8 is probably the most common format used for storing Unicode in files; in
October 2014 it accounted for 81.6% (with an upward trend of 4% over the year) of all web pages with a known
encoding. The next most common web format was ISO-8859-1 (which is an 8-bit character set covering European
languages) with 9.8%, down about 2% over the year.

UTF-16LE

This uses 16-bit Little Endian values to store the characters. This is the format that Windows uses internally for all
text. Unicode builds of Signal uses this format internally everywhere except where we have to use 8-bit characters
(1401 communications, serial line input and output, external text files, resource files, the script editor, data import,
MATLARB interface). In UTF-16LE, characters in the BMP are all represented by one 16-bit value. Characters in
all other planes require a pair of 16-bit values. Character codes in the range 0xd800 to 0xdbff are reserved for the
first (lead) of a two word pair and characters in the range 0xdc00 to Oxdfff are reserved for the second (trail) part
of a two word pair. These are known as surrogate pairs.

Updating to a Unicode version of Signal

Signal version 6.03 and onwards uses Unicode characters internally and stores output text in UTF-8 compatible
files. When you update from an ASCII (8-bit character) to a Unicode version of Signal our aim is that you should
see no difference. We achieve this by assuming that any characters that we read above code 127 that are not valid
UTF-8 sequences are code page characters, and we convert text appropriately:

e When we open a script or sequencer or text file in a text editor, we check read file to attempt to guess the format.
If it starts with a BOM (Byte Order Mark: a special code that indicates the file format) for UTF-8 or UTF-16LE,
we assume that is the format. Otherwise, if it holds no characters above code 127 we can already treat it as
Unicode. If it holds correctly formed UTF-8 (this is easy to detect), we assume it is UFT-8. If the text is an even
number of bytes long and holds 0 bytes in odd positions, we assume it is UTF-16LE. If it is none of these, it
must hold 8-bit characters above code 127 and we assume these are code page characters and we translate the
text using the local code page set on the computer. It is possible that we might be fooled into interpreting code-
page text as UTF-8, but this is unlikely for text of any length.

o When we read text from a resource or from a Signal data file we test to see if it holds correctly formed UTF-8. If
it does not, we assume it holds code-page characters.

However, for performance reasons, we do not convert text from #included script files. If you have included a script
file that use characters codes above 127 you must convert these by opening it in the script editor and saving it.
Note that we do not count changing the format of a text, script or sequencer file from code-page based to Unicode
as a change (the result should appear identical). To force a converted file to write you will need to use the File
Save As command or edit the file.
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Backwards compatibility

If you update to Unicode by saving a script or a modified data file or a resource and you used character codes
above 127, the modified files will no longer read correctly into non-Unicode versions of Signal. This will not stop
you opening the files or resources, but any character codes above 127 will not appear correctly. If you write all
your text in English this will not be a problem for you; you will see no change.

The .cfs file format has limited size fields for channel titles, units and comments. The channel units field can be a
problem as this is limited to 5 8-bit characters. If you use extended European characters, these typically code as 2
UTF-8 bytes each, so you are limited to 2 of these, or 1 of these and three ASCII characters. If you use a Far East
typography, such as Japanese, each character uses 3 UTF-8 bytes, so you only have space for one such character
and 2 ASCII codes.

If you require 100% backwards compatibility with old versions of Signal you must use only ASCII character codes
for channel titles, units comments and file comments.

Character set used in scripts and sequences

The characters that are accepted as numbers, punctuation, keywords and variable and constant names in the script
language and in the output sequencer are restricted to the ASCII set. There are additional sets of numbers,
punctuation and a-z and A-Z in Unicode, for example Japanese defines wide versions of numbers and A-Z; these
cannot be used. You do have a free choice of Unicode characters for comments and for string literals in the script
language.

Resource limitations

There are some limitations that are imposed on us by the operating system and the computer environment. Some of
these are obvious, some less so:

Memory

Your computer will have a fixed amount of memory (typically several GB). This is shared out between all the
competing programs as they require it. If you use a lot of memory, for example by using Memory buffer channels
and copying vast quantities of data into them, Windows will try to cope with this (especially if you run under a 64-
bit operating system), but at some point the operating system will start swapping allocated memory to disk. This
makes things much slower. If you keep allocating more memory, at some point Signal will start reporting that it is
out of memory. The more memory your system has, the more you can use.

If you run under particularly restrictive rights you may find that you get error -544 when Signal tries to allocate the
memory Working Set.

Disk space

This is a pretty obvious limitation. Once you have filled your disk, you cannot use more space. However, you may
well find that once a disk becomes significantly full, disk operations start to get slow. It is usually well worth
periodically cleaning up your disk system by deleting unwanted files. It may also be worth de-fragmenting your
disk (though this seems less important in modern versions of Windows).

GDI and User Handles

Windows tracks the use of GDI objects (things like fonts, bitmaps, brushes, pens and drawing surfaces) and User
objects (things like desktops, windows, menus, cursors, icons and menu short cuts). For reasons tied up in the
history of Windows and for backwards compatibility, these have 16-bit identifiers, which meant that there can only
be 65535 GDI and 65535 User handles. Each application is limited to 10,000 GDI objects and 10,000 User
objects. Most programs do not use a huge number of either (typically a few hundred of each), so this is not usually
a problem.

It starts to be a problem when an application creates lots of windows as each window will use quite a few handles.
You can track the the number of GDI and User objects with the App () command. Each new view (visible or not)
uses some 20 to 100 of each of these objects. This means that you can run out of handles by opening 300-400 data
views (or even fewer if they all have a lot of channels). We refuse to allow you to create new views if you have
used more than 9900 of either object. If this happens, you are probably running a script that is not deleting
windows that it has created.
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Symptoms of resource exhaustion
Windows does not manage running out of resources very gracefully. The symptoms include:

e Messages from Signal warning that there was not enough memory or resources to complete an action
e Missing areas or channels in window or screen repainting problems

e Text appearing in degraded fonts

e Poor system performance (to the point of appearing to stop)

e Crashes

If you start to suffer from these problems while using Signal, do the following:

o Save any volatile data in case things get so slow that you cannot continue.

e Check for a lot of hidden windows in the Windows menu Show list or in the Windows... command. Close down
(and save, if required) unwanted, hidden windows.

e If you are running a script, check that you are closing all windows that you have opened. Each FileNew () or
FileOpen () should have a matching FileClose ().

e If you are running a script, have you used a huge array space, and could you reduce it? Script users can use
DebugHeap () and App (-4) commands to get information on used memory resources.
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Sampling data

If you worked through the Getting started section you already have most of the skills to sample a new data
document. Sampling a new document is the same as working with an old document, except that the new document
grows in length as new frames are added. There is also a special frame zero that shows incoming data from the
1401 as it is sampled and before it is written to the file, you would normally display this frame so you can see what
the sampling is doing.

Inputs and outputs

Before we discuss the sampling configuration itself, we need to provide some information on the types of input and
output signal available to users of the 1401. There are two basic types of signal, analogue and digital.

Analogue signals are varying voltages that can have any value within the available range, normally this range is -5
to +5 volts. Because the 1401 handles these signals as a 16-bit binary number, the actual values available are
quantised to the available integer values. The 1401 provides analogue inputs via the ADC inputs and analogue
outputs via the DACs.

Digital signals use TTL-compatible voltages that can take only two values; low and high. The 1401 provides both
digital inputs and digital outputs.

ADC inputs

The 1401 ADC (Analogue to Digital Converter) measure varying voltage signals in the range of +5 volts, these can
be optionally changed to £10 volts if required - usually this requires the unit to be returned to CED. The
Power1401 mkIl, Micro1401-3, and later 1401 models all incorporate software control of the ADC input range -
you can switch these units between 5 and 10 volts using the 1401 options dialog in the Try1401 utility installed
with Signal. The ADC generates a 16-bit integer value representing the voltage seen, with -32768 corresponding to
the lowest voltage possible and 32767 corresponding to (just less than) the highest voltage. Zero corresponds to
zero volts. Signal uses the ADC inputs to generate waveform channels through sampling.

ADC input connections
To sample waveforms, connect your signals to the 1401 ADC input ports that you are sampling. Ports 0-7 (0-3 for
an unexpanded Micro1401) are the labelled BNC connectors on the front of the 1401.

For early-model Power1401s without an ADC expansion topbox, ports 8-15 are on the rear panel 37-way "D-type"
connector labelled Analogue Expansion. The connections on this are:

ADCport [ 8 9 10| 11 (12 ] 13| 14 | 15 Ground
[Pin number| 35 | 34 | 33 | 32 | 31 | 30 [ 29 | 28 1-19

For late-model Power1401s and Power1401 mk IIs and above the Analogue expansion socket is a high-density 44-
way "D-type" connector. On this connector each signal has its own separate ground return. The connections are:

ADC port 8 9 10 11 12 13 14 15
Pin number 33 34 35 36 37 38 39 40
Ground return| 3 4 5 6 7 8 9 10

For port numbers above 15 you will require an expansion topbox for your micro or Power1401. If you have a
Micro1401 ADC expansion box installed, ports 4 to 15 are BNC connectors on the expansion box. If you install a
Power1401 expansion box, it adds new ADC ports starting at number 8 and the port numbers on the rear expansion
connector are adjusted to start after the expansion box ports, so if you add an ADC-16 topbox ports 0-7 are on the
main unit, ports 8-23 are on the topbox and ports 24-31 are on the rear connector. If you try to sample using a port
above the number available on your 1401, Signal will generate an error message.
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DAC outputs

The 1401 DAC:s (Digital to Analogue Converters) produce varying voltage outputs in the range +5 volts, these can
be optionally scaled to +10 volts if required. DACs can be used to generate pulses with arbitrary initial values and
amplitudes (as long as they lie within the DAC output voltage range), they can also generate ramps, sine waves and
arbitrary waveforms.

To generate complex DAC outputs and particularly for arbitrary waveform output, the DACs must update
repeatedly with new output values. The faster this is done, the more accurate the output pulses or waveforms.
However, very high DAC output rates may interfere with data acquisition. Signal pulse output is limited to a time
resolution of 100 microseconds, which is not fast enough to cause any interference with data acquisition.

The Power1401s have four DACs, numbered 0 to 3, while Micro1401s have two (0 and 1). Micro1401s have the
DAC outputs available on BNC connectors on the left-hand side of the 1401 front panel. Power1401s have DACs
0 and 1 on the front panel and has DACs 2 and 3 on pins 36 and 37 respectively of the rear-panel analogue
expansion connector. The Power1401 mk II and later versions of the Powerl401 have a high-density 44-pin
analogue expansion connector with DACs 2 and 3 on pins 43 and 44.

If your Power1401 has a Signal expansion top box fitted, then 8 DAC outputs are available via BNC connectors on
the 1401 front panel.

TTL compatible signals

In several places in this manual we refer to TTL compatible signals. TTL stands for Transistor-Transistor Logic
and is a method of passing logical (High/Low) information between devices using voltage levels. Levels above 3.0
volts are in the High state, levels below 0.8 volts are in the Low state. Levels in between 0.8 and 3.0 volts are
undefined.

The TTL inputs and outputs on the 1401 are the digital inputs and outputs, the event inputs, the clock F external
frequency input, the ADC external convert input, the clock output and the trigger input. On Micro and
Powerl1401s, the event and trigger inputs are not actually TTL but can be treated as such (they are actually heavily
protected analogue inputs from which a TTL signal is derived).

The event, trigger and ADC external convert inputs are edge-sensitive; they respond to either a falling or rising
TTL input, the edge to which they respond can be controlled using the Rising edge trigger option in the General
tab of the sampling configuration dialog.

Do not subject TTL inputs to voltages above 5.0 volts or less than 0.0 volts. CED hardware has special circuits on
TTL compatible inputs to provide some protection, however determined abuse will damage them.

The 1401 TTL compatible inputs are pulled up by a resistor to 5 volts. They require a current of some 0.8 mA to
pull them into the Low TTL state. Alternatively, you can connect them to ground to pull them low (useful for the
Event inputs).

See the Owners handbook of your 1401 interface for full details of each input port.

Trigger input

All modern 1401 systems have a Trigger input BNC on the front panel, it is actually the 1401 event zero input but
re-routed to the front of the 1401. This is a TTL input that normally responds to low-going pulses. It is possible to
configure the trigger input so that it responds to high-going TTL pulses instead.

Signal generally always uses a pulse on the trigger input as the sweep trigger except in Peri-triggered sampling
mode when, in addition to the Event trigger mode (which uses the standard trigger input), other forms of sweep
triggers are available.

Digital inputs

1401 systems have 16 bits of digital input available, numbered 0 to 15. They are normally used separately as two
eight-bit input sets, which can cause some confusion between overall bit numbers and bit numbers within the low
or high digital inputs.

Digital input bits 8 to 15 are used in External digital states mode and in Peri-trigger sampling, they can also be
used as triggers for some of the dynamic clamping models. Digital input bits 0 to 7 are read by the output
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sequencer and are used for digital markers. To keep the various discussions simpler, Signal refers to both sets of
inputs as bits 0 to 7, the context determines if we actually mean bits 0-7 or 8-15.

The 1401 digital inputs are on a 25-way ‘D-type’ plug on the rear of Power1401s and Micro1401s.

Power1401s and Micro1401s have digital inputs 8 and 9 on 1401 front panel BNC sockets for easy access. These
are labelled as event inputs 0 and 1 to match Spike2 usage. If the Spike2 digital I/O expansion top box is fitted, it
has digital inputs 10 to 15 on front panel BNC sockets labelled as events 2 to 7 (again to match Spike2 usage).

Digital input connections

Signal input bit number 7 6 5 4 3 2 1 0 |[Gnd
External digital / Peri-trig pin / DC trigger pin[ 1 14 2 15 3 16 | 4 17 | 13
numbers

Sequencer / Marker pin numbers 5 18 6 19 7 20 8 21 | 13

Digital outputs

The 1401 digital outputs are TTL-compatible and can be set high or low. When high they generate a voltage in the
range 2.6 to 5 volts; the usual lightly loaded level is about 4.5 volts. When low they generate a voltage between 0
and 0.6 volts.

The Signal pulse output system and the output sequencer DIGOUT instruction control 1401 digital output bits
8 to 15 of the 16-bit digital output port. If you use the output sequencer, you can also set bits 0 to 7 with the
DIGLOW instruction. Signal refers to both sets of outputs as digital outputs bits 0 to 7, the context determines
which set we mean.

The 1401 digital outputs use a 25-way ‘D-type’ socket on the rear of Power1401s and Micro1401s.

Power1401s and Microl401s also have digital output bits 8 and 9 on 1401 front panel BNC sockets for easy
access, they are labelled 0 and 1 (the labels match Signal usage). If the Spike2 digital I/O expansion top box is
fitted, it has front panel BNC sockets for digital output bits 10 to 15 labelled 2 to 7 (also matching Signal usage).

Digital output connections
Signal output bit number 7 6 5 4 3 2 1 0 Gnd
DIGLOW pin numbers 5 18 19 20 8 21 13
Pulses and DIGOUT pin numbers 1 14 2 15 3 16 4 17 13

»
~

Types of channel

Signal can directly sample two types of channel: waveform and marker. Waveform channels are generated by
sampling from 1401 ADC inputs, marker channels can be generated using the keyboard or from the 1401 digital
inputs. Channels in a Signal data file are numbered starting with number 1, the channel numbers are contiguous.
Memory channels (either marker or real marker) can be created during sampling by measurements processing,
while virtual channels will automatically work with incoming data during sampling.

Waveform channels

The waveforms that Signal records and displays are continuously changing voltages sampled using the 1401 ADC
inputs. Signal stores waveforms as a list of numbers that represent the waveform amplitude at equally spaced time
intervals. These numbers are 16-bit integers, they are scaled using calibration values to produce the floating point
data values that Signal uses and displays. The process of converting a waveform into a number at a particular time
is called sampling. The time between two samples is the sample interval and the reciprocal of this is the sample
rate, which is the number of samples per second. A set of samples taken at regular intervals is referred to as a
sweep, a sweep of sampling generates a frame in a Signal data file.

Signal is also able to handle waveform channels (for example data that is the result of analysis or generated by a
script) where the underlying data is floating point values; these are indistinguishable from channels using integer
data in nearly all circumstances. Floating point data is more accurate and does not require calibration values, but it
requires twice as much disk space. Though Signal can create and use channels based on floating-point data, Signal
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data created by sampling is always based upon 16-bit integers from the ADC hardware and calibration values taken
from the sampling configuration.

ADC ports and channels

Waveform channel data is generated as described above by sampling from ADC inputs. A 1401 has a number of
separate ADC inputs, these are called ports and are numbered from zero upwards — so a Micro1401 with four ADC
inputs has ADC ports numbered 0 to 3. When you define a Signal sampling configuration the ADC ports that will
be used are specified as a list, for example ports 0, 1 and 3. Note that these port numbers do not have to be
contiguous (or even in ascending order). The ports are sampled in the order given to produce waveform data
channels, the number of channels being set by the number of ports in the list. The data channels are numbered in
ascending order starting with channel 1 and these channel numbers are contiguous. So when the port list given
above is used to sample data, data from port O generates data file channel 1, port 1 generates channel 2 and port 3
generates channel 3.

Minimum sample rate

Original waveform O-0O- Resulting waveform
0 1 2 3 4 5 6 7 8 9
samples

The sample rate for a waveform must be high enough to represent the data correctly. You must sample at a rate at
least double, and preferably 2.5 to 5 times, the highest frequency contained in the data. If you do not sample fast
enough, high frequency signals will be aliased to lower frequencies, as illustrated above. The dots in the diagram
represent samples; the thin line shows the original waveform while the thicker grey line shows how the sampled
data will appear. Just to keep things interesting, you also want to sample at the lowest frequency appropriate to
keep the size of your disk files down.

Voltage range

The 1401 ADC (Analogue to Digital Converter) measure varying voltage signals in the range of £5 volts, these can
be optionally changed to +10 volts if required - usually this requires the unit to be returned to CED. The
Power1401 mk II, Micro1401-3 and later 1401 models all incorporate software control of the ADC input range -
you can switch these units between 5 and 10 volts using the 1401 options dialog in the Try1401 utility installed
with Signal.

Use of filters

Many users pass waveform data through amplifiers or signal conditioners with filter options to limit the frequency
range. Some transducers have a limited frequency response and require no filtering. If you are concerned about
measuring the frequency content of your data, you should ensure that your waveform data is filtered to remove
frequencies above 50% of the sampling rate — the Nyquist frequency.

Marker channels

Signal can sample two types of marker data: keyboard markers and digital markers. Signal treats both marker types
identically once the data has been captured; they differ only in their source. Marker channels can only be logged by
Signal when not using fast sweep modes.

A Marker is a 32 bit time value, in units of the sample interval on waveform channels for keyboard markers and of
the output resolution for digital markers. In addition to the time a marker has 4 bytes of marker code data. The first
of these 4 data bytes is the ASCII code of the keyboard character pressed by the user (for a keyboard marker) or an
8 bit digital code read by the 1401 from the digital inputs (for a digital marker). The remaining 3 bytes are
normally zero.

Keyboard markers
Keyboard markers time events to an accuracy of, at best, around 0.1 second, you should use digital markers if you
require precise timing. The upper and lower case characters a-z and the numbers 0-9 are logged, but only when the
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new document window or the sampling control panel is the current window. The keyboard marker channel, if
created, is the first channel number after the sampled waveform channels.

Digital markers

These are not available for the Standard 1401. Digital markers are timed as accurately as the outputs and record 8
bits of TTL data. These can be used as 8 separate channels of on/off information or one channel of 8 bit numbers
or any combination in between. Digital marker data is sampled when a low going TTL compatible pulse is detected
as described below. The data is read from bits 0 to 7 of the 1401 digital input. Digital markers can also be
generated by the Pulses and Sequencer output systems, for example to show when something was done, in these
cases the marker data can either be read from the 1401 digital inputs or set directly by the outputs. The digital
marker channel, if created, is the first channel number after the keyboard marker channel or after the waveform
channels if the keyboard marker is not used.

Digital marker connections

The digital marker data is read from the 1401 digital inputs bits O to 7. These inputs are found on the 1401 Digital
inputs connector; a 25-way ‘D-type’ plug located on the rear of Micro1401s and Power1401s. In addition to the
data lines a TTL pulse is required on the digital inputs Data Available input on pin 23 to log a digital marker.

Digital input: bits 0 to 7
Digital input bit bit 7 |bit6 |[bit5 |bit4 |bit3 [bit2 |bit1 [bit0 |Gnd
Digital input pin 5 18 |[6 19 |7 20 |8 21 |13

Digital input: other signals
Signal All 1401s
Data Available pin 23

To log a digital marker, apply a low going TTL pulse at least 1 ps wide to the Data Available. When the 1401
detects the falling edge of the input, it latches the input data so the data inputs do not need to remain stable for
more than a few microseconds after the Data Available falling edge.

Marker codes

When Signal displays data from the keyboard marker, digital marker or other marker channels, it shows a marker
code value as well as the marker time. The code displayed is normally the first marker code but can be selected
using the draw mode dialog.

Marker codes have values from 0 to 255. This is the same range of numbers that the ASCII character set uses, and
it is sometimes convenient to treat the codes as ASCII character codes (for instance when dealing with keyboard
markers). At other times it is more convenient to deal with the codes as numbers.

Whenever Signal displays a marker code that has the same value as the ASCII code of a printable character, it
displays the code as a character, otherwise it displays the marker code as a two digit hexadecimal number.
Hexadecimal (base 16) numbers use the standard digits 0 to 9, but also use a to f (for decimal 10 to 15). Thus 00 to
09 hexadecimal is equivalent to 0 to 9 decimal. Oa to Of is equivalent to 10 to 15 decimal. 10 to 1f hexadecimal is
16 to 31 decimal, 20 to 2fis 32 to 47 decimal and so on.

+ 01234567889 abcde £ The printing characters are 20 to 7e hexadecimal, 32 to 126
20 PN # 8% s M () *+, - . / decimal, as in the table. Character 7f may or may not print,
30 0123456789 :; <=>7? depending on the character set. To find the hexadecimal code of a
40 ¢ABCDEFGHTJXKLMN O printing character, add the number above it to the number to the
50 PORSTUVWXYZ [ N1 " _ Jeft of it. For example, the code for A is 41. To convert a code to
Y abocdefghidjklmno  paacter, look up the first digit in the left column and the
70 pgrstuvwxyz {/][l ]}~

second in the top row. For example, 3f codes to 2, the
intersection of the row for 30 and the column for f.
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Sampling configuration

A Signal sampling configuration contains all the information and settings that Signal needs in order to create a new
data file by sampling. This information includes fairly obvious things like how fast to sample waveforms in the
1401 and what 1401 outputs to be generated during sampling, and also extra information such as how the sampled
data is to be displayed and what online processing to create measurement channels or derived data documents
should be carried out. Signal always holds a sampling configuration in memory, this is the current sampling
configuration. The current sampling configuration is used for all sampling, you can change the current sampling
configuration by using the File menu Load Configuration command. When Signal starts up, it normally loads the
last-used sampling configuration into memory so that the setup will be the same as when it was last used.

Before you start to sample data with Signal you must set Up | eem——G——_=-—:TwtC——TT—rTT
the sampling configuration. This is done through the Sample
menu Sampling Configuration dialog, which is also | 5=l | Poitsehun| Duputs | Automete |

available by using a toolbar button. - General - Markers
The sampling configuration dialog is a tabbed dialog - it Sueep mace !BaS'C_ = :: ETP.{JDIBM

. . . . I Multiple frame states ik
contains a number of tabs for selecting different sections of SR ~Dptions
the parameters. Click on a tab to display the corresponding W] e e _p e
page of the dialog. Some sections of the sampling Samplerate Mzl [10000 P! Syicrtine
configuration dialog are always present, while others are e e T Fising edge tigger
shown or hidden according to the circumstances. The Fisns poifls [0 ||| Suite ot sweep erd
sections that are always available are General, Port setup, aiOaa B Fil e

Outputs and Automate. The other sections, Peri-trigger,

States and Clamp hold extra information not relevant to all ADC potts {0.3 Reset |
sampling configurations. The Peri-trigger tab appears only
when the sampling mode selector in the General section is ok | cancel | Punnow | Hep |

set to Peri-trigger. Similarly, the States tab only appears
when the General section Multiple frame states item is
checked. The Clamp tab is only available if clamping experiments are enabled using the Clamp page of the
Preferences dialog.

The title of the dialog shows the filename and path of the configuration file from which the configuration data was
read. A ™' character is appended to the file name if the current sampling configuration contains unsaved changes.

Press OK to keep any changes you made to the sampling configuration or Cancel to discard changes. The Run
now button keeps any changes and then immediately starts off sampling.

Signal sampling configurations are saved on disk as files with a . sgcx filename extension using the File menu
Save configuration as command. Older version of Signal used a different sampling configuration file format
that used a . sgc filename extension. Signal can read and use these older sampling configuration files, but before
you can save them in the new format it is necessary to convert them to the new form by using them for sampling.
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General configuration

The General section holds a selector for the sweep mode,
the multiple frame states check box, fields to define the
waveform sampling rate and the frame width or points, check = %= | Port setup | Dutpute | Automte |

boxes to control the creation of marker channels and various - Gisneral ~ Markers

other options, plus a list of the ADC ports to sample to Sweepmode [Basic %) " Keyboard

generate waveform channels. [ Multipls fiame states [ Digal
=1 Yarablesmeen pairts — Optionz

V¥ Burst-mode sampling

Sweep mode Sample rate (Hz)  [10000 o s
The Sweep mode selector defines how sweeps of data are Frame lenath (] [ B e
taken and triggered and how sampling sweeps relate to the o s o000 i e
outputs system. The modes available are: 5 s (1 affsst [s] o [ Pause at sweep end
Basic the trigger for a sweep of data is a TTL ADCpats [0.3 T |

pulse at the start of the sweep, and

pulse outputs start and finish at the [ o0 | taed [ Bunwow || e |

Peri-trigger

Extended

Fixed interval

Fast triggers

Fast fixed interval

Gap free

Parameters - c:\'Work\Signald\winDebugh\LAST 5GC

T Usze ADC estemal convert

same time as the sampling sweep. We
have tried to keep this mode simple to
use to help beginners with the Signal software. It is useful for a wide variety of
straightforward sampling requirements.

the trigger point can be before the start of the sweep, at the start of the sweep or at any point
within the sweep. Pulse outputs start at the trigger point and finish at the end of the sampling
sweep. This mode allows a wide variety of triggers including threshold crossings on a
sampled waveform channel, and allows data to be collected before the sweep trigger, which
no other sweep mode can achieve. The trigger point and type of trigger are set in a separate
peri-trigger configuration page.

the pulse outputs are triggered rather than the sweep. The outputs can be longer than the
sampling sweep, occur both before the sweep starts and after the sweep is over and the
sampling sweep is triggered by the outputs; the sampling sweep trigger time is set along with
the outputs in the pulses dialog. This is a very powerful sweep mode while still being useful
for general-purpose use.

similar to Extended, but the sweeps are internally timed so that they occur at the specified
interval; a random variation in the interval can optionally be provided. Both the sweep
interval and any required random variation are set using the pulses dialog that is used to
define the outputs. External sweep triggers are not used in this mode, needless to say. The
fixed interval must be longer than the overall sweep length so that Signal has enough time to
get things ready for the next sweep. The amount of time required varies a lot with the
sampling and computer system, 100 to 200 milliseconds is usually sufficient.

like Basic mode except that marker logging, multiple frame states and variations in the pulse
outputs are not available, in addition the absolute start time for a sampled frame cannot be
measured and is set to zero. This keeps the inter-sweep interval to a minimum - less than 100
microseconds usually.

has the same limitations as Fast triggers but uses a fixed interval between sweeps rather than
requiring an external trigger; in this mode no random variation in the interval is available -
the interval is set using the pulses dialog. The fixed interval still has to be longer than the
overall sweep length, but only by a millisecond or two.

is like Fast triggers mode but only the first frame is actually triggered; subsequent frames
start immediately after the previous frame finishes with no loss of data, change in sampling
interval between points or any other variation in sample timing. It is used when you want to
sample continuously but are happy to break up the data into frames. If you want full-blown
continuous sampling then you should consider using the CED Spike2 software, Signal cannot
do this very well.

Useful extra information relevant to some of these modes can be found in Pulse outputs during sampling — the
pulses dialog is used to set the fixed interval sweep timing and other parameters.
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Multiple frame states

This check box enables sampling with multiple frame states. With multiple frame states disabled, all sampling
sweeps are the same, the same pulse outputs are generated and the new data frames are set to state zero. With
multiple frame states enabled, each sampling sweep can be different from other sweeps in a number of ways and
the data frame states are different to indicate what happened during sampling. This can be used to achieve a variety
of useful effects.

The use of multiple frame states is a complex topic which is covered separately in Sampling with multiple states.

Variable sweep points

This check box is only available with Extended and Fixed interval sweep modes with multiple frame states
enabled; it allows different sampled sweeps (with different states) to have different numbers of ADC data points.
The number of data points for each state is set in the pulses outputs dialog, the sweep points set in this page sets the
upper limit for sweep data points, this will also be the maximum display width for such a file. When you change
the frame length or points (using the controls below) with variable sweep points in use, the variable points values
are checked to make sure that they are legal, but note that when you change the data sampling rate the variable
points values are not adjusted to keep the individual sampling sweep durations unchanged - you will have to do
that yourself if you want the same sweep lengths.

When variable sweep points data is displayed, the allowed X range is set by the maximum number of sweep points
which is set here, so you may find yourself looking at frames of data that do not reach the limits of the X axis. But
apart from that they will behave normally.

Use ADC external convert

This check box selects the use of an externally generated pulse to trigger ADC conversion rather than the internal
1401 clock that is normally used. When this check box is set, the Sample rate and Frame length controls are
replaced by an X axis units field which sets the X axis (which would normally be time) in the generated data and a
Points per X unit field that sets the separation of the sampled ADC data points on the X axis.

The external ADC convert pulse should be connected to pin 6 of the Events socket on the back of the 1401, this is
the ADC Ext Conv input. The pins are numbered from right to left with pin 6 being the 6™ hole along on the top
row. Normally, the ADC Ext Conv input is sensitive to a falling edge - an ADC conversion is triggered when the
signal level changes from TTL high to TTL low - the polarity of this signal is inverted by the use of the Rising
edge trigger control, below.

Sample rate

The Sample rate field sets the sampling rate for all waveform channels, in Hz. The rate displayed will not always
be exactly the preferred rate that was entered; it shows the closest achievable rate given the 1401 clocks and the
number of ADC ports to be sampled. This occurs because the 1401 ADC converter clock can only generate sample
intervals that are an exact multiple of the clock input frequency. In all modern 1401 designs an input frequency of
10 MHz is available (in older 1401 designs the maximum input frequency is 4 MHz) so the ADC clock will
generate sample intervals that are a multiple of 100 nanoseconds. This limits the higher sampling rates available. In
very modern 1401 types (the Power3A and the Micro4) a 200 MHz internal frequency is available, giving sample
intervals that are a multiple of 5 nanoseconds and much closer adherence to your desired sampling frequency. It is
important to emphasize that, though you may not get exactly the sampling rate that you want, this will not cause
inaccuracies in your sampling - Signal knows exactly what sampling rate it is actually using and will ensure that the
timing of all ADC data is correctly derived from this actual sampling rate.

Getting the correct sample rate

As described above, the ADC clock interval has to be an exact multiple of 100 nanoseconds and this can make it
impossible to get the exact sampling rate that you want. For example suppose you want to sample at exactly 3 KHz.
To do this the ADC clock would have to generate an interval of 333 and 1/3 microseconds. This cannot be done as
1/3 of a microsecond is clearly not a multiple of 100 nanoseconds and so Signal will use the closest achievable
sampling rate (approximately 2994.012 Hz).

If you cannot get the correct rate, it is often possible to fix this, or at least a rate much closer to the one you want,
by enabling the Burst mode check box described below. This is because of the way burst mode sampling operates.
Consider a sampling configuration that samples 8 ADC ports at a rate of 20 KHz - this means a 50 microsecond
interval between samples on each ADC port. With burst mode disabled the ADC clock must generate a sample
interval of 6.25 (50/8) microseconds, clearly this cannot be achieved when all intervals have to be an exact
multiple of 100 nanoseconds. However with burst mode sampling is enabled the ADC clock has to generate a 50
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microsecond interval which is of course easily done. For this reason we recommend always using burst mode
sampling unless you need to exactly match the behaviour of previously-used sampling configurations.

Maximum sample rates
The overall sampling rate in the 1401 is the Sample rate times the number of ADC ports. With a Power1401 625,
the maximum overall sampling rate is 625 kHz. A Micro1401 mk I and Micro1401-3 will sample at up to 500kHz,
while a Power1401 mkII and Power1401-3 will go up to IMHz. With an original micro1401 the maximum overall
sampling rate is 333 kHz.

The sampling configuration dialog does not apply hardware-specific limits to the sample rates that you enter - you
can enter any sampling rate that you want. If you use a sampling configuration with an overall sampling rate
beyond that achievable with your hardware a 1401 sampling error will occur and be reported by Signal. If Signal
detects a Power1401 (or other more modern 1401 type) during program startup, it enables the use of higher timing
resolutions. You can force Signal to allow this higher timing resolution by checking the Assume Powerl1401
hardware box in the Sampling page of the Edit menu Preferences dialog.

Variable sweep points
If variable sweep points are in use, note that sampling rate changes are not compensated for by adjusting the
variable points values for each state and so the individual sampling sweep durations will change.

Frame length and points

The Frame length and Frame points fields set the length of the sampled frame. The frame length is always
shown in the appropriate time units. Changes made to one of these fields automatically cause an appropriate
change in the other. The Frame length field also updates whenever the sampling rate changes.

The maximum frame length possible varies with the model of 1401 and the amount of 1401 memory installed; each
sampled point requires two bytes of memory. For a standard micro1401 the limit is about 480,000 while for a
Power1401 the limit depends upon the amount of extra memory installed but is at least 15 million. For a
Micro1401 mk II or -3 the limit is either about 480,000 or 1 million depending on the amount of memory the unit
was built with. The sampling configuration dialog does not apply any limits to the frame length that you enter,
when sampling starts the 1401 memory required is checked against the memory that is available.

X axis zero offset

Normally the X axis zero appears at the start of the frame, or at the trigger time for peri-triggered sampling mode.
This position can be moved by entering a non-zero value in this field. This does not alter how and when sampling
takes place, only the way in which times are displayed on the x-axis.

ADC ports

This field sets a list of ADC ports to sample, up to 80 ports can be specified in the list. You can enter individual
ADC ports separated by commas or spaces or a range of ports such as 0..7 or both (for example “0,7,1..6").
Port numbers between 0 and 127 are accepted, the list of ports can be in any order that you want, unwanted ports
can be freely omitted and duplicated port numbers are allowed.

Each ADC port in the list creates a separate waveform channel in the resulting data document. The ports are
sampled in the order they are given in the list, so the first port in the list generates data channel number 1, the
second channel 2, and so forth.

Keyboard marker

The Keyboard marker check box enables the creation of the keyboard marker channel and logging of keyboard
markers. If the keyboard marker channel is enabled then it is the first channel in the data document after the
waveform channels. Keyboard markers cannot be logged when using fast sweep modes.

Digital marker

The Digital marker check box enables the creation of the digital marker channel and logging of digital markers
from the 1401 digital inputs, digital marker data items can also be created by Pulses or Sequencer outputs. If this
channel is enabled it is the first channel after the keyboard marker channel or the waveform channels if the
keyboard marker channel is not present. Digital markers cannot be logged when using fast sweep modes.

4-45



Signal Version 7.07

Burst mode

Check this box for burst mode sampling, leave it clear for equal interval sampling. In equal interval sampling the
waveform data points are sampled individually in turn and the interval between samples is 1/(Sample rate * number
of ADC ports) - this gave some slight advantages with very early 1401 designs. In burst mode sampling all of the
ADC ports are sampled in a burst as close together as possible and the interval between bursts is 1/Sample rate.
Burst mode sampling is generally preferable as it ensures that the interval between samples on adjacent ADC ports
is kept to a minimum and it very often allows the required ADC sampling rate to be achieved precisely, as
described above.

If the first two ADC ports sampled are ports 0 and 7 (or 0 and 3 for a micro1401, Micro1401 mk II or Micro-3),
then the second sample and hold circuit optionally fitted to 1401s is enabled. If fitted this option causes the
sampling on ports 0 and 7(3) to be exactly simultancous. With Peri-triggered sampling mode burst mode is always
used for efficiency reasons.

Sweep trigger
This check box sets the initial state of the Sweep trigger check box in the sampling control panel, this check box
enables and disables sweep triggers. With sweep triggers enabled, a sampling sweep will not occur until a trigger
has been detected, the sampling configuration determines what a trigger is. With sweep triggers disabled, a
sampling sweep starts immediately. For Extended sweep mode, the trigger starts the outputs rather than the
sampling sweep.

Except when using Peri-trigger sweep mode, the sweep trigger is a low-going (or high-going if a rising edge
trigger is selected below) TTL pulse supplied to the Trigger BNC input on the 1401 front panel. For Peri-
triggered sweep mode the trigger can be any of a number of signals.

Rising edge trigger

Sweep triggers normally occur on the falling edge of the supplied TTL pulse on the 1401 Trigger input, check this
box to make them occur on the rising edge. This also controls the polarity of the ADC convert input used if Use
ADC external convert mode is selected (see above) and the event 1 input that cab be used for a precisely timed
start to sampling. Both of these inputs are also normally sensitive to a falling TTL edge and to a rising edge if this
box is checked.

Write sweep to disk
This check box sets the initial state of the Write to disk at sweep end check box in the sampling control panel.
When this is set, sampled sweeps are automatically written to disk when the sweep finishes.

Pause at sweep end
This check box sets the initial state of the Pause at sweep end check box in the sampling control panel. When
this is set, Signal waits at the end of a sweep instead of immediately starting the next sampling sweep.

Reset
Pressing this button resets all of the sampling configuration parameters to the default state.
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Peri trigger configuration

The Peri-trigger section holds information that is specific to

C . . . . Parameters
the Peri-trigger sampling mode. It is only available when =
Peri-triggered sweeps are selected in the General section. General Peritigger | Portsetup | Outputs | Automate |
- General

At the top of the dialog is a selector for the type of trigger
and a field for the pre-trigger points. Below this is a section Tiggzttype [-Anaogue x| Pretiig time (s) [02
holding details of the trigger parameters. The contents of this
section changes with the type of trigger, the individual fields
will be described along with the various types of trigger. Thieshold level [0

Hupsteresis 12.5

~ Trigger values for ADC port 1

Trigger type

This can be set to one of +Analogue, -Analogue,
=Analogue, Digital or Event. The three analogue types
monitor the last ADC port in the sampled ADC ports list for
a trigger. The trigger levels are shown with the sampled data [ x|
as a pair of cursors which can be moved, without stopping
the sampling, to alter the levels. The Digital trigger waits for
a specified state on a bit in the 1401 digital inputs, while the Event trigger is a TTL pulse just as for the Basic
sample mode triggers. Each form of trigger has different parameters:

Cancel | Riun now | Help i

+Analogue Trigger on a positive-going level transition on the last ADC port in the sampled list. The parameters
are Threshold level and Hysteresis, both in units set by the channel calibration. The trigger
process first waits for the sampled data to go below (Threshold - Hysteresis) and then triggers
when the sampled data value rises above Threshold. The hysteresis acts to prevent false triggering
by noise as the sampled data passes downwards through the threshold level, triggering can only
occur after the sampled data has clearly been below the threshold. If you find that you are having
problems with false triggers due to noise, increase the Hysteresis value.

-Analogue Trigger on a negative-going level transition on the last ADC port in the sampled list. This is identical
to +Analogue, but in the opposite direction. The trigger process first waits for the sampled data to
go above (Threshold + Hysteresis) and then triggers when the sampled data value falls below
Threshold.

=Analogue Trigger on signal moving outside a pair of levels on the last ADC port in the sampled list. The
parameters are Upper threshold and Lower threshold. The trigger process first waits for the
sampled data to go between the thresholds. It then monitors the sampled data and triggers when the
sampled data value is above the upper level or below the lower level.

Digital Trigger on a digital input bit state. The parameters set the digital input bit, from 8 to 15 and select
triggering on a high bit or on a low bit. The trigger occurs when the bit is in the correct state. There
is no requirement for the bit to be in the other state first. The digital inputs are found on the 1401
digital inputs connector, the pins for the digital bits are:

Digital input bit ~ bit 15 bit 14 bit 13 bit 12 bit 11 bit 10 bit9 bit8 GND
Digital input pin 1 14 2 15 3 16 4 17 13

Event Trigger on a TTL pulse. There are no parameters; the trigger occurs when a TTL pulse is detected on
the Trigger BNC input on the 1401 front panel. The Rising edge trigger option in the general
sampling configuration operates normally.

Pre-trig. time

This parameter sets the amount of data in the frame that will be sampled before the point at which the trigger
occurred. This can have any value from -(1,000,000 * sample interval) to the length of the frame -(2 * sample
interval). If the value is negative, this means that points sampled after the trigger occurs are discarded before the
first point in the frame is kept. If the value is positive, then the specified time must have elapsed before the search
for a trigger begins and the resulting frame contains points sampled before the trigger occurred.

When a non-zero pre-trigger time is specified the resulting data x axis adjusts to start at -pre-trig. time. Thus a
negative value gives an x axis starting at some positive value because the first point in the frame was sampled some
time after the trigger. Similarly, a positive value gives an x axis starting at a negative value as some points sampled
before the trigger are shown.
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Ports configuration

The port setup section defines settings for the individual
ADC ports used to sample waveform channels. You can set
the scaling and units for data sampled from a port, the name || [General | Portsetp |clamp | outputs [ Automate |
of the data channel created by sampling and specify online
processing options for data from a port. This section defines
settings for each ADC port, note that the actual ports that
will be used for sampling are set in the General page of the
configuration dialog.

| CA\Users\Tim\AppData\LocalCED\Signalé\ast.sgex

Port  Zero Full {(5.0v)  Units MName
ADC 0

The main dialog displays the current settings for all ADC
ports (note that this can include ports that are not available
with the current 1401 hardware). Double-click on the entry
for a particular port to open the parameters dialog for that
port and change the parameters. The entries for each port [ 4ot Tderaphs |
(both in the main dialog and in the parameters dialog) are: -

0
1
2
3
4
5
6
7
3

0
0
0
a
0
0
0
a

Zero The wvalue (in the specified units)
corresponding to a zero volt reading from the
ADC. This value, along with Full, is used to
convert ADC data into the floating-point values used by Signal.

Full (5.0V) The value (in the specified units) corresponding to the full scale reading from the ADC. To scale the
data in volts, this will be 5 for a 5 volt 1401 and 10 for a 10 volt 1401. The 1401 ADC range in use is
shown alongside the title.

Units The units for calibrated data. This is a string from 1 to 6 characters long, you can set any units string
that you want.

Name The port name. This is a string from 1 to 19 characters long, it sets the title of the waveform data
channel sampled from this port.

Options This is a string of 0 to 8 characters that holds online processing options for data from the port.
Characters corresponding to various processing options can be entered into this dialog. Currently,
only one processing option is available; enter an ‘R’ character to cause online rectification of sampled
data. If the port scaling is being altered or controlled by an amplifier telegraph, this field shows Tel
(or ATel if an auxiliary telegraph) in red to indicate this fact. If the port is being used by the standard
1401 telegraphs to control the scaling of another port this field shows T>n in red, where n is the port
number that is controlled.

Amplifier telegraphs

The 1401 Telegraphs and Aux Telegraphs buttons on the bottom provide dialogs that allows you to configure
amplifier telegraph support. Amplifier telegraphs are signals, usually analogue outputs, from an amplifier that
indicate amplifier settings such as gain and offsets. By collecting and interpreting the telegraph signals, Signal can
automatically adjust for changes in the amplifier settings. Signal supports a standard telegraph mechanism using
analogue voltages sampled using the 1401 and it can also use a custom DLL to support alternative mechanisms.

The standard telegraph mechanism using a voltage signal is accessed and configured using the 1401 Telegraphs
button on the left. If support for an auxiliary telegraph system has been installed then central button will be enabled
and its label will change to indicate the type of auxiliary telegraph in use. For information on setting up and using
amplifier telegraphs, see Amplifier Telegraphs. Only a few types of amplifier provide telegraph signals; if you do
not have such an amplifier you can ignore these option.

Conditioner or quick calibration

The Conditioner... button on the bottom right opens the signal conditioner setup dialog if a signal conditioner
channel for the currently selected port has been found (see Programmable Signal Conditioners). If the name of the
signal conditioner hardware is known to Signal the label on this button will change.
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If no signal conditioner support has been selected, the Conditioner... button will T FSEERTEEES
change to Quick Calibration. The Quick calibration dialog offers an easy way to

ibrati : | Reguired signal units =
set up the calibration of the current port as a voltage based upon the amplifier gain e m"
and the desired units for data from that port. To set your calibration, select the | Totslampifier gain w0 |
desired units from the available choices of kV,Volt, mV, yV and nV, and enter [Cox ] | conce Help

the total amplifier gain applied to the signal between the preparation and the 1401
ADC input. If you have a headstage or other pre-amplifier don't forget to include that in your calculation of the
gain.

More on channel scaling and amplifier gains

The Zero, Full and Units fields are important; they define the way that 1401 ADC data is converted into the values
that you will see throughout Signal. Initially these values are set to give readings in volts at the 1401 ADC inputs,
you can keep them as they are but often it is more useful to change them to show values more closely connected to
the experiment.

For example, imagine you are using an amplifier with a gain of 100 to amplify the signal from an electrode before
the signal is fed to the ADC input. A gain of 100, for those that are unfamiliar with electronics, means that the
amplifier output voltage at any point will be the input voltage multiplied by 100. Now you could leave the
calibration of this signal alone and just log the voltage connected to the 1401 but it is usually much neater, and
harder to make mistakes, if you adjust the signal calibration to take the amplifier gain into account so that the
calibrated signal levels show the voltage at the electrode. To do this you have to set the Full value to show the
electrode voltage that would result in a full-scale reading (we will assume your 1401 uses a 5-volt range in this
discussion). As gain is a simple multiplier we can work out what electrode voltage gives a 5-volt amplifier output
by dividing 5.0 volts by the gain in use; 100. That gives us 0.05 so you would set the Full value to that.

That will work fine but numbers running from -0.05 to +0.05 are not particularly convenient; it would probably be
much nicer to work in millivolts. To do this you would set the units to "mV" and multiply the Full value by 1000.
That gives us an input range of -50 to +50 mV which is a lot easier to work with. The same arithmetic applies to
whatever gain your amplifier provides - just divide the actual 1401 full-scale value (5 or 10 volts, in volts,
millivolts or microvolts as you prefer) by the amplifier gain to get the Full value to enter. But in nearly all
circumstances, the Quick Calibration dialog described above will take care of this for you; this description is
provided to give you a more complete understanding of what is going on.

Only a few amplifiers have an offset control that allows removal of standing DC levels while still retaining DC
measurements (one of the few that do is the 1902 from CED). Unless you are using one of these you will never
need to do anything with the Zero value and can leave it set to zero (the 1902 control software will take care of the
Zero setting for you).

Going beyond altering the port settings to take account of amplifier gain, you can also use them to generate
correctly calibrated values from a transducer which measures a quantity other than voltage. The arithmetic required
is much the same; calculate the transducer input that will result in a full-scale value at the 1401 ADC input and set
that as the Full value (and don't forget to set the correct units). For example consider a pressure transducer that
generates 1 volt for each 50 mmHg applied. Then a 5 volt 1401 input will be generated by 250 mmHg pressure and
you should set the Full value to that and set the port units to "mmHg". If the transducer electronics includes a
selectable gain then you apply the gain in the same way as for voltage - by dividing the Full value by the gain. So if
your transducer gain was changed to 5 you should change the Full value to 50 (250/5).

Clamp configuration

This section of the sampling configuration dialog is only available when clamping support is enabled in the Clamp
page of the Preferences. It is described under Sampling with clamp support.

Outputs configuration

The outputs section of the sampling configuration is used to set the outputs required during sampling, which DACs
and digital outputs are available for use and to set the DAC units and scaling. The leftmost area is used to
configure the type of outputs. It contains a selector for the type of outputs required plus items specific to the
currently selected type of outputs. The right-hand areas enable and set up the output ports.
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Outputs type
This control selects the type of outputs to use from either None, Pulses or Sequence. The controls in the area
below the selector vary according to the selection.

Outputs type: None

This disables outputs during sampling. When selected, only a single control is shown:

Timer period (ms)

This item sets the period of the internal timer used to measure the absolute frame start time and to time digital
markers. A value of 1 to 10 ms is usually appropriate for these purposes. Values from 0.1 microseconds to 250 ms
can be entered and they are rounded to the nearest 0.1 microseconds.

Outputs type: Pulses

This selects pulse outputs during sampling. The pulses can be controlled by the script language or interactively
using a dialog. The details of configuring and using pulse outputs are covered separately under Pulse outputs
during sampling. When pulse outputs are in use, a number of controls to configure the pulses are shown:

Resolution (ms)

This sets the timing resolution of the output pulses in
milliseconds or microseconds and also sets the period of the
internal timer used to measure the absolute frame start time | general Portsetup Clamp OutUEs  States  Automate
and to time digital markers. Values are rounded to the nearest

Ch\Users\ Tim\AppData'Local\CED\Signal7\last.sg o™

Setup DAC enables, scalings and units

0.1 microseconds. The practical limit to the resolution Ful (5.0v) Zero  Units

depends upon the type of 1401 in use; for the micro1401 Twe PE Hols |0 v |

values down to 0.1 ms can be used, for the Micro1401 mk II Resolution {ms) [0.1 | F v ]

and Microl401-3 25 microseconds, while for Power1401s [[] Maximise wave rates '

you can go down as far as 6 to 10 microseconds. (] Absolute levels Oz2[s Jo v |
[ Absolute times e |5 ||U ||\.. |

.. Show DACE 410 7
Maximise wave rates

The design of the 1401 is such that it is possible to maximise et ipitts eieble

1} T
either the timing precision with which the pulses are Configure Pulses O0O0OO
generated or the highest possible arbitrary waveform output
rates, but not both. Normally you should leave this check box [ox ]| cone g e

clear but if you want high waveform rates and are getting
errors indicating the rate in use is too high, setting this check
box may help, at the cost of a very small increase in the timing jitter in the DAC outputs. We have also found that
setting this check box allows slightly higher rates of sampling with dynamic clamping before slow dynamic clamp
updates occur.

Absolute levels

This selects between absolute and relative pulse levels. With absolute pulse levels, the pulse amplitude sets the
level directly, with relative levels the pulse amplitude is added to the level before the pulse to get the actual pulse
level.

Absolute times

This selects between absolute and relative pulse times. With absolute times, the pulse dialog allows you to enter the
pulse start time directly; with relative times you use the delay since the start of the previous pulse. This control
only affects the way in which the pulse dialog handles pulse start times, not the other times shown in the dialog, the
underlying pulse data or the generation of pulses.

Configure pulses
Press this button to configure the output pulses using the pulse configuration dialog. Details of doing this are
covered in Pulse outputs while sampling.
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DAC enables, scaling and units

This section contains four sets of controls, one for each DAC (users of micro1401s and Micro1401 mk IIs should
ignore DACs 2 and 3). These control if a DAC is available for use and set the scaling and units with which DAC
values are defined.

Enable These check boxes enable the DACs for use. Set a check box to use a DAC, leave it clear otherwise.
The fewer DACs are enabled for output the more space is available for the display of each DAC in the
pulse dialog.

Zero The value (in calibrated units) corresponding to a zero value output from the DAC. This value, along
with Full, is used to convert the floating-point values used by Signal into the integer quantities actually
used by the DAC hardware. This conversion process occurs when generating pulse outputs, when
waveform data is pasted into an arbitrary waveform pulse and when compiling pulse sequences.

Full The value corresponding to the full scale output from the DAC. For DACs calibrated in volts set this to
5 for a 5 volt 1401 and to 10 for a 10 volt 1401. If your 1401 has a patch clamp scaling card fitted, this
scales DAC 1 in a Power1401 or Microl401. To calibrate the DAC in volts, set Full to 2.048 or 10.24
depending on the scaling card setting.

Units The units with which the DAC output scaling is specified. This is a string from 1 to 6 characters long.

On the Powerl401 DACs 2 and 3 are available on pins 36 and 37 respectively of the rear-panel analogue
connector. If a Signal top-box is fitted, DACs 2 to 5 will be available on the top box front panel, with DACs 6 and
7 available on pins 36 and 37 respectively of the rear-panel analogue connector. If a Spike2 top-box is fitted then
DACs 2 and 3 will be available on the top box front panel, with DAC’s 4 and 5 available on pins 36 and 37
respectively of the rear-panel analogue connector.

Digital outputs enable

This section contains a set of check boxes to enable and disable the individual digital outputs for use. Set the check
box to use this digital output port, leave it clear otherwise. The fewer digital outputs are enabled for output, the
more space is available for the display of each output in the pulse configuration dialog. See Pulse outputs during
sampling for details of the digital outputs.

Outputs type: Sequence

This type of operation generates pulses and other outputs
using a list of sequencer instructions that are executed inside

ChlUsers\ Tim\AppData'Local\CED\Signal7\last.sgcx®

the 1401 at a specified rate. Each instruction carries out @ | general Portsetyp Clamp OUMUL States Automate
s1mple function such as setting a DA(; to a given value, i < DN
waiting for a specified time or looping. The sequencer s Jsoomo lo. |
instructions are generated using a output sequence file; a form Tre. ERSUICIE | | TR
) . . L ) ———  DACunits pA |

of text document that is edited and viewed within Signal Step period (ms) | 1 "

. . .. . ETEE W v
using a Sequence view. Though writing a sequence is a more [IMaximise wave rates R
complicated task than generating outputs using the pulses [Free un without restarts  Waveformpoints | 2000
dialog, the sequencer allows for more complicated behaviour Jumps controlled by 0“'43““3‘33 ) 1oag ?l
and can be very useful for the more demanding operations. Keysandcontrolpanel | o GEACOOOOO0
The sequencer includes 256 variables that can hold values |  s.qence fie e
anq a table .of (.1ata. that can be quickly read and updated by [ Sigralsid._hhab.os |
scripts running in Signal.
The details of the sequencer language and instructions are [Cox ]| cance Run now Help

covered separately under Sequencer outputs during sampling.
When Sequencer outputs are selected, a number of sequencer controls are shown:

Step period ms

This item sets the clock interval for sequencer instruction execution and thus the rate at which sequencer
instructions are executed. It functions identically to the Pulses outputs Resolution (ms) control, it has the same
hard limits of 0.1 microseconds to 250 milliseconds, the same rounding to the nearest 0.1 microseconds, and the
recommended limits for the various types of 1401 are the same; for the micro1401 values down to 0.1 ms can be
used, for the Micro1401 mk II and Micro1401-3 25 microseconds, while for Power1401s you can go down as far
as 6 to 10 microseconds. Note however that some instructions will have a speed penalty that will start to limit how
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fast you can run the sequencer on modern 1401’s. DIV and RECIP in particular may take twice as long to execute
as most other instructions.

Maximise wave rates

The design of the 1401 is such that it is possible to maximise either the timing precision with which the sequencer
executes or the highest possible arbitrary waveform output rates, but not both. Normally you should leave this
check box clear but if you want high waveform rates and are getting errors indicating the rate in use is too high,
setting this check box may help, at the cost of a very small increase in the timing jitter in the DAC outputs. We
have also found that setting this check box allows slightly higher rates of sampling with dynamic clamping before
slow dynamic clamp updates occur.

Free run without restarts

If this item is left clear, sequencer execution will be restarted at the first instruction at the start of each sampling
sweep (specifically, at the time that the data point at time zero is sampled). This allows you to easily produce
sequencer outputs at a particular time in the sampled data, but the sequencer is halted between sampling sweeps. If
this item is checked, the sequencer starts running at the time that sampling starts, before the first sampling sweep is
started, and continues to run until sampling is stopped.

Jumps controlled by

Sometimes you may want to stop users activating sequence sections with the keyboard or from the sequencer
control panel, for example when an inadvertent change in a DAC output controlling a force feedback device might
hurt the subject. This item allows you to do this; you can choose between Keys and control panel, Control panel
and Script only. The script language equivalent is SampleSeqCtrl () The script language SampleKey ()
command can always activate sequencer sections.

Sequence file
This control defines the file holding the instruction sequence to be used. You can either enter a file name directly
or you can use the Browse button to select the sequence file directly.

DAC scaling and waveforms

This section contains fields that define how DAC outputs are calibrated for use with sequencer outputs and how
waveforms used by the sequencer are calibrated. It also sets the arbitrary waveform output rate, number of
waveform areas, the length of each area and the DACs used. Both the sequencer itself and the arbitrary waveform
output system assume that all the DACs have the same scale factors and units setting. See SampleSeqWave () for
the script language equivalent.

Full and zero These fields define the full scale output level of the DACs in the units that you wish to use
corresponding to a full-scale output from the DAC and similarly the value corresponding to a
zero-volt output from the DAC. They are used to convert from the user units entered into the
sequence into actual DAC values and are also used by the dynamic clamping system to
calibrate DAC outputs when dynamic clamping is used with sequencer outputs.

DAC units This defines the DAC units that you wish to use. This value is provided mainly for your
convenience (it is not used within the sequencer outputs system itself) but it is used by the
dynamic clamping system to check and calibrate DAC outputs when dynamic clamping is used
with sequencer outputs.

Waveform areas This sets the number of arbitrary waveform output areas, you can set any number from 1 to
256.

Waveform points This defines the length of each arbitrary waveform storage area, in points. Values from 0 to 4
million can be entered.

Output rate (Hz) This defines the rate at which the arbitrary waveform is played out through the DACs. In
conjunction with Waveform points, this sets the maximum duration of waveform replay.
Values from 1 to 10 MHz can be entered. The maximum achievable rate depends on the type
of 1401 and the number of DACs used.

DACs These check boxes set which DACs will be used for waveform output. If one DAC is selected,
the waveform data consists of a simple list of values; for more than one DAC the data for the
DAG: is interleaved starting with the lowest-numbered DAC.
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Pulses or sequencer?

You can define the outputs that Signal will generate during sampling in two different ways; by defining pulses
using a graphical editor and by generating a sequence, a text file listing the operations that will be carried out in the
form of a simple program. Pulses output is easier to get started with and supports multiple states directly, this form
of outputs will be suitable for most users of Signal. You should consider using the sequencer only if you are unable
to achieve the effect you require with Pulses output. The table below summarises the main differences between

these two forms of output.
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Pulses Sequence
Edited with Built-in graphical editor Built-in text editor
Visualise output Yes No

Stored as

Part of the sampling configuration

Output sequence . PLS files

Implemented by

Drag and drop editing

Machine code like language

Ease of use

Very easy to learn and use

Takes time to learn

Flexibility

Uses pre-set building blocks

All features available

User interaction

Pulse editor while sampling

Buttons trigger jumps

Script interaction

Add, delete and modify pulses

Variables and table data

Arbitrary waveform |Data in sampling configuration Data loaded by script
Sweeps Locked to sampling sweeps Can be sweep independent
Timing Several instructions per item One instruction per text line

Though the way in which the required outputs are defined in Pulses and Sequencer outputs are very different, the
actual generation of outputs is carried out identically. When you use Pulses outputs, the pulses information is used
to build sequencer data that is loaded into the 1401 and executed in exactly the same manner as Sequencer outputs.
The timing requirements and limits for these two forms of output are therefore identical.

The following table summarises the use of the various output methods in the different sweep modes. More details
can be found under Pulse outputs during sampling and Sequencer outputs during sampling.

Pulses

Sequence (triggered)

Free-run sequence

or free-running, can be
longer than the sampling
sweep, outputs trigger the
sampling sweep at a defined
point.

starts) and triggers the
sampling sweep at the required
point.

Basic Sampling sweep and outputs |Sweep and sequencer triggered | Sequencer starts immediately
start together and are of (or just start) together so that |and runs throughout. Can
same length. sequence is repeatedly trigger sweeps or react to

restarted. sweep progress.

Peri-trigger Pulse outputs triggered when [Sequencer triggered when Sequencer starts immediately,
sweep trigger is recognised, |sweep trigger is recognised, so |runs throughout. Can trigger
same length as remaining sequence restarts at time of sweeps via outputs or react to
sweep. trigger. sweep progress.

Extended Pulse outputs are triggered  [Sequencer triggered (or just Sequencer starts immediately

and triggers sweeps as
required. No external trigger
available.

Fixed interval

Outputs (which are triggered
by an internal timer) starts
the sweep at a specified time.

Not available, simulate with
Extended mode with a free
running sequence.

Not available, simulate with
Extended mode with free
running sequence.

length as sampling sweep.
First sweep only can be
triggered.

of each sweep so that sequence
repeatedly restarts.

Fast triggers Single set of outputs of same |Sweep and sequencer triggered | Sequencer starts immediately,
length as sampling sweep. together (or just started) so runs throughout. Can trigger
Sweep and outputs triggered |that sequence repeatedly sweeps itself or react to
(or just start) together. restarts. (triggered or free-running)

sweep progress.

Fast fixed|Single set of outputs, same |Not available, simulate using [Not available, simulate using

interval length as sampling sweep. Fast triggers mode with free  [Fast triggers mode with free
Sweep and outputs triggered |running sequence. running sequence.
together by internal timer.

Gap-free Single set of outputs, same |Sequencer re-triggered at start |Sequencer starts immediately,

runs throughout. Can react to
sweep progress, first sweep can
be triggered.
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Automation configuration

This section of the sampling configuration dialog controls the
Signal automation features. There are two areas of the dialog:
Filing, which controls automatic file name generation and | genersl Portsetp Clamp Outputs Automate
automatic filing, and Sampling limits, which can be used to

ChUsers\ Tim\AppData Local\CED\Signalflast.sgodc™

Filing
restrict the amount of data sampled or filed. There is also a path | | [Browse ...
button used to access the artefact rejection dialog. File name template aedomeey_000 o

Save file to disk on sampling finish
Path Sampling limits

Mumber of frames 20

This sets the directory where the automatic file naming will
look to produce a unique file name and where new files are
saved when sampling has finished. This is distinct from the File size (KByte)
directory for new files that is set in the Sampling page of the
Preferences dialog, that sets the location for the temporary
files used while sampling. If this field is blank, automatic file
name generation and file saving use the current directory [ ]
which is generally not a good idea as this directory can
change. You can enter a directory path directly, or use the
Browse button to select a directory.

Sampling duration {s)

oo

Al

Optimise ¥ axes for all channels at sweep end

Output Resets ... Artefactreject ...

Cancel Run now Help

File name template

This sets a filename template for automatic file name generation (which should not be more than 22 characters
long), if left blank automatic file name generation is disabled and normal document names (Datal, Data2, ...) are
used for sampled data. If a template is provided, it generates a sequence of unique file names based on a numeric
code. If the template ends with one or more digits, these set the length and initial value of the numeric code. If the
template does not end with digits, Signal adds "000" before using it. Signal increments the code until it finds an
unused name in the directory set by the Path field. Thus, a template of “cestdat” generates “testdat000” to
“testdat999”, while “testdat10” generates “testdat10” to “testdat99”.

You can insert fields holding the time and date that the data was sampled by using % followed by a character
code. The button marked >> to the right of the template text can be used to insert these codes, which is easier than
remembering them. The codes are:

5T Time as numbers (hhmmss) 5D Date as numbers (ddmmyy)

5H Hour in 24 hour format (00-23) %4 Day of month (01-31)

M Minute as number (00-59) sm  Month as number (01-12)

55 Seconds as number (00-59) 5y Year without century (00-99)
Y

Year with century, e.g. 2007

If you use one of these codes right at the end of the template, Signal will add a ¢’ after the date information so that
the automatic filename generation does not change the date or time information. If a file name template is set, the
generated name is used automatically when the data file is saved without the user being prompted to confirm the
name. A different name can be specified using the File Save As command.

Save file to disk

If this check box is set, the new data file will automatically be saved to disk when sampling finishes. If automatic
filename generation is in use, the generated filename is used, otherwise the usual prompts for a file name from the
user are generated. Therefore, if you set the path, a filename template and this check box your data files will be
automatically saved without your having to enter a file name at the end of sampling.

Sampling limits

This part of the dialog controls three limits that will cause sampling to stop automatically. These are Number of
Frames, Sampling duration and File size. Each option has a check box to enable the limit plus a field for entry
of the limit value. If the check box for a particular limit is clear, or if the corresponding limit value is set to zero,
then that limit is disabled. Note that all of these limits cause sampling to stop, not finish, sampling can still be
continued after a limit is reached.
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In addition to these user-defined limits, Signal has a built-in sampling limit based on the available free disk space.
If the available free disk space drops below 0.5 Mbytes, sampling stops automatically. This limit cannot be
disabled as it is important not to allow hard disks to get completely full, both because this can slow down file
accesses considerably and also because of the trouble a full disk gives to an operating system such as Windows that
uses spare disk space for virtual memory management. The user-defined limits are:

Number of frames If this limit is enabled, sampling stops when the set number of frames have been written to
the data file.

Sampling duration If this limit is enabled, sampling stops when the set time has passed since sampling was
started.

File size (Kbyte) If this limit is enabled, sampling stops automatically when the file size reaches or exceeds
the set size.

If you press the 'More' button in the sampling configuration dialog after sampling has stopped after reaching a
preset limit, sampling will allow another limits-worth of sampling to occur before stopping again. So if the frame
limit was set to 25, pressing More would cause sampling to continue until the data file had 50 frames. Pressing
More again would give 75 frames and so on.

Automatic Y axis optimisation

Setting the Optimise Y axes for all channels at sweep end check box will cause the Y axes of all channels to
be optimised at the end of each sampling sweep. Optimisation causes the Y axes to be adjusted so that they cover
the sampled data range in each channel, this gives you a better view of your data but may make it harder to see the
differences between frames.

OutputResets...

Press this button to open the dialog for the configuration output reset settings. These allow you to define DAC and
digital outputs that will be set before and after any sampling, for example to ensure that a stimulator is reliably
turned off.

Artefact reject...

The Artefact reject ... button opens a dialog that allows you to configure artefact rejection. This provides
mechanisms for automatically rejecting or tagging sampled frames if they contain an artefact, normally caused by
stimulation.

Output Resets
In most cases, when sampling is not in progress the = —
signal levels on 1401 outputs are of no interest to [ “Put Aessts -_

the researcher, but if an output is driving
equipment that needs to be held in an inert state
(for example a skin stimulator) it can be very |,
important (if only for the peace of mind of the || [¥Ioacz() [Cloacs )
experimental subject) to ensure that the 1401 ||| [Clpacaqw o [Cloac7(y ©
outputs are in the 'off state before sampling starts
and are reliably restored to this state when
sampling finishes. This can be a particularly
difficult problem if sampling stops during the
middle of a sweep as the 1401 outputs will be left f [ hep |
in whatever state they were at the point where ||
sampling stopped. To avoid such problems, Signal -
provides mechanisms to define and apply forced output resets. There are two sets of forced output settings;
application-wide settings which are controlled by a dialog generated by the Sampling page in the preferences and
these settings in the sampling configuration dialog which are held as part of the sampling configuration
information. The two sets of information are very similar; any reset level defined for an output in the sampling
configuration settings overrides the corresponding application-wide settings for the same output. Note that if you
do not have outputs that need to be controlled in this manner you do not need to make use of these settings.

[Tpaco [Tpac 400 DIG Outbits 00000k
[V]pac 1(v) [Clpac s DIG Low bits a1l

Ramp DACs to desired voltage over | 0 seconds {if possible)

[ Apply when sampling configuration is loaded
[¥] Apply when sampling starts [¥] apply when sampling finishes
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DAC outputs
All reset output DAC values are defined in volts, each DAC has a check box which enables the use of the forced
output value.

Digital outputs

There are separate fields for the main digital outputs used by the pulse outputs and the DIGOUT sequencer
instruction and for the lower digital outputs used by the DIGLOW sequencer instructions. Each field is eight
characters long with the first character controlling the highest output bit and the last character controlling the
lowest bit. An 'x' character leaves the corresponding output bit unchanged, a '0' clears the output bit (sets it to TTL
low) while a '1" sets it (TTL high). So, to set the digital output 0 BNC on the front of a modern 1401 high and the
digital output bit 1 BNC low, you would enter "xxxxxx01" into the DIG Out bits field.

Ramp DACs to desired voltage over ...

It may be necessary to avoid simply setting DAC outputs to the required voltage and instead ramp the output level
to the correct level over a period of time. This option is not currently available but if required by significant
numbers of users will be implemented in a future release.

Apply when sampling configuration is loaded
If this check box is set then the sampling configuration output reset settings will be applied immediately when the
sampling configuration is loaded into Signal by any means.

Apply before sampling starts
If this check box is set then the sampling configuration output reset settings will be applied when sampling is about
to begin.

Apply after sampling ends

If this check box is set then the sampling configuration output reset settings will be applied when sampling has
finished.

Artefact rejection

The artefact rejection dialog can be used to configure Signal to —

automatically examine newly sampled data and, if the data has reached

the ADC limits, to reject or tag the new frame. Artefact rejection is = Artefact rejection mode [Nane -
important when generating averaged evoked responses, particularly  uiopact jsvel i of ADC rangs] ET——
from the EEG, where artefacts often occur and where the mathematical ,

R . . Start time offzet for zearch (=] ID
rigor of the averaging process will be affected by the presence of _

signals at the ADC limits. End time offzet far search (3] |D.2

. . . Bllowed bad points [percent] I2

The Artefact rejection mode item controls what form of artefact
rejection to apply. It can be set to None for no artefact rejection, Tag 0K i Cancel I

frames to label frames with artefacts, or Reject frames, to discard
frames with artefacts by not writing them to disk. The Artefact level is the percentage of the ADC range outside
which data values will be regarded as an artefact.

The next two items set the time range for the search for artefacts; note these are specified as offsets from the start
of the data rather than as absolute frame times. The final item, Allowed bad points (percent), sets the limit before
the frame is rejected or tagged, allowing you to avoid rejecting frames with a trivial amount of bad data.

If artefact rejection is enabled, each frame of data sampled is scanned for artefacts. All sampled waveform
channels are scanned over the time range specified and the points that exceed the Artefact level are counted. If the
percentage of bad points found during the scan exceeds the limit of Allowed bad points then the frame is rejected
or tagged as appropriate.

Creating a new document

Once you have set up the sampling configuration you can create a new sampling data document. You can do this
by clicking on the Run Now button in the sampling configuration dialog or the Run Now button on the Toolbar,
or by selecting New from the File menu, then Data Document for the file type.
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The exact appearance of the new document view varies, depending on the configuration. The name for the new
document will either be Datal, Data2, and so on or a name automatically produced from the file name template
in the sampling configuration. You can customise the view by adjusting the x axis, y axes, channels and other
aspects of the view.

Frame zero

A sampling document is different from all other types of data documents because it starts at frame zero, while the
others start at frame 1. Frame zero is a special frame that holds the transitory data making up the sweep currently
being sampled; frames 1 onward hold data that has been made permanent by being written to the disk file.
Sampling is a cyclical process of collecting a new sweep of data into frame 0, deciding if it is to be written to disk
and writing it if necessary, clearing frame 0 and starting the next sweep off. This process continues until enough
frames have been written to disk or until sampling is stopped.

Data is shown in frame zero for as long as it is the most recent data. Frame zero is cleared when pulse outputs for
the next frame start or when sampling of the next frame begins. For Basic and Peri-trigger sweeps, this means that
data is displayed right up until data from the next sweep starts to be drawn. For Extended or Fixed interval sweep
modes, the frame zero data will be cleared when the pulse output for the next frame starts and the new data starts to
be drawn when the sampling is triggered. There may be a period when no data is shown, which provides the user
with a clear indication that the next sweep has started. This is valuable because once the pulse output or sampling
has started, the Accept/Reject button in the control panel cannot be used on the previous sweep of data.

For fast sweep modes (Fast triggers, Fast fixed interval or Gap-free) the most recently sampled sweep is
displayed, starting when the first data points for the frame are sampled.

The sampling is controlled using a small floating or docked window; the Sampling

control panel. This contains buttons and other controls to interact with the % s 5
sampling. Sampling will not start until you click Start in this control panel (the oA o

Sample menu duplicates the panel controls). If the Event 1 start box is checked, [~ Event{ start
sampling waits for an external signal after the start button is pressed. Beiect | Abot | Bestai |

- Sweep end
W ‘uite to disk at sweep end

[T Pause atsweep end

Online analysis

You can create memory channels and result and XY views to hold the result of analysis carried out during data
acquisition in exactly the same way as when working offline; using the Analysis menu Measurements to data
channel, New Memory View and New XY View commands. The dialogs through which you specify what analysis
is to be performed are exactly the same as when offline, however the Process dialog that specifies what data is to
be processed is different from it’s offline equivalent.

This dialog controls which frames to include in the processing and how to update the memory view holding the
analysis result (see under Analysis menu for a full description of this dialog). The most common mode is All filed
frames, with an update every 0 frames (every frame). This dialog closes when you select either OK or Cancel.
You can recall it with the Process command in the Analysis menu or by right-clicking in the result view.

Other variations on the standard Process dialog are provided when carrying out online processing to an XY view,
particularly when the data source is a memory view which is itself being generated by online processing.

4-58



Sampling data

Sampling control panel

The gampling cpntrol panel hplds several buttons and check boxes qsed tq contrql " Sampling - SFSMJT004 I 3
and interact with data sampling. When the control panel is a floating window it ,
looks like the picture to the right, or it can be docked to any edge of the Signal IZR e bl
application window (most often the top). Click Start to begin sampling, or Abort to | [T Ewent{ start

give up immediately. Once sampling has started the buttons change but most check Eeat | b | DE=

boxes are always present and can be changed at any time during sampling. —Sweep end
W Wiite to disk at sweep end

[~ Pause at sweep end

The Event 1 start check box allows you to trigger the entire sampling process
externally. If this check box is set, clicking on Start will not start sampling directly,
it enables the initial start of sampling on an event 1 pulse. This allows precise
control of the time of the start of sampling; the time from which the frame absolute start times are measured. While
Signal is waiting for an event 1 start pulse, the Start button will flash ‘Waiting for E1’. The E1 input is on pin 2 of
the 1401 rear panel Events connector, with a suitable ground on pin 9. Connect the E1 input to ground (or pull it
below 0.6 V from above 3V) to start sampling. The polarity of this input can be inverted using the Rising edge
trigger option in the General page of the sampling configuration dialog, when inverted you should disconnect the
E1 input from ground (or raise it above 3 V from below 0.6V) to start sampling.

The Sweep trigger check box is initially set from the Sweep trigger item in the sampling configuration. It
enables or disables triggered sweeps, while Signal is waiting for a sweep trigger the check box text will show
‘Waiting (TR)'.

The check boxes in the Sweep end section of the dialog control what happens at the end of a sweep of sampling
and how data is written to disk. If the Write to disk at sweep end check box is set, then each frame zero is
written to the disk file when the sweep finishes. If the check box is clear, then the frame is not written - the check
box text is drawn in red in this case to remind you that data may be lost. You can override this behaviour for
individual sweeps using the Accept/Reject button in the sampling control panel.

The Pause at sweep end check box controls whether a new sweep is started automatically once the previous
sweep has ended. If the check box is set then sampling will pause until the Continue button is pressed, or until the
check box is cleared again, allowing the user to pause for a while or to inspect the data and accept or reject each
frame. If the check box is clear then the next sweep starts immediately.

Sweep end check box combinations

Write to disk [ Pause at Effect
No No Continuous (free-running or triggered) sweeps for signal monitoring
Yes No Continuous (free-running or triggered) sweeps written to disk
No Yes Interactive sweeps (optionally triggered) written to disk if accepted
Yes Yes Interactive sweeps (optionally triggered) written to disk unless rejected

The sampling control panel can be hidden or shown using the Sampling menu, the Signal toolbar or the pop-up
menu provided by right-clicking the mouse on unused parts of the Signal window. It can also be hidden by clicking
on the X button at the top right of the control panel, or docked at any edge of the Signal window.

During sampling

Once sampling has started, the sampling control panel changes to show buttons suitable for the sampling process. If
Event 1 start was checked before you click Start, the word Waiting flashes until a suitable signal is applied to the
E1 input to enable sampling. This is distinct from the Sweep trigger. Use this method to synchronise the start of
sampling with an external event. Sampling starts within 1 or 2 ps of the external event signal. The buttons available
are:

Start This is only shown before data capture starts and after sampling has been restarted. When you click
on the button, sampling of data begins. If the Sweep trigger box is checked, the 1401 system waits
for the sweep trigger before starting to collect data.

Continue  This button is labelled Start before data capture starts. Its name is changed and it is enabled when
sampling is paused at the end of a sweep. When you click on the button, sampling of the next sweep
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is enabled. If the Sweep trigger box is checked, the 1401 system waits for the sweep trigger before
starting to collect data.

More This is labelled Start before data capture starts. Its name is changed and it is enabled when sampling
has been stopped or when one of the Automate limits has been reached. Pressing it will cause
sampling to resume, if it had stopped because an Automate limit was reached the limit is adjusted
upwards. So if sampling had automatically stopped because 100 frames had been collected, pressing
More will cause a further 100 frames to be collected before sampling again stops automatically/

Stop This button is displayed after data capture starts. If you click on this button, the data capture stops, in
the same manner as if one of the Automate limits was reached. Once the data capture has been
stopped it is possible to resume sampling again using the More button.

Finish This button is displayed when data capture has stopped but could be resumed by pressing More. If
you click on this button, data capture stops completely and it is not possible to resume sampling
again.

Accept Clicking on this button writes unwritten frame 0 data to disk. If frame zero is still being collected, it

overrides the Write to disk at sweep end check box so that the sweep is written to disk at sweep
end; it does not affect subsequent sweeps. If the frame has been collected and sampling is paused, this
writes the frame to disk immediately. The button acts upon a sweep up until the point that the next
sweep is triggered or pulse outputs for the next sweep begins.

Reject If Write to disk at sweep end is checked, or sampling is paused at the end of the sweep and frame 0
has already been written, then the label on the Accept button changes to Reject. Clicking on Reject
either overrides the Write to disk at sweep end check box to cause the currently sampling frame
not to be written automatically, or removes the current frame 0 data from the end of the data file, as
appropriate. This button acts on a sweep up until the point when the next sweep is triggered or pulse
outputs for the next sweep starts.

Abort This button abandons sampling and discards the file. You can use this button before sampling starts
or while sampling. You are warned if this will lose saved data.

Restart This button is available once sampling starts. It stops sampling, discards any data that has been
written to disk, then waits for you to start sampling again with the same document by pressing Start.
You are warned if this will lose saved data.

Other interaction with sampling

If a keyboard marker channel is being sampled, you can insert markers into the sampled data by pressing keys on
the keyboard. You can do this if the new data view is the current view, or if the sampling control panel is current.
The current view or window has a highlighted title bar, you can make a view current by clicking on it. If the
sampling control panel is current, you should be careful about pressing the space bar, which is equivalent to
pressing whichever button is currently highlighted, or pressing Enter, which is equivalent to pressing the
Start/Continue button.

If you are using Peri-triggered sampling in any of the analogue trigger modes, frame zero of the sampling
document displays a pair of horizontal cursors that indicate the positions of the two trigger thresholds. These
cursors are displayed on the highest-numbered waveform channel (which is the last port in the ADC ports field),
as this is the trigger channel. For +Analogue and Analogue trigger modes, the cursors show the trigger level and
the trigger level minus (or plus) the hysteresis, this latter level is shown as the Arm level. For =Analogue trigger
mode the two separate trigger levels are shown. During sampling you can adjust the trigger levels used by moving
the cursors; they cannot be moved to a different channel as the trigger channel is fixed.

If you use the keyboard command Ctr1+PgUp, Signal will switch to displaying the last frame that was saved to
disk.

If you are using a programmable signal conditioner such as the CED 1902 programmable amplifier then you can
use the signal conditioner control panel to adjust the amplifier settings — see Programmable Signal Conditioners
for more details of these. Note that, if you alter the amplifier gain or offset settings, the channel calibration will be
adjusted in such a way to keep the incoming data correctly calibrated — cancelling out the gain and offset changes —
so you will not normally see any change in the displayed data. The Edit menu Preferences dialog has a setting (in
the Sampling page) to allow the display range shown to be adjusted, if required, to reflect changes in the ADC
range caused by signal conditioner changes.
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You can tag data frames as they are sampled by pressing Ctr1+T, or frames can be automatically tagged by the
artefact detection system.

Most standard display manipulation mechanisms work in exactly the same manner online, but frame overdraw
mode works differently on frame zero; it never erases old data but just redraws it in grey and the frame display list
is ignored. This provides a very nice ‘storage oscilloscope’ style display, but if any part of the view is redrawn the
previous traces are lost. You can use the Edit menu Clear command to erase all the previous traces.

Stopping sampling

Sampling can be stopped by clicking on the Stop button or by the sampling limits being reached. If a (non fast
mode) sweep is in progress when Stop is pressed then sampling will continue until the end of the sweep is reached.
When sampling has stopped Signal is in between sampling and finishing sampling. The sampling control panel is
still present, but the button labels will change:

More This is the button previously labeled as Start or Continue. Click it to resume sampling as if the Stop
button had not been pressed. If sampling stopped due to the frame count reaching a limit then
pressing More resets the frame count and sampling runs until the count again reaches the limit,
otherwise the limit is disabled and sampling continues indefinitely.

Finish This is the button previously labeled as Stop. If you click on this button, the data capture is
terminated and the sampling control panel disappears.

Click on the Finish button to end sampling. If the sampling configuration has automatic saving to disk enabled, the
new data file will be saved at this point, using either the automatically generated filename from a template or a
name entered by the user as appropriate. You will also be prompted for a comment for the new file, if this feature is
enabled. Once the sampling has actually shut-down, the sampling control panel is removed. In the new data view,
frame zero of the data document disappears and the view changes to show the last filed frame if it was previously
showing frame zero. If there are no saved frames, the data document and view are destroyed, giving the same effect
as pressing Abort.

Saving new data

A sampling document that has stopped sampling is essentially the same as a document loaded from disk. However,
unless you are using automatic saving to disk, the data has not yet been saved in a permanent disk file, though it is
stored on disk as a file without the .CFS file extension. To keep the data, you must save the new data using the
File menu Save command. If you try to close the document view without saving the data Signal will check that
you really want to do this. If you do not save the new document the data file will be deleted but, to try to protect
you against accidentally losing important data, it will be moved into the recycle bin.

Data documents are always stored on disk while other document types are kept in memory until you save them. We
keep data documents on disk because they can be very large. When you use the File menu New command, Signal
creates a temporary file in the directory specified in the Sampling page of the Edit menu Preferences dialog. If you
do not specify a directory, the location of the temporary file is system dependent. When you save a new data
document after sampling, Signal moves it to the directory you specify.

Saving configurations

To avoid setting the sampling, analysis and screen configuration each time you sample, you can save and load
sampling configurations from the File menu. The configuration includes:

e The basic sampling parameters in full, including port information for all ports.

e The position of all windows associated with the new file (including duplicated windows and the various control
panels) plus all windows generated by processing.

e The displayed channels and display modes of the channels in the windows.

e The outputs to be generated during sampling if pulse outputs are used - sequences are saved in separate .pls
files.

e The multiple states information, including the protocols.

e The processing parameters and update modes of all memory views.
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If sampling ends without failing or being aborted, then Signal will save the sampling configuration that was used as
last.sgcx. This last-used sampling configuration is used the next time data is sampled unless a default sampling
configuration is found, which overrides this. When Signal starts, it searches for and loads the configuration file
default.sgcx. If this cannot be found, it uses last.sgcx so generally you will get the same sampling setup as
was used last time. If sampling fails or is aborted the last.sgcx file is not updated and the sampling
configuration switches back to the configuration in use at the time you started sampling.

Both of these files are saved in the current user's application data directory but in order to be as compatible as
possible they are searched-for in both the current user's application data directory and the application installation
directory.

It is a good idea not to rely on last.sgcx as this may have been changed by someone else doing some sampling,
instead you should save important sampling configurations to disk using suitable names and reload them before
starting an experiment. You can make this much easier by using the Sample Bar which holds sampling
configurations so that they can be quickly loaded using a single mouse click.

Sequence of operations to set and save the configuration

This describes a sequence of operations that build a new sampling configuration from scratch. You will find that
once you have built a few configurations, it is simpler to load an existing configuration and change the sections that
do not fit your requirements, rather than re-build entirely. The steps are:

1. Open the Sampling Configuration dialog using the Sampling menu or toolbar and set the sampling
configuration, limits and port information.

2. Press Run Now from the configuration dialog or press OK and select the New command in the File menu and
choose Data Document.

3. Arrange the new file view as you require and add or remove duplicate windows.

4. Use the Analysis menu New Memory view and Measurements view commands to add result views, XY views
and memory channels as required and set their update mode and position on screen.

5. You can use the File menu Save Configuration As command to save the configuration to disk at this point.

6. Sample, adjusting any positions, display configurations and so forth as required. Again, you can save the
configuration as adjusted at this point.

7. If sampling has finished without being aborted or failing, the sampling configuration is held in memory for use
the next time you sample. You can use the File menu Save Configuration As command to save the
configuration used to disk.

You can re-use a saved configurations by loading it with the File menu Load Configuration command before you
use the File menu New command to create a sampling document.
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Pulse outputs while sampling

Signal can generate pulse and waveform outputs from your 1401 during sampling using the DACs and the digital
outputs.

Signal pulse outputs provide a simple way of configuring outputs that will be generated during sampling. Pulse
outputs, like Signal data acquisition, is arranged as fixed-length frames. Depending upon the sampling sweep
mode, the pulse outputs may be the same length as the sampling sweep, longer, or shorter (Peri-triggered mode
only). In all circumstances, the outputs are fixed in time relative to the sampling sweep. In Basic mode and the
three fast-trigger modes (Fast triggers, Fast fixed interval and Gap-free) the pulse outputs start at the same time
as the sweep (triggered or un-triggered) and is of the same length. In Peri-triggered mode, the pulse outputs start
at the time of the trigger (which can be before or after the start of the sampled data, depending upon the pre-trigger
points), and again runs to the end of the sampling sweep. In Extended and Fixed interval sampling modes, the
pulse outputs can be any length greater than or equal to the sampling sweep and the sampling sweep starts at a
defined point within the pulse outputs.

Pulses dialog

If you press the Configure Pulses button

Pulses configuration

(only available with Pulses outputs =

selected) in the outputs page in the <> | com] Baic0 Tl Lebel |

sampling configuration, Signal will o

display the Pulses dialog which allows |a

you to view and edit the pulses. ;

This dialog can also be used to control é

and adjust the pulses while Signal is : " ; ;

sampling, in which case it is accessed Oms ~1om

using the sampling menu, the Signal | Pulse train DAC O at 340 to 530 ms Id | | b5

ltaoocglligr H(})éfg/ using the right mouse button "= =" N— ot [07 ] ok |
AL~ Pulses [10_ Length [mz) _10_5 Cancel |

The Pulses configuration dialog can be |[j_ p Intervalms) [20 | FreqHz [50 Help |

used to define square pulses and pulse

trains, ramps, sine waves, markers and

arbitrary waveforms which will be generated during sampling. Many of these pulses can automatically vary by
incrementing their amplitude or duration by fixed amounts. This provides a straightforward way of generating a
repeating set of pulses from one definition. If you are using Extended frame or Fixed interval sweep modes, this
dialog is also used to set and control the length of the pulse outputs, the start of the sampling sweep within the
outputs period, the sampling sweep ADC points if Variable points are enabled, and the fixed interval sweep
interval and interval variation.

You can resize the Pulses dialog by dragging the bottom right-hand corner of the dialog.

Pulses dialog layout

The dialog is divided into a number of sections:

Pulse and state controls

These controls occupy the topmost area
of the dialog and provide buttons used
to interact with the dialog, information
about any timing problems and a state selector and state label for multiple states use:

5 2

Dl I This button is used to delete the currently selected pulse.

‘f_l_d [iel I Copy | Timing faultz : 3 IBaSiCU vi::]l Label I

These buttons are used to toggle through the pulses on the current output trace in forwards or reverse
time order, selecting each pulse available in turn.
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Copy| This button is only enabled when multiple states controlling dynamic outputs are in use (see Sampling with
multiple states). It is used to copy sets of pulse data from the currently displayed state to other states. See
below for more details on using this.

Timing faults: 3

This area shows if there are any timing problems with your pulses, it will be blank if there are no problems. Timing
problems are caused by the fact that the Signal outputs system can only do one thing within each time step, a non-
zero timing fault count indicates that at some point or points the system is trying to do more than one thing at a
time, cannot do so and therefore an action will be delayed. Timing faults will not cause sampling to fail, they just
indicate that the pulse timings will not be perfect, to get rid of them you will have to alter your pulse times. Red
dots are drawn at the bottom edge of the pulse display area (below the blue control track) to indicate where the
timing problems are happening - you can see three of them in the Pulse display area picture below.

iB aszic [ - !—l This pair of controls is only visible when multiple states controlling dynamic outputs are in
= use (see Sampling with multiple states). They are used to select the state shown by the dialog:
you can only display and edit pulses for one state at a time.

| abel Fa-st— This control is also only visible when multiple states controlling dynamic outputs are in

use (see Sampling with multiple states). It is used to set a label for the currently displayed

state; a descriptive name for the state up to 10 characters long that will be used in the state control bar buttons and

elsewhere within Signal. If you leave this field blank the standard state names “Basic 0, State 1 ..” will be
used.

Pulse display area

This occupies most of the upper part of
the dialog and shows the currently
defined outputs as graphical traces. At
the bottom of the display area is a blue
line, the control track, that is used to
hold special pulse items and provide ; i
access to special information. The
control track line also indicates what s
portion of the pulses output period that

is covered by the sampling sweep, the line is thick where sampling is happening (if you are using Extended or
Fixed interval sweeps) and thin where no sampling is taking place.

=g D=
o

1000

Numbers indicating the start and end times of the pulses are shown just below the pulse display area itself. If you
are dragging a pulse about an extra indicator appears here showing the current drag time.

The outputs themselves are displayed starting with DAC zero at the top and finishing with the digital outputs at the
bottom, with the higher-numbered digital outputs first. Only traces for enabled outputs are displayed, they are
labeled with the DAC or digital output bit number. If you double-click on a trace in the display area it will expand
to use all of the space available for traces, hiding all other outputs. Double-clicking on the display a second time
will restore the display of all traces. If you stretch the dialog by dragging a corner or edge, the pulse display area
will expand to fill the space available and give you more space to see what the pulses are doing.

This display also includes a dotted rectangle drawn around one of the pulses, or around the initial level of an
output. This indicates the currently selected pulse whose numerical parameters are displayed at the bottom of the
dialog (see the Values section below). You can select a pulse by clicking on it with the mouse. Alternatively you
can toggle the selection through the various pulses on an output using buttons in the Controls section. You can
change the start time of a pulse by dragging it around the display area.

Review controls
B il These are at the right of the central area of the dialog, just below the numbers showing the start and end
times of the pulse display area. The controls are:

|E_ Click on this control to see the effect of pulse variations. While you hold down the mouse button on this
: control, the limits to pulse variations plus three intermediate values are displayed.

5 | Click on this button to animate the display to show the effect of pulse variations. The display updates to
show the effect of each variation in turn. Click again on the button to turn animation off.
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Pulses toolbox
This is the area at the bottom left of the dialog. It holds pulse icons which can be dragged into the dlsplay area to
add a new pulse into the outputs. Each icon represents a different type of pulse: e — —

a square pulse without variations, digital or DAC.
a square pulse with varying amplitude, DACs only. [
a square pulse with varying duration, digital or DAC. AP

a train of square pulses without variations, digital or DAC.
a ramp pulse with varying amplitude at start, finish or both, DACs only.
a sine-wave without variations, DACs only.

an arbitrary waveform on one or more DACs.

= ][] [ [E] (=] [m][2

a digital marker generation item, this is not an output but is added to the sampled data.

Pulse values

This is the area at the bottom centre of the dialog, it holds the
parameters defining the currently selected pulse which can be
changed by editing the parameter values. The parameters |.._ wvalsl B Stat(ms) [0 =
shown vary according to the type of pulse, the box title shows | [T Lenahimd [0 =

the type of pulse and the start and end times for the pulse
iad . ) X > | Startphase [a0 Cpelefms)  [100 Freq(Hzl [10
again using the currently selected time units. The details of the il il e

parameters are covered under the individual pulse types. If the
control track is the current selection this area will show other parameters according to the sampling mode, such as
the length of the outputs, the time of the sweep trigger , the fixed interval times and the sampling sweep points.

Sine wave DAC 0 at 40to 140 ms Id |

The Id field at the top right of the values area displays the name for the currently selected pulse, which can be
edited as desired. The main reason for giving a pulse a name is to make it easy to access the pulse from the script
language.

Dragging and dropping

A number of operations in the pulse configuration dialog are carried out by dragging and dropping. A major
advantage of drag and drop is its graphical, visual nature. For this reason, it is increasingly commonly found as a
way of carrying out operations in Windows software.

To drag and drop a screen object place the mouse pointer on top of the object, then press and hold down the left
mouse button. The mouse pointer may change to indicate the start of a drag operation and an icon may be attached
to the pointer to indicate that the object has been ‘grabbed’. Still holding the mouse button down, move the mouse
pointer to drag the object to its required destination. The mouse pointer may change while you do this, a common
effect is for the pointer to change to a no entry sign (a circle with a diagonal line through it) to indicate that you
cannot drop the object at this point. When the object is at the required destination, release the mouse button to drop
it in place.

Adding a new pulse

To add a new pulse into the outputs, select the pulse required from the pulses area of the dialog. Drag the new

pulse from the pulses area into the display, the mouse pointer changes to a * (a hand with a plus sign) to
indicate that you are adding a new pulse. As you move the mouse pointer about the display, a vertical line indicates
where the new pulse will go and the drop time is displayed in the control area. Once the pulse is correctly
positioned, drop it into place by releasing the mouse button.

If you cannot get the display area to accept the new pulse (the mouse pointer is always No Entry), this could be
because of the following reasons:
¢ You are trying to drag a DAC-only pulse such as a ramp, sine wave or waveform into the digital outputs.

¢ You are trying to drag an arbitrary waveform or marker generation item onto an output track, these can only go
on the control track.
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Moving a pulse

To move a pulse, select the pulse in the display area. Then drag the pulse into the new position required (you are
allowed to drag a pulse onto a different output as long as you do not change from DAC to digital or vice-versa).

The drop position is shown as for adding a new pulse, the mouse pointer changes to (a hand) to indicate
taking hold of something without addition or removal.

)

If the ctrl key is held down during the drag operation the mouse pointer will change to
the centre to indicate addition) and the pulse will be copied instead of moved.

(a hand with a + in

To avoid problems with precise positioning of the mouse Signal does not recognise a drag-and-drop operation until
the mouse has moved a certain amount away from the initial position. The mouse pointer shows this by only
including the pulse icon and showing the drop position when the amount of movement is sufficient. You can give
up on a move by returning the pointer close to the initial position. If you want to move a pulse a small amount, but
find that Signal will not recognise a drag operation that short, move the mouse pointer a larger amount vertically to
convince Signal that you mean it and smaller horizontal movements will be accepted.

If you cannot find or click on the pulse to start dragging it (usually because it is too short or completely hidden by
another pulse), see Finding a pulse for how to select it. Once the pulse is selected, you can change the start time
directly by editing it in the values area.

Removing a pulse

To remove a pulse, select it in the display area, then drag the pulse out of the display area completely. The mouse
pointer changes to (a hand with a minus sign) to indicate a remove operation once you are outside the display
area. Drop the pulse to complete the removal.

Alternatively, once the pulse has been selected, you can remove it by clicking the Del button in the controls area. If
you cannot find or click on the pulse to start dragging it, see Finding a pulse for how to select it.

Finding a pulse

It may be difficult to see a pulse or to click on it because the pulse is too short to see or because it is hidden by
another pulse. Click on the appropriate output trace, then use the .LIL! buttons to toggle through all of the

pulses on that output. At the appropriate point, your hidden pulse will be selected and can then be edited or deleted
directly.

Copying pulses

You can copy a single pulse to the same or a different output by holding down the Ctrl key while dragging a pulse,
without the Ctrl key this moves a pulse.

When working with the multiple sets of pulses provided by [ sefect pulse items ta co
multiple states with dynamic outputs, it is often useful t0 (™ jims to copy Destiation states

copy a set of pulses or settings to create duplicated data for B 7 o
other states. The Copy button opens a dialog where you || 2o o - - Setetate | |Sptet
can specify items within the currently selected state to be DAC outputs Endstate  [State 2

copied and a range of destination states to copy them to. 7] Control track items

The left-hand side of the dialog sets the items that will be [@|Length, trigger  [IExedinterval | Cancel | |
copied, the right hand side sets the destination, with check
boxes for each DAC and digital output plus another for the
control track that select the pulse items to be copied. If the Length, trigger check box is checked, the outputs
length, the sweep trigger time within the outputs and any variable points settings are copied from the currently
selected state into the target states, otherwise these values are left unchanged. Similarly, checking the Fixed
interval check box causes the fixed interval and interval variation values to be copied. For the DACs and digital
outputs selected, all existing pulses in the destination states are deleted before the new data is copied in.
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Pulse types

The pulses dialog can handle a number of different pulse types, both varying and not, some of which can only be
used on DAC outputs or are attached to the control track:

a square pulse without variations, on digital or DAC outputs.

a square pulse with varying amplitude, on DACs only.

a square pulse with varying duration, on digital or DAC outputs.

a train of square pulses without variations, on digital or DAC outputs.

a ramp pulse with varying amplitude at start, finish or both, on DACs only.
a sine-wave without variations, on DACs only.

an arbitrary waveform on one or more DACs, the pulse item is on the control track.

= ] [2] [~ [E][=][m] [2

a digital marker generation item on the control track only.

in addition to these there is extra information setting the initial level of an output. For the control track, this sets
extra information about the outputs, for example the outputs length and the sweep interval in Fixed interval mode.

Initial level

This item specifies the state that the outputs are set to at
the beginning of the pulse outputs, this item is always
present and cannot be deleted or moved.

Initial state for DAC O Id

The item has a single parameter; Level, that sets the level |ievelpa) 71

that the DAC is initially set to. The level entered is scaled |gtep change o Repests 1 Steps 0
before use as defined by the DAC settings in the output '

page. The three other parameters at the bottom of the

values area; Step change, Repeats and Steps, are used to define a built-in variation in the initial level. Built-in
variations are described under Pulses with variations.

For digital outputs only a single initial level parameter is available, set this to 1 for a high output and 0 for low.

Control track values
The initial level item for the control track provides other

. Outputs length, d interval ( 1d
parameters that control the overall outputs, these available ST S it (i)
vary with the sampling sweep mode, they are provided as ,
. Outputs (ms) 2000  Trigger (ms) 0 Interval (ms) 10000
part of the pulses outputs setup because they can vary with _ .
the state in multiple states sampling and can interact with AEp Py 20000 ey e
the outputs in some cases. Length {ms) 1000

When using Extended and Fixed interval sweep modes,

the outputs length and start time for the sampling sweep are shown. The Outputs parameter sets the length of the
outputs, while the Trigger parameter sets the time, relative to the start of the pulse outputs, of the start of the
sampling sweep.

With Fixed interval mode two more parameters; Interval (s), and Vary (%) appear (with Fast fixed interval
mode the Interval field is available but not Vary). These set the timed interval between output frames (which
cannot be less than the pulse output frame length) and the percentage random variation in the interval, from 0 to
100, for the selected state. If the variation is non-zero, the frame interval used while sampling will vary randomly
from Interval-Vary% to Interval+Vary%.

If variable sweep points are enabled (only available with Extended and Fixed interval modes when multiple
states are used), other fields are provided to set the number of points sampled per channel for the selected state.
This ADC points field can be set to any even number less than or equal to the sweep points value set in the
General section of the sampling configuration, the Length field does the same but in terms of the sweep duration.
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Simple square pulse

Thls spec1ﬁes a square pulse w1t.hout any variations. This Soumre pulse DAL 01 106010 1760 ms I

is the simplest type of pulse and is available for DACs and

for the dlg}tal putputs, in addition to genera?mg simple Sistvoks] [2  Statim [1050 =] [ Horetum
pulses multiple items can be used to generate simple pulse o =
trains or biphasic pulses. Many of the parameters used for e
this type of pulse are also used for all other types of pulse,
to save space these common parameters are described in
detail once only.

The Size parameter sets the pulse size, in calibrated units as defined in the outputs page. If absolute pulse levels
are in use, the item changes to Level, and is the level that the pulse goes to, for relative levels the size is added to
the level prior to the pulse to get the pulse level. Either positive or negative values can be used.

For digital pulses, the Size parameter disappears; for outputs with a low initial value a high-going pulse is
produced and vice-versa. The use or otherwise of absolute pulse levels does not affect digital pulses and
overlapping pulses do not invert each other.

The Start parameter sets the start time for the pulse. If absolute times are not in use, this parameter changes to
Delay and sets the delay from the start of the previous pulse to the start of this pulse. The Length parameter sets
the length of the pulse. Both of these fields will use the time units selected in the Display page of the Preferences
dialog.

If the No return check box is checked, the pulse does not return back to the initial level when it ends but just stays
at the pulse level, giving us a single step-change. In this circumstance the length parameter has no effect.

Varying amplitude pulse

This specifies a square pulse whose amplitude varies as it
is used. The Size, Start and Length parameters are exactly
the same as for the gimple puls.e. .In additign there. are three shepvale] [02 | Statims)  [1200 = Heretun
parameters controlling the built-in variation. This type of =
pulse is not available for digital outputs. The behaviour of Lengih sl [120 =]

the built-in variation is described under Pulses with |S'P change [0 1 Repeats |2 Steps [

variations.

| Warying pulze DAC 1 at 1200 to 1320 me Id I

Varying duration pulse

This specifies a pulse wh.os.e amphtudq is constant but the [Sauare pules DAE T, vary lenath, sl 12011 0 1300 ms
pulse length changes as it is used. This is the only pulse

with a built-in variation that is available for the digital Seetvoks) [T Statimg  [1200 =]

outputs. Lengthfms] [100 =4 I Pushback
The Size, Start and Length parameters are exactly the |gip charge[10 | Repeats [T Steps [z
same as for the simple pulse. The other parameters control
the variation, with the exception of the Push back check box. If this is checked, increases in the pulse duration
delay the start of following pulses by the same amount. Decreases in the pulse duration move the following pulses
earlier in time. If the check box is clear, changes in the pulse duration do not affect the time of following pulses.
The behaviour of the built-in variation is described under Pulses with variations

I |
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Square pulse train

This specifies a series of non-varying square pulses. This

Pulze train DAC 0 &b 340 ba 530 ms

Id |

type of pulse is available for DACs and for the digital
outputs.

Size [Voltz) |3 Start [mz] 340 =
I'IEI_ Length [ms) m
Interval [mz) |2EI

The Size, Start and Length parameters are all exactly the
same as for the simple square pulse. The extra parameters
are Pulses, which sets the number of pulses in the train,
Interval which sets the pulse spacing - the spacing between
the start of two adjacent pulses, which should not be less than Length, and Freq (Hz) which allows you to set the
pulse spacing in terms of pulses per second. Changes made to Interval are reflected in Freq and vice-versa.

Pulzes

Freg [Hz] EED

Ramp with varying amplitudes

This item specifies a pulse with different start and end
amplitudes so that the top of the pulse can be sloping. The
variation in amplitude, if this is used, can be applied to
either the pulse start or end, or both.

| Yoltage ramp DAC 1 at 300 to 400 ms

Start [Wolts] I1 Start [mz] |3EIEI 3: [~ HNoretun

End [Volts] [3 Lengthfms) [100 = [Stepbath x|
The Start and Length parameters are exactly the same as | giep change|d | Repeats [1 [ |
for the simple pulse, the size parameter is also called Start,
but shows the DAC units to avoid confusion. The extra parameters are End, which sets the pulse level at the end of
the pulse and a selector for the variation which can be set to Step both, Step start or Step end. This is an
extremely versatile form of pulse; for example by setting the start size to zero you can produce a ramp running
from one level to another.

I |

Stepz

Sine wave

Digital

This item specifies a cosine wave output of fixed duration, .
. . Sine wave DAC O at 40 ta 140 ms Id I

amplitude and frequency for output on a DAC. For Signal
version 3, sine wave output can be generated on all DACs. |

. . 5 k) [2 Start [0 =
In earlier versions only DACs 0 and 1 could be used. Al i -

Centre |EI Length [ms] |1DD 5:

The Size parameter sets the amplitude of the cosine wave | gy phase [30  Cyclefms) [100 | Freq(Hz) [10

(the distance from the mid-point to the extreme value, so
the total amplitude will be Size*2). The other parameters are Centre, which sets the level about which the cosine
oscillates, Start phase, which sets the initial phase in degrees, Cycle (s), which sets the duration of one complete
cycle and Freq (Hz) which allows you to set the cycle period in terms of cycles per second. The Centre value is
an absolute or relative voltage level as required. Because the output is actually a cosine wave an initial phase of 90
degrees will start the output off at the centre level.

marker

This item specifies a digital marker generation item with |

the marker code either set by the pulse item or read from
the digital inputs. Digital marker generation items can only

Marker generation at 405 mz

I |

5 [ans =
be placed onto the control track (as they do not apply to an i = ,
Code I?'E [ Read inputs

output) where they are shown by a green tag.

The Start parameter sets the time for the digital marker
generation. The Code parameter sets the marker code value unless the Read inputs check box is set, in which
case the code value is read from the 1401 digital inputs.
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Arbitrary waveform

This item specifies arrays of data to be output to one or
more DACs at a specified rate. Output to each DAC starts
simultaneously and consists of the same number of points, . o .
so the output also finishes simultaneously. An arbitrary - i Sla_rl me} 1850 =
waveform item can only be placed upon the control track, |He={Hal |5000 - Feints [1258
where it is shown by a purple tag, it also shows the
waveforms on the relevant DACs.

Waveform on DACs 07 at BE0 to 902 ms Id I

Adding a waveform item to the pulse outputs is a two-step process:

1. First you add the arbitrary waveform item to the control track, which creates the item with a waveform that is
all zeroes. Once the waveform item has been created you can adjust the DACs used, the waveform output rate
and the number of points to get the parameters correct - it's particularly worthwhile to set up the DAC list at
this point.

2. Once the basic waveform item is set up, you can then put the waveform that you want to use into it. This is
most easily done using the clipboard; if you copy Signal data to the clipboard you can then paste it into your
output waveform(s). To do this, select your new waveform item and press Ctrl+V on the keyboard or right-
click on the item and select Paste. Signal then provides the Paste waveform dialog which you can use to
control what data is pasted and which DAC outputs it is pasted into, along with other aspects of the paste
operation. You can also use the script language to copy data from a script array into the output waveform(s).

The DAC list parameter specifies which DACs are used, it is a list of DAC numbers from 0 to 7, this list is always
sorted so if you enter "620" it will be redisplayed and used as "026". The Start parameter sets the start time for the
waveform output in the usual manner, while the Rate (Hz) parameter sets the output rate for the data points for
each DAC and the Points parameter sets the number of data points output for each DAC.

The maximum output rates possible vary according to many factors such as the ADC rate and the pulse output
timing resolution. Tests carried out at CED with two channels of ADC data sampled at 10 KHz show that
waveform rates of up to 275 KHz can be achieved with a microl1401 and 500 KHz is possible (with difficulty)
when using a modern Power1401. The Maximise wave rates check box in the Outputs page of the sampling
configuration dialog can be used to increase the waveform output rates achievable - with a small penalty of
increased timing jitter in all sequencer operations.

Waveform output scaling

Waveform data on the clipboard is held as floating-point numbers exactly as seen in the Signal data display. When
this data is copied into a waveform output item it is scaled using the individual DAC scale factors as set up in the
main sampling configuration Outputs page. This conversion does not pay any attention to the units defined for
either the source waveform data or the DAC outputs. So if you copy waveform data with mV units where the data
values range from -200 to +200 mV and paste it into a DAC scaled to generate outputs from -5 to +5 volts, Signal
will try to generate an output running from -200 to +200 volts, not -0.2 to +0.2 volts. As the DAC scaling only
allows values from -5 to +5 volts your waveform will be severely truncated. You can fix this either by adjusting the
DAC scale factors, or by rescaling the data before you put it onto the clipboard. The easiest way to rescale the data
is to use a virtual channel with an expression such as "ch (1) *2.5" as this allows you to adjust the scaling until it
is correct. Once the waveform is as you want it you can copy the virtual channel data onto the clipboard and paste
it into the output waveform. When setting output waveforms using the script language an identical scaling process
is carried out if you are using an array holding floating-point values, values in an integer array are used directly
with 32767 corresponding to the upper full-scale DAC range limit and -32768 corresponding to the lower DAC
range limit.

Multiple waveform items

You can define an unlimited number of arbitrary waveform items but there are restrictions; both the DAC list and
the waveform output rate must be the same for all waveform outputs in a given set of outputs (waveform outputs
for different states can be different).

Pasting a waveform

Copying data to the clipboard in Signal also places the visible view data onto the clipboard in a private format
which can be used to set the waveforms for outputs. To place suitable data on the clipboard, open a data file and
adjust the display so that the required time range and channels are visible, then use the Edit menu Copy command.
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You can then paste this data into a waveform item in the pulse
. . . . Paste waveform
outputs configuration dialog by selecting a waveform output item
Clipboard holds 2040 pointz on 2 channels zampled at a
frequency of 10000 Hz, [duration 0.204 seconds)

and pressing Ctrl+Vv (the Paste command shortcut) or right-
clicking on the dialog and selecting Paste. Signal then provides a

dialog to control the paste so that you can ensure that you paste |jo cinhaard data starting with channel [1 -]
the right data into the waveform and to control other options. e O

The upper part of the dialog describes the data on the clipboard  fiavafarm puiss item outputs is 2000 points of data on 2
and provides control of which data to be taken from the clipboard = [PAC channels &t 5000 Hz [duration 0.4 secands)

- you specify the first channel whose data will be used (channel _

numbers start at 1 from the first waveform channel that was  Medi [2 ouputs, startenDAC [0~
pasted; the actual channel numbers for the data that was copied = Dwenite [2040 points starting at offset [0

are not used) and the start data point offset for each channel to be = ¥ Outputlength set to end of pasted data

taken from the clipboard. An offset of zero takes data starting with & Dutput frequency set from pasted data

the first point. on the clipboard, lar.ger offsets cause points. at the oK | ] |

start of the clipboard data to be skipped. The same offset is used
for all pasted channels.

The lower part of the dialog describes the current waveform output parameters, and provides control over where
the data taken from the clipboard is put to what extent the waveform output parameters are modified to match the
clipboard data. The upper pair of controls, making up the line Modify x outputs, start on DAC n, defines the
channels of the waveform output to modified. The DAC selector will only show DACs that are in the DAC list for
the waveform output item that you are pasting-into, so it is a good idea to set the DAC list correctly before pasting.
If you are changing more than one DAC output, DACs in the DAC list starting with the DAC specified are
changed. The lower pair, making up the line Overwrite x points, starting at offset y, sets the amount of data that
is pasted and where in the waveform buffer it is put.

The Output length set to end of pasted data and Output frequency set from pasted data check boxes act as
their titles imply. If all data offsets are set to zero, the points to overwrite is set to the points on the clipboard and
these two check boxes are checked, the paste operation copies all the clipboard data and changes the waveform
output parameters to match. Click OK to paste the data, or Cancel to do nothing.

Pulses with variations

Some types of pulse can be set up so that they vary |
automatically. The pulse types that support this are initial |
level, square pulse with varying amplitude, square pulse | _. [z a0 =

with varying duration and the ra%np pulse. All of these use (i (.2 hamu il 200 - L

the same three parameters to control the variation, only the Lengthfms) [120 =

varying aspect depends upon the type of pulse. The pattern | 5P change (0.1 Repeats |2 Steps [5

of variation used is: the pulse is generated a number of

times without variation, then a number of times with one ‘step change’ added, then two steps and so on. This
repeats until the maximum number of changes has been reached, at which point the cycle restarts with the pulse
with no step changes.

Waming pulze DAC T at 1200°t0 13200 ms Id I

The Step change parameter sets the amount by which the varied aspect (the pulse amplitude for example)
changes at a time. The Repeats parameter sets the number of times each step is repeated before moving on to the
next step and the Steps parameter sets the maximum number of changes to be added. This arrangement gives a
final value of Initial + (Steps * Step change). The total number of pulse forms generated is one more than Steps
as the variation includes the basic pulse without any step changes.

In the example shown, seven pulses will be generated with amplitudes of 30, 20, 10, 0, 10, 20 and 30 mV. Each
pulse will be generated twice in the order shown; the entire sequence will repeat after 14 pulses. If you wanted a
sequence that ran 30, 20, 10, 0, 10, 20,and 30, you would set the pulse amplitude to 30 and the step change to 10.

Extended and Fixed interval sweep modes

With Basic, Peri-triggered, Fast triggers and Fast fixed interval sweep modes, the length of the pulse outputs
is set by the sampled data (Basic, Fast triggers and Fast fixed interval modes have the outputs length the same
as the sweep length, Peri-triggered mode has outputs length as the sweep length less any pre-trigger time). With
Extended and Fixed interval sweep modes, the outputs length is set independently of the data frame and data
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acquisition starts at a preset time within the outputs. Because these values can vary with the state in multiple states
sampling, for convenience they have been located in the pulses dialog.

When using Extended mode the length of the outputs and
the sweep start time values are shown whenever the control
track is selected. The Outputs field sets the length of the
outputs, this value must be at least as long as the sampling
sweep. The Trigger parameter sets the time, relative to the
start of the pulse outputs, of the start of the sampling

Outputs length and sweep {in ms) Id

Outputs (ms) 2000  Trigger (ms) 0O

sweep.
With Fixed interval mode two more control track TS e e e =
parameters appear; Interval, and Vary (%) (with Fast s
fixed int mode the Interval field is available but not Vary). e o o ; S ot
These set the timed interval between output frames (which utputs (ms) rigger (ms) nterval (ms)

Vary % 10

cannot be less than the pulse output frame length) and the
percentage random variation in the interval, from 0 to 100,
for the selected state. If the variation is non-zero, the frame
interval used while sampling will vary randomly from Interval-Vary% to Interval+Vary%.

Variable sweep points

If variable sweep points are enabled (only available with
Extended and Fixed interval modes with multiple states
in use), extra control track parameters are provided to
control the sweep points. The Sweep points item sets the
number of points sampled per channel for the selected
state, this can be set to any value less than or equal to the Length {ms) 1000

overall maximum sweep points value set in the General

section of the sampling configuration, and must be an even number. The Length parameter controls the same
sweep points value in terms of the sweep duration.

Outputs length and sweep {in ms) Id

Outputs (ms) 2000  Trigger (ms) 0O
Sweep points 20000

Controlling pulse outputs during sampling

While sampling is in progress, the pulses configuration dialog can be obtained by using the Sampling menu, by
clicking on the relevant toolbar button or by right-clicking on spare application areas to get a popup menu. All
three mechanisms provide the pulse configuration dialog in the same form as used offline. The only difference is
that the OK button has been renamed Apply and the Cancel button Close and that pressing Apply doesn’t cause
the dialog to disappear.

You can use the pulse configuration dialog freely during sampling to change the pulses that are output, the only
restriction being that you cannot increase the size of any arbitrary waveform items, or add an arbitrary waveform
item where one was not present beforehand. All changes made will be copied into the sampling configuration if the
sampling completes successfully so that they can be used next time.

Timing warnings

With Fixed interval or Fast fixed interval mode in use, the use of external sweep triggers is disabled as the
interval timer does all of the triggering. If the delay between the end of one pulse frame and the start of the next is
too short, the internal trigger may be missed, if this occurs a warning message is generated at the end of data
acquisition.
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Sequencer outputs during sampling

The Signal output sequencer is available as an alternative to Pulses for generation of outputs during sampling. It
can generate both digital and analogue signals and can be used to respond to external signals and to control data
capture.

An output sequence is a list of up to 8191 instructions (2047 for older 1401 types) that are executed by the 1401
during sampling at a constant, user-defined rate to produce the outputs required. Sequences are defined by a
sequence file, which is a text file with a . p1s file extension. The Signal sequencer has the following features:

e It controls digital output bits 15-8 to produce precisely timed digital pulse sequences. In Power1401s and
Micro1401s it can also control the 1401 digital output bits 7-0.

e It controls the 1401 DACs (Digital to Analogue Converters) to produce voltage pulses and ramps.

e [t can play cosine waves at variable speed and amplitude through the DACs.

e [t can test digital input bits 7-0 and branch on the result.

e It supports loops and branches, can randomise delays and stimuli and generate digital marker items.

e It has 256 variables (V1 to v256) that can be read and set by on-line scripts.

e [t supports a user-defined table of values for fast information transfer from a script.

e [t can read the latest value from a waveform channel and, using this information, provide real-time (fractions
of a millisecond) responses to input data changes.

e [t can set or get the sweep state code, get the start time of the sweep, wait until a specified time within the
sweep or trigger a sweep.

e [t can control and monitor arbitrary waveform outputs.

You write sequences with a text sequence editor; each text line generates one instruction.

Sequencer technical information

The sequencer clock starts within a microsecond of recording time zero, the time at which the Start button is
pressed, and is time locked to the 1401 sweep timing and waveform channel recording. Each clock tick books an
interrupt to run the next sequencer instruction and updates digital output bits 15-8 if they were changed by the
previous instruction.

An interrupt is a request to the 1401 processor to stop what it is doing at the earliest opportunity and do something
else, then continue the original task. The time delay between the interrupt request and the instruction running
depends on what the 1401 is doing when the clock ticks and the speed of the 1401. This delay is typically a few
microseconds, so instructions do not occur precisely at the clock ticks but changes to digital output bits 15-8 do.
Changes made by the sequencer to the 1401 DACs and digital output bits 7-0 occur a few microseconds after the
clock tick.

The table shows the minimum clock interval, the approximate time per step and the extra time used for cosine and
ramp output for each 1401. Notice that the first item is in units of milliseconds (to match Signal) and the remainder
are in microseconds.

Power-3 Power mk Il Power Micro3 Micro mk Il micro1401
Minimum tick interval 0.004 ms 0.006 ms 0.01 ms 0.01 ms 0.025ms 0.10 ms
Time used per tick <1 us <1 us <1 us ~1 s ~1 us <8 us
Cosine penalty/tick 0.2 ps 0.3 us 0.55 us ~1 s ~1 uUs ~5 uUs
Ramp penalty/tick 0.1 us 0.25 us 0.5 us 0.7 us 0.7 us ~3 Us
DIV/RECIP penalty 0.2 us <1 us <1 us <3 ys <3 us <10 ps

The Minimum tick interval is the shortest interval we recommend that you set. The Time used per tick is how
long it takes to process a typical instruction. The Cosine penalty/tick is the extra time taken per cosine output.
The Ramp penalty/tick is the extra time taken per ramped DAC, the DIV/RECIP penalty indicates the extra time
taken up by these instructions. Time used by the sequencer is time that is not available for sampling, transferring
data back to the host or arbitrary waveform output. To make best use of the capabilities of your 1401 you should
set the slowest sequencer step rate that is fast enough for your purposes.
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If you overload the system so much that the output sequencer cannot keep up, Signal will warn you of this when
sampling finishes. If the 1401 is extremely overloaded by the combination of sampling and sequencer output,
sampling will fail with an appropriate error message.

The clock interval that you set is rounded to the nearest 4 microseconds to generate the actual sequencer tick
interval. For modern 1401s (Power1401s and Micro1401s mk II and -3), intervals less than 5 milliseconds are
rounded to the nearest 0.1 microsecond. All subsequent timing is based upon the rounded interval so that full
accuracy is maintained.

1401-specific limitations
On the micro1401 and Micro mk II, the limit to the number of sequencer instructions is 2047, all other types allow
8191.

The sequence editor

The output sequence is stored as a text file with the extension . PLS. You can open existing Signal output sequence
files or create new ones with File menu New. There are five buttons at the top of the window:

Compile

—1 This checks the sequence to make sure that it is correct with no labels missing or duplicated and no

=k duplicated key codes. The picture shows a sequence with a simple error (the LB in the seventh line should be
LP). The line in error is marked and an explanatory message is shown at the top of the window.

Format
=g This aligns the labels, key codes, instructions and any arguments, output text and comments and removes step
-] numbers. Undefined labels are not flagged but there must be no other errors.

Format with step numbers

sso1 This does the same job as the Format button, and also starts each line with the step number. Step numbers

E‘ can be useful as they give an indication when you are running out of space and can pinpoint the line where
your sequence is not behaving as you expect.

Current

«ps This compiles the sequence and, if the sequence is correct, saves it and makes this the current sequence for

;u_% use during sampling. If you were to open a new data file and start sampling, this sequence would be used.
You can also set the output sequence file from the Sampling Configuration dialog.

Help
=5 This is the Help button. It opens a window holding a list of the sequencer topics for which help is available.
= | You can copy and paste text from the help window into your sequence. You can also obtain online help on a
topic by clicking on the relevant text and pressing the F1 key.

Sequencer compiler error messages

When you use the Format or Compile buttons in the sequence editor, Signal displays the result of the compilation
or format operation in the message bar at the top of the window. The messages report either successful operation or
the cause of the problem.

No errors, N lines compiled

Your sequence has been checked and is syntactically correct. This means that it will certainly run, but it is up to
you to ensure that the sequence of codes produces the desired effect. If your sequence runs off the end of the
defined instructions, it will stop as the compiler adds a HALT instruction to the end of every sequence. The number
of lines compiled is a count of the number of instructions generated, which is one more than the number in the
sequence text as Signal adds a HALT instruction to the end of the sequence.

Formatting done
The format operation has completed and all lines of instructions are syntactically correct in themselves. There is no
check that a label referenced in an instruction exists.

Invalid label format, or same as Opcode, VAR, CONST or function
A colon was found, indicating a label, but the characters before the colon are not legal. A label starts with an
alphabetic character (A-7) and is followed by alphanumeric characters (2-z and 0-9) and is terminated by a colon.
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Case is not significant in labels. The label can be up to 8 characters long. It must not be the same as an instruction
name, a variable name, a constant name or a built-in function.

Invalid key definition
A quote mark was found, but there was no acceptable character following the quote, or there was more than one
character.

Unknown command used
A group of characters was found in the correct position to be an instruction, but they were not recognised. Change
them to a correct instruction mnemonic. This can also be caused by a missing colon at the end of a label.

The first/second/third/fourth argument is invalid
The instruction argument is either missing, invalid or was too long to be correct. If the argument included a table
reference, the offset may be too large or too small.

Internal error, contact CED
This is caused by a serious system error. If you can reproduce this problem please contact CED for advice.

Out of memory

Signal has run out of memory while processing the sequence. Close any non-essential windows in the Signal
application and try again. If this does not allow compilation, close any other applications and retry. As you are
most unlikely to exhaust your memory when compiling it may mean that something has gone badly wrong.

Label or table size defined twice

A label has been defined on more than one line. Remember that the labels are converted to upper case, so two
labels that differ in case only will cause this error. This error is also given if you use TABSZ more than once in a
sequence.

Unexpected characters at end of line
The most common cause of this error is a missing semicolon to introduce a comment.

Couldn't find branch destination
The label used by the instruction is not defined anywhere in the sequence. Define the label, or correct the label
name.

Invalid numeric value
A numeric argument was expected, but an invalid number or one that was outside the permitted range for the
argument was found.

Probability out of range
The probability field of the BRAND instruction must be set to a number in the range 0 to less than 1.0000000000;
correct the number.

Bad digital i/o pattern
Whenever a digital i/o pattern is expected, exactly 8 characters must be present, one for each bit of the digital i/o.
The characters are restricted to “0”, “1” and “.”, plus “c” for DIGIN and “i” for DIGOUT.

A label, key or display string but no instruction

Labels, key definitions and display strings may only occur on lines that have an instruction. If you really want an
instruction that does nothing, use NOP. Blank lines and lines consisting entirely of comments are allowed and
ignored.

Too many instructions

You have defined more than the maximum allowed number of instructions (8191, or 1023 for the original
micro1401), so you must shorten your sequence. You may be able to significantly shorted your sequence by using
variables and the SampleSeqgVar () script instruction. You can also split a sequence into sections and load these
one at a time.

Input line too long; shorten and try again
Each line of the file must be no more than 100 characters long. Shorten the offending line and try again. This limit
in previous versions of Signal was less, so it is a good idea to keep to short lines wherever you can.
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Unexpected end of file encountered
This shouldn't happen and probably means that something has gone badly wrong.

Variable name too long, unknown, badly formed or missing
A variable name used to replace the vl to v256 built-in names is incorrectly formed.

Bad branch code: S=Stopped, G=Going
The branch code for the WAVEBR command was not one of the allowed characters listed, or the branch code was
more than one character.

Variable name already defined as Opcode, label, function or CONST

Previous versions of Signal allowed a variable name to be the same as a label or an Opcode. This is no longer
allowed. Also, the name is not allowed to the same as a built-in function, for example VAngle or the same as a
CONST item. Change the variable name.

Label already exists as Opcode, variable, function or CONST
Previous versions of Signal allowed a label to be the same as a variable name or an instruction name. This is no
longer allowed. The name may not match a built-in function or a constant. Change the label.

The DAC value exceeds the DAC output range
You have entered an expression for a DAC value that exceeds the DAC full-scale range. Check that the Full and
Zero values in the Outputs page are correct and that you have not mistyped the value.

More table entries than set by TABSZ
You have used the TABDAT directive to create table entries. There is either no TABSZ directive, or you have
generated more table data than you allocated with TABSZ.

Target of branch is too far away

You should only see this with an original micro1401 if you attempt to JUMP or branch to a target instruction that is
more than 4096 instructions before or 4095 instructions after the current instruction. Although you can have
sequences up to 8191 instructions, there is a limit on the size of a branch. This was a choice between slowing down
all branch instructions, or limiting the range of a JUMP for these devices.

Loading sequence files for sampling

The name of the output sequence file to use during sampling is part of the sampling configuration. The file name,
including the path to the folder containing it, must be less than 250 characters long. You set the file name either
with the Current button in the sequence editor or in the Outputs page of the Sampling Configuration dialog.
When you start sampling, Signal searches for the output sequence file named in the sampling configuration and
will generate an error message if it cannot be found.

Signal compiles output sequence files whenever you use them. If a file contains errors you are warned and the
sequence file is not used.

Sequencer control panel

While sampling is in progress, you can interact with sequencer execution using the
sequencer control panel. The control panel displays the next sequence step and any
display string associated with it. You can use display strings to prompt the user for an
action or to tell the user what the sequence is doing. If there are any keyboard- g EEISE‘ -:'utlputt and stop
controlled entry points in the sequence, these are also shown in the control panel. R

Sequence control Ea

|Slep oo | G to zhart

You can show and hide the control panel with the Sequencer Controls option in the Sample menu or by right
clicking on any toolbar to activate the context menu. You can also dock it on any edge of the Signal application
window. When undocked, the control panel displays sequence entry points as the key that activates

them and a descriptive comment. When docked, the keys are displayed as buttons and the comment is |5te,;. ooo7
hidden to save space. Move the mouse pointer over a key to see the comment as pop-up text. Click the |m‘
mouse on a key and the sequencer will jump to the instruction associated with the key. The key is also

stored as a keyboard marker. This is equivalent to pressing the same key in the time window or using ilil
the script language SampleKey () routine.
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The control panel is always displayed if you start sampling using Sequencer outputs from a Signal menu
command or from a dialog. If the sample command comes from the script language, the control panel visible state
does not change. The control panel position is saved in the sampling configuration. However, the position is
restored only if the control is currently invisible or floating, and the saved position was floating; if the control
panel is docked, we assume it is positioned where you want it.

Marker channel and digital input conflict

If you record a digital marker channel, this uses the same hardware in your 1401 as the sequencer instructions
DIBEQ, DIBNE, WAIT and DIGIN that read the digital input bits. Reading digital input bits 7-0 clears the hardware
flag that indicates that a marker event has occurred. These instructions can cause events to be missed on the marker
channel if they read the digital input at exactly the same time as the marker event arrives.

When you sample, Signal will warn you if there is a conflict in the use of these digital input bits. You can choose to
hide the warning for the remainder of your Signal session. In October 2002 we released updates to the Micro1401
mk II and Power1401 firmware that allow reads of the digital input that do not clear the hardware flag. The
warning is suppressed when the new firmware is installed in your 1401. Newer 1401 designs have this fix in all
firmware versions.

Getting started

The sequencer runs instructions in order unless told to branch, starting with the first instruction. The sequence can
either be restarted at the start of each sweep, or it can be set to free run throughout data acquisition. Sequencer
execution can be re-routed during data acquisition by associating an instruction with a key on the keyboard. Each
time the key is pressed or the associated sequencer control panel button is clicked or the script language
SampleKey () command is used, the sequencer jumps to the associated instruction. Signal records keys pressed
during sampling in the keyboard marker channel, so you can have a record of where in the sampling you switched
to a new portion of the sequence.

Simple sequence restarted each sweep

Here is a simple sequence that pulses DAC 0 high for 10 milliseconds ten times starting at 0.25 seconds into the
sweep. It for use with sequencer execution restarting each sweep. You can start and stop the pulses with keys or by
clicking buttons. You will find this in Signal3\Sequence\MyFirst.pls to save typing it in.

0000 MOVI V1,10 ;Initialise loop counter

0001 DELAY 248 ;Just less than 0.25 s >Waiting
0002 LP: DAC 0,2 ;Set output high

0003 DELAY 8 ;Wait 9 steps

0004 DAC 0,0 ; Set output low

0005 DELAY 7 ;Wait 8 steps

0006 DBNZ Vv1,LP ;Loop required times

0007 HALT ; Stop outputs >Done

Open MyFirst.pls and click the Check and make current sequence button at the upper right of the window
(leave the mouse over each button for a second or so to see the descriptive text). Open the Sampling configuration
dialog, and set a configuration with one sampled channel on ADC port 0, a sample rate of at least 10 KHz and a
sweep length of a second. On the Outputs page, make sure the sequencer clock rate is set to the default of 1
millisecond, and that the Free run without restarts box is not checked. To record the output pulses you must
connect the DAC 0 output to the ADC 0 input. This is easily done with a BNC cable on the 1401 front panel. You
do not need to make the connection to follow this description.

Click the Run now button in the sampling configuration, and then click the Start button. The sequencer control
panel is now visible. It displays Step 0000 in the top left window and a blank area to the right. If the control panel
is not docked there is also an area for comment display, currently clear. If you start sampling, you will see that the
control panel displays the text after the > when the relevant steps are being executed, if you are sampling the output
you will see the ten pulses being generated.

As this is our first sequence we will explain it in detail. Click the Format and add step numbers button at the
top of the sequencer window. All of the lines get a step number starting at zero, this is the step number displayed in
the control panel. You can remove step numbers with the Format button.
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Step 0 is executed at time zero in each sweep. The MOVI V1, 10 instruction on this line sets the value of variable 1
(V1) to 10. This variable is used as a loop counter in the sequence, so this statement sets the number of times that
execution will go round the loop. The remainder of the line is a comment.

The next line, step 1, holds the instruction DELAY 248. This causes sequencer execution to wait at this step for the
specified number of sequencer ticks into the sampling sweep, plus one more for the delay instruction itself (this
could be changed, but we have kept it this way to match the behaviour of the Spike2 sequencer, for those who use
both programs). The sequencer control panel displays the text to the right of the > for the current step, so while this
step is executing, the text “Waiting” is displayed. Note that we wait for 249 ticks (0.249 seconds). This means that
the next step will execute at precisely 250 steps into the sweep, or 0.25 seconds. Note also that we could have
written DELAY ms (249) -1 to achieve the same effect and that this would have the advantage of being immune to
changes in the sequencer tick interval.

Step 2 is DAC 0, 2, which sets the output of DAC zero to two volts. This step has a label at the start of the
instruction text, P :, so we can branch back here from elsewhere in the sequence.

Step 3 is DELAY 8, which causes sequencer execution to wait at this step for nine sequencer clock ticks, thus
setting the width of the pulse. The width will include the time taken by the DAC instruction as well, giving ten ticks
(0.01 seconds) overall. Note that, as for step 1, we could have written DELAY ms (9) -1 to achieve the same effect.

Steps 4 and 5 are the same as steps 2 and 3; they set the DAC output low again and wait for 8 sequencer ticks. We
only wait for 8 ticks because step 6 adds an extra step into this part of the sequence, so we get 10 ticks overall for
the low phase too.

Step 6 is DBNZ V1, LP, which causes the sequencer to decrement the value of variable number 1 and, if it has not
reached zero, branch to the label specified so that the next instruction executed will be step 2. As we have put the
value 10 into variable 1 at the start of the sequence, this will cause the loop that creates a pulse to execute ten
times, so we get ten pulses.

Finally step 7 is HALT, which causes sequencer execution to stop until the start of the next sweep, where it will be
automatically restarted at step 0. This step displays the text “Done” in the sequencer control panel while it is
executing.

Free running sequence

The simple way to use the sequencer is with restarts, so that the sequence restarts at the first step at the start of each
sweep. However, this mode of operation may prove insufficiently flexible for some situations. If you check the
Free run without restarts box in the Outputs page, you get a different style of sequencer operation. You will find
a sequence that operates in this manner in Signal3\Sequence\MySecond.pls; this also demonstrates some
other aspects of sequencer use:

0000 FL: 'F DAC 0,2 ;Start fast pulse >S for slow
0001 DELAY ms(9)-1 ;Wait 9 ms >S for slow
0002 DAC 0,0 ;Set output high >S for slow
0003 DELAY ms(8)-1 ;Wait 8 ms >S for slow
0004 JUMP FL ;Continue >S for slow
0005 SL: 'S DAC 0,2 ;Set slow pulse >F for fast
0006 DELAY ms(99)-1 ;Wait 99 ms >F for fast
0007 DAC 0,0 ;Set output low >F for fast
0008 DELAY ms(98)-1 ;Wait 98 ms >F for fast
0009 JUMP SL ;Continue >F for fast

Most of this sequence is similar to MyFirst.pls. The differences of interest are:

Steps 0 and 5 have a keyboard character defined as well as a label for looping. The sequencer control panel will
show buttons corresponding to each character defined; pressing the button or the appropriate keyboard character
will cause sequencer execution to jump to the relevant instruction.

A JUMP instruction is used instead of DBNZ so that the pulse output loops continue forever.

The remainder of this information is organised as a reference manual for the sequencer instructions. You can find
more information about the output sequencer in the Signal Training Course manual.
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Instructions

Instruction format

Blank text lines and lines with a semicolon as the first non-blank character, are ignored. Instructions are not case
sensitive. Each instruction has the format:

num lab: 'key code argl,arg2,.. ;Comment >display
num An optional step number in the range 0 to 1022, for information only.
lab: An optional label, up to 8 characters long followed by a colon. The first character must be alphabetic

(A-Z). Labels are not case sensitive. Labels may not be the same as instruction codes, variable names,
constants or expression function names.

'key In this optional field, key is one alphanumeric (a-z, A-Z, 0-9) character. When this character is
recorded as a keyboard marker during data capture, the sequencer jumps to this instruction. Each key
can occur once. Upper and lower case are dist